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Resumen 
 
La generación de energía eléctrica por medio de energía eólica ha tenido un gran 
crecimiento en los últimos años; resaltan las turbinas de viento de baja potencia que 
permiten aprovechar el potencial eólico en zonas con poco recurso, tal es el caso 
de los entornos urbanos. 
 
El presente trabajo desarrolla la simulación numérica mediante software CFD 
(Computational Fluid Dynamics) para el rotor de una turbia eólica de eje vertical de 
baja capacidad, obteniendo la potencia generada y el coeficiente de potencia (𝐶𝑝) 

de la turbina eólica. Se describe el proceso de simulación usando ANSYS Fluent 
mediante la técnica de Sliding Mesh. Así mismo, se estima mediante simulación la 
optimización de los concentradores eólicos de discos inductores, los cuales son una 
patente en trámite con número de expediente MX/a/2022/002284 ante el Instituto 
Mexicano de la Propiedad Intelectual (IMPI). Los concentradores eólicos de discos 
inductores son concentradores de energía eólica que tienen por objetivo aumentar 
el rendimiento de la turbina eólica, mediante la implementación de una estructura 
no giratoria que producen una aceleración en la velocidad del flujo del viento hacia 
el rotor. 
 
 
Palabras Clave: CFD, VAWT, Simulación, Energía eólica, Concentradores de 
viento. 
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Abstract 
 
The generation of electrical power using wind energy has grown rapidly in the last 
years; low-power wind turbines stand out as they allow the exploitation of wind power 
in areas with little resources, such as urban environments. 
 
The objective of the present work is to develop the numerical simulation by means 
of CFD (Computational Fluid Dynamics) software for a low-capacity vertical axis 
wind turbine rotor, obtaining its generated potency and 𝐶𝑝. The work shows the 

simulation process using ANSYS Fluent and the Sliding Mesh technique, as well as 
estimating through simulation the optimization of inductor disc wind concentrators, 
which are a pending patent with expedient number MX/a/2022/002284 before the 
Mexican Institute for Intellectual Property (IMPI). Inductor disc wind concentrators 
are wind energy concentrators that increase wind turbine performance through the 
implementation of a non-rotating structure that produces an acceleration in wind-flow 
speed towards the rotor. 
 
 
Key words: CFD, VAWT, Simulation, Wind energy, Wind concentrators. 
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Capítulo I 
 

1.1 Introducción 
 
Factores como: los bajos precios de costo debido a la continua innovación y escala 
tecnológica; las expectativas de avances tecnológicos continuos; la reducción de 
costos de financiamiento debido a un menor riesgo percibido y una mayor 
competencia en la industria; han hecho que la energía eólica se posicione como la 
energía renovable con más crecimiento en los últimos años[1]. 
 
De acuerdo con la Secretaria de Energía (SENER), en México la energía eólica 
presenta uno de los mayores niveles de crecimiento anual, para el periodo 2018-
2032, tanto en capacidad instalada (10.2%) como en generación bruta (11.3%) [2]. 
Véase Fig. 1.1. 
 

 
Fig. 1.1. Evolución de las adiciones de capacidad y la capacidad instalada de tecnología eólica, 2018-

2032 [2]. 

 
Para el año 2032, la energía eólica concentrará el 12.8% del total de la generación, 
ocupando el primer lugar en generación, dentro de las energías renovables [2], 
véase Fig. 1.2. 
 

         
Fig. 1.2. a) Participación de las tecnologías renovables en la generación de energía eléctrica en 2032. b) 

porcentaje de las energías renovables en las adiciones de capacidad para 2032 [2]. 

a) b) 
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Por otra parte, dentro de la Prospectiva de Energías Renovables 2012-2026, 
realizada por la Secretaría de Energía (SENER), se estima una participación de 
pequeñas instalaciones (en baja y mediana tensión) de autoabastecimiento en el 
mismo sitio de consumo de 10.5% de la capacidad adicional instalada con energías 
renovables. Se estima que 21.4% (461 MW) provenga de aerogeneradores con 
conexión a red eléctrica o aisladamente [3]. 
 
 

1.2 Planteamiento del problema 
 
En la actualidad uno de los retos tecnológicos es la obtención de energía eléctrica 
utilizando energías renovables, entre las que se destaca la energía eólica. El estado 
de Jalisco es territorio propicio para la producción de energía mediante fuentes 
renovables [4]. 
  
El potencial de capacidad de generación de energía eléctrica puede ser ampliado 
gracias a la mini eólica, que es el aprovechamiento de los recursos eólicos mediante 
la utilización de aerogeneradores de potencia inferior a los 100 kW [5,6], ya que 
estos aerogeneradores generan energía de manera distribuida y se pueden instalar 
en zonas con poco recurso eólico, como son los entornos urbanos y periurbanos [5]. 
 
Las condiciones para aprovechar la energía del viento en entornos urbanos son más 
complejas que en zonas abiertas, debido a la complejidad de la topografía lo que 
genera velocidades del viento más bajas y un flujo más turbulento [5]. 
 
México tiene un mercado emergente orientado a las turbinas de baja potencia [1]. 
Sin embargo, en nuestro país no existe fabricante alguno de turbinas eólicas de eje 
vertical. 
 
Las problemáticas ligadas al calentamiento global y al cambio climático han dejado 
muy claro que no es posible alcanzar el progreso a expensas del deterioro del 
patrimonio natural, por lo que es necesario promover la generación y el uso de 
energías más limpias [4]. 
 
En Jalisco existen parques eólicos de gran capacidad que aprovechan zonas con 
altas velocidades del viento, como lo son “Palo Alto”, “Los Altos” y “Los Altos II” [7], 
todos ellos con aerogeneradores de eje horizontal. Desafortunadamente, no se 
cuenta con proyectos que aprovechen el potencial del viento en zonas con poco 
recurso eólico; tal es el caso de los entornos urbanos. 
 
Las turbinas de viento de eje vertical son ideales para entornos urbanos ya que 
permiten generar electricidad al aprovechar las bajas velocidades del viento y no 
son afectadas por los cambios de dirección del viento [8]. Sin embargo, existen 
pocos trabajos de investigación en esta área ya que el esfuerzo se ha enfocado en 
las turbinas de eje horizontal que necesitan mayores velocidades de viento y pueden 
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producir por tanto una mayor cantidad de energía eléctrica pero que requieren una 
gran cantidad de terreno libre.  
 
Los modelos comerciales de turbinas de eje vertical para parques eólicos son 
limitados y son aún más escasos para entornos urbanos, debido a que existe una 
baja eficiencia lo que dificulta la rentabilidad de estos equipos. 
 
 

1.3 Antecedentes y estado del arte 
 
M. Islam et al. [9] proporciona un resumen de los diferentes modelos aerodinámicos 
matemáticos computacionales para turbinas de eje vertical tipo Darrieus de álabe 
recto, con una explicación corta de su fundamento físico, ventajas y desventajas, 
así como una comparativa de los modelos.  
 
R. Kumar et al. [10] hace una revisión de los principales desarrollos de 
aerogeneradores de eje vertical (VAWT, por sus siglas en inglés) enfocándose en 
su aplicación en las zonas urbanas. Da recomendaciones basadas en información 
de vanguardia sobre el tema para futuros estudios y la aceptación de turbinas 
eólicas en las zonas urbanas. Define la situación de los aerogeneradores en zonas 
urbanas y proporciona una visión de las áreas de oportunidad para hacer viables a 
los aerogeneradores de eje vertical en las ciudades. 
 
M. Islam et al. [11] establece un panorama más general sobre la energía eólica, 
abarcando tanto los aerogeneradores de eje horizontal como de los de eje vertical. 
Hace un recuento de su evolución, así como de la creciente importancia de la 
energía eólica para la producción de electricidad a nivel mundial. Aborda de forma 
más general el problema de la intermitencia de la producción debido al cambio en 
la dirección y velocidad del viento proponiendo los sistemas de baterías y sus 
diferentes tipos como un medio de solución. 
 
M. Ghasemian et al. [12] recapitula los trabajos publicados sobre análisis de 
dinámica de fluido computacional para turbinas de eje vertical tipo Darrieus. 
Presenta recomendaciones, pautas para el modelado de la turbulencia, la 
discretización espacial y temporal, esquemas numéricos y algoritmos 
computacionales. Así mismo aborda parámetros operativos y geométricos de los 
aerogeneradores. Otorga información sobre los diferentes modelos CFD y los 
análisis de álabes con el propósito de abordar diferentes progresos en áreas de 
simulación como la modificación y optimización del perfil de la pala y el rendimiento 
de la turbina eólica.  
 
X. Jin et al. [13] revisa y resume de forma concreta la investigación básica de los 
principales métodos y sus correspondientes aplicaciones en turbinas eólicas de eje 
vertical tipo Darrieus, ofrece modelos matemáticos, simulaciones en CFD y los 
resultados de medidas experimentales. 
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M. Aslam Bhutta et al. [14] y W. Tjiu et al. [15] revisan y resumen varias 
configuraciones de aerogeneradores de eje vertical, M. Aslam abraca turbinas de 
eje vertical de tipo Darrieus, tipo Savonius así como un híbridas, en cambio que W. 
Tjiu se centra en las de tipo Darrieus, haciendo un análisis más profundo. Exponen 
las ventajas y desventajas de cada configuración y abordan las técnicas de diseño 
empleadas con sus resultados. Comparan el coeficiente de potencia para varias 
configuraciones y muestra que puede optimizarse con referencia a la relación de 
velocidad de la punta. Expone los retos que enfrenta este tipo de aerogenerador 
para que pueda usarse más ampliamente. 
 
N. Batista et al. [16] aborda el diseño de un aerogenerador de eje vertical tipo 
Darrieus para instalarse en un área urbana, que tiene la capacidad de autoarranque 
debido a un diseño de perfil innovador denominado EN0005, que evita la necesidad 
de componentes adicionales, ofrece todo el proceso desde diseño, simulación CFD, 
instalación y pruebas de campo. Expone una posible solución, mediante el diseño 
desde la forma del rotor hasta el diseño de un nuevo perfil aerodinámico, a una de 
las grandes problemáticas de los aerogeneradores Darrieus que es el autoarranque, 
en general este tipo de aerogenerador necesita un impulso externo proporcionada 
por un sistema mecánico o eléctrico para poder vencer la fuerza de inercia y poder 
empezar a girar. En este articulo lo tratan de resolver mediante el desarrollo de un 
nuevo tipo de álabe con ciertas propiedades aerodinámicas. 
 
F. Toja-Silva et al. [17] refiere que el viento en las ciudades representa un gran 
recurso eólico que aún no ha empezado a explotarse para la generación de energía 
eléctrica. Los vientos urbanos tienen la característica de ser multidireccionales lo 
que representa un reto para las turbinas eólicas. Para explicar la influencia del viento 
multidireccional en la turbina, se simula el flujo de aire alrededor de una sección de 
un edificio, las secciones de varias turbinas eólicas se superpusieron en los campos 
de velocidad, y se analizó el comportamiento aerodinámico cualitativamente. Brinda 
ejemplos de aerogeneradores eólicos instalados en zonas urbanas y da una 
comparativa del comportamiento y rendimiento que podrían obtener una turbina de 
eje vertical y horizontal. 
 
Los discos inductores que se analizarán en el presente trabajo son una patente en 
trámite que tiene como folio de recepción MX/E/2022/013115 y expediente 
MX/a/2022/002284, por lo que se hace la búsqueda de patentes orientadas a 
mejorar el rendimiento de las turbinas eólicas de eje vertical. A continuación, se 
mencionan las que tienen alguna relación con la patente en trámite del presente 
trabajo y las principales diferencias. 
 
La patente MX/a/2020/006802, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es una invención de un dispositivo eólico 
que describe un volumen de sección horizontal circular de desarrollo vertical que 
posee por lo menos dos turbinas VAWT dispuestas y selectivamente desplazables 
a lo largo del lateral del volumen central girando en el centro geométrico de la 
sección del volumen central, orientando las turbinas de manera óptima en la 
cercanía de la sección máxima del volumen que es donde el caudal de viento está 
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en su máxima velocidad. Cada estructura "sesten" de las turbinas aguas arriba 
sostiene sendos fuseladores que ocultan la zona de las turbinas que avanza en 
sentido contrario respecto de la dirección del viento y placas laterales que ocultan 
visual y auditivamente las turbinas capaces de acelerar el caudal en la zona de las 
turbinas por el efecto Venturi. Esta invención se diferencia en que no requiere de 
mínimo dos turbinas para su funcionamiento. 
 
La patente MX/a/2016/015980, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es un generador de conversión ciclónica o 
anticiclónica que comprende: una estructura hueca y rígida que en su extremo 
superior cuenta con unos deflectores difusores para producir un efecto Venturi, y 
con unos medios de conversión de la energía cinética del viento exterior en energía 
eléctrica, es de aplicación tanto para generación de ciclones como anticiclones, y 
para su uso con cualquier fluido, como viento y agua; permite aumentar la velocidad 
del fluido, concentrándolo en la periferia lo que redunda en un mayor rendimiento y 
efectividad. Esta invención se diferencia en que aumenta la velocidad de viento, sin 
producir un flujo ciclónico o anticiclónico. 
 
La patente MX/a/2016/001491, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es una torre de generación de energía 
eólica. La torre de generación de energía eólica puede implementar la generación 
de energía eólica al acelerar la velocidad del viento aún para el viento de baja 
velocidad y simultáneamente incrementar la eficiencia de uso del viento que hace 
girar las paletas, mejorando mediante esto la eficiencia de generación de energía 
global. Además, la torre de generación de energía eólica puede incrementar la 
intensidad del viento por un efecto Venturi e incrementar simultáneamente la caída 
de presión del viento que escapa de la torre de generación de energía eólica al usar 
el vórtice generado en la superficie posterior de la torre de generación de energía 
eólica en una forma cilíndrica, mejorando mediante esto la rotación de las palas 
provistas al interior de la torre de generación de energía eólica. Esta invención se 
diferencia en que no requiere de una torre 
 
La patente MX/a/2020/004614, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es un sistema de guía de viento para guiar 
el viento por delante y/o por encima de una turbina eólica desde una primera 
dirección hasta una segunda dirección. La guía de viento está dispuesta y 
configurada para cambiar la dirección del viento de tal manera que el viento que 
sale de la guía de viento aumentara la velocidad del viento de la estela detrás del 
rotor al agregar o conducir parte del viento circundante hacia la estela. Esta 
invención se diferencia en que no posee un sistema para guiar el viento. 
 
La patente MX/a/2009/010236, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es un sistema de turbina de viento con 
mezclador/eyector ("MEWT"). La MEWT incorpora avanzadas tecnología de 
mezclado de flujo, tecnología de eyector, aerodinámica de aeronave y propulsión 
tecnologías de reducción de ruido de una manera única para mejorar en cuanto a la 
dinámica de fluido la efectividad y eficiencia operacional de las turbinas de viento 
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anteriores, de tal forma que su eficiencia operacional excede rutinariamente el límite 
de Betz. La MEWT presenta una envoltura de turbina con una entrada acampanada; 
álabes del anillo del estator; un anillo de paletas rotatorias en línea con los álabes 
del estator; y una bomba mezcladora/eyectora. Esta invención se diferencia en que 
no cuenta con un mezclador ni eyector. 
 
La patente MX/a/2015/006190, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que es un método y un aparato pasivo integrado 
que capta y acumula energía solar potenciada con energía eólica y energía térmica 
captadas, inducidas y aceleradas actuando simultánea o independientemente para 
producir electricidad. El aparato consta de un captador y acelerador de viento 
exterior y de corriente de convección proveniente del interior del inmueble, carcasa 
y tobera de turbina de perfil aerodinámico acumuladoras de energía solar lo que le 
permite tener una mayor potencia en su rendimiento través de una turbina 
aerodinámica compuesta de estator integrado con álabes divergentes con perfil 
aerodinámico y colector integrado con álabes convergentes conectados por medio 
de un eje a un generador para producir electricidad permitiendo su operación de día 
y de noche en cualquier latitud y en forma permanente. Esta invención se diferencia 
en que no hace uso de la energía solar. 
 
La patente MX/a/2020/000540, protege un diseño similar a la presente invención, 
ya que en la descripción menciona que está constituida a partir de una torre soporte 
en la cual se implementa un rotor que comprende dos crucetas paralelas sobre las 
que se fijan en sus extremos exteriores dos anillos paralelos que sirven de soporte 
a los rodamientos que fijados a la carcasa exterior conforman el rotor, y dicha 
carcasa fija en su parte interior comprende una corona dentada que será la 
encargada de transmitir mediante tren epicicloide la fuerza del giro al seno de la 
torre que conforma un espacio propicio para alojar la transmisión que por necesidad 
será vertical e irá a buscar la caja multiplicadora. Las palas se materializan sobre 
dos vigas paralelas en horizontal unidas y compactadas entre ellas por cajas 
metálicas en cuyo interior se alojan los ejes y mecanismos de guiado, que dan 
sustento y orientación a las lamas. Esta invención se diferencia en que no cuenta 
con tantos componentes mecánicos ni requiere componentes dentados. 
 
La patente US 9.284,943 B2, protege un diseño similar a la presente invención, ya 
que en la descripción menciona que es una turbina eólica de eje vertical formada a 
partir de una disposición de palas de estator fijas para proporcionar aceleración del 
flujo de fluido en una disposición de palas giratorias aseguradas a un generador 
para invocar la generación de energía eléctrica. Las palas del estator se mantienen 
en posición mediante el uso de una placa de estator. Las palas del rotor están 
acopladas al generador. Las palas del estator están diseñadas para la deflexión del 
aire en una dirección para una rotación óptima de las palas del rotor acelerando el 
flujo de aire en un remolino previo antes de que el flujo entre en contacto con las 
palas del rotor. Cada pala de estator está orientada a un ángulo de escalonamiento 
suficiente para que un ángulo de la velocidad relativa no exceda el ángulo de 
pérdida de dicha pala de rotor. La invención involucra un estator con palas para 
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acelerar el flujo lo que la diferencia de la presente solicitud de patente que no 
involucra un estator. 
 
La patente US 6,740,989 B2, protege un diseño similar a la presente invención, ya 
que en la descripción menciona que es una turbina eólica de eje vertical con un rotor 
de turbina con palas de rotor dispuestas para girar alrededor de un eje 
sustancialmente vertical. La turbina incluye múltiples álabes de estator que se 
extienden verticalmente y separados circunferencialmente alrededor del rotor en 
una disposición anular. Cada paleta tiene una superficie que mira radialmente hacia 
adentro, una superficie que mira radialmente hacia afuera y una pestaña en un 
borde exterior de cada paleta. La brida sirve para crear una capa límite de remolino 
turbulento en las superficies de las paletas que gira en una dirección que atrae y 
redirige el flujo de aire hacia los canales de flujo de aire definidos por las paletas del 
estator que luego se comprime por el estrechamiento de los canales y se dirige al 
rotor. palas para accionar la turbina. La invención involucra un estator con palas 
para redireccionar el flujo lo que la diferencia de la presente solicitud de patente que 
no involucra un estator. 
 
La patente US 6,465,899 B2, protege un diseño similar a la presente invención ya 
que en la descripción menciona que es una turbina eólica omnidireccional de eje 
vertical que incluye una combinación de rotor / estator que maximiza la producción 
de energía al aumentar la velocidad y la presión del viento, además de eliminar la 
contrapresión. La sección de estator incluye una pluralidad de palas en forma de 
vórtice aseguradas entre velas cónicas superior e inferior. Las palas tienen un radio 
fundamentalmente igual al del rotor y una longitud de cuerda de aproximadamente 
1,25 veces su radio. El rotor tiene un diámetro aproximadamente igual a la mitad del 
del estator y tiene una pluralidad de palas cóncavas aseguradas ay espaciadas de 
un eje vertical, estando dispuestas dichas palas en etapas dentro de la elevación 
vertical del rotor. Cada pala de rotor tiene una línea de cuerda igual al doble de sus 
radios y una longitud de cuerda que se aproxima a un tercio del diámetro del estator. 
La invención involucra un estator con palas en forma de vórtice para redireccionar 
el flujo lo que la diferencia de la presente solicitud de patente que no involucra un 
estator. 
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1.4 Justificación 
 
El Consejo Estatal de Ciencia y Tecnología de Jalisco (COECYTJAL) en conjunto 
con el Centro de Investigación y Asistencia Técnica del Estado de Querétaro 
(CIATEQ) participó en la convocatoria 2019 del Fondo de Desarrollo Científico de 
Jalisco (FODECIJAL) para Atender Problemas Estatales con el proyecto “Diseño y 
desarrollo de turbina eólica de eje vertical para ambientes urbanos”, en la cual su 
proyecto fue seleccionado. Al programa de Maestría en Ciencias de la Ingeniería 
Mecánica de la UMSNH se le hizo la invitación a colaborar con la simulación 
mediante software CFD de la turbina diseñada por el CIATEQ. 
 
La colaboración del programa de Maestría en Ciencias de la Ingeniería Mecánica 
de la UMSNH tiene por objetivo proporcionar al CIATEQ los datos para que puedan 
corroborar el diseño de su turbina, mediante la simulación del rotor de la turbina 
eólica de eje vertical obteniendo de la simulación la potencia generada por el rotor 
y el cálculo del 𝐶𝑝 de la turbina, para distintas velocidades de viento, que van de los 

2.5 m/s hasta los 10m/s. Así mismo, se pretende estimar la optimización de los 
concentradores eólicos de discos inductores, los cuales son una patente en trámite 
con número de expediente MX/a/2022/002284 ante el Instituto Mexicano de la 
Propiedad Intelectual (IMPI).  
 
 

1.5 Hipótesis 
 
Es posible realizar la simulación numérica del rotor de una turbina eólica de eje 
vertical de baja potencia y estimar la optimización de los concentradores eólicos de 
discos inductores. 
 
 

1.6 Objetivos 
 

1.6.1 Objetivo general 
 
Realizar la simulación numérica mediante software CFD (Computational Fluid 
Dynamics) de una turbina eólica de eje vertical y estimar la optimización de los 
concentradores eólicos de discos inductores. 
 

1.6.2 Objetivos específicos 
 
1.- Realizar un estudio del estado del arte de las turbinas de eje vertical. 
 
2.- Realizar la simulación numérica mediante software CFD (Computational Fluid 
Dynamics) para evaluar el rendimiento a diferentes velocidades del rotor de una 
turbina eólica de eje vertical. 
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3.- Estimar por medio de la simulación numérica mediante software CFD 
(Computational Fluid Dynamics) la optimización de los concentradores eólicos de 
discos inductores. 
 
 

1.7 Metodología del proyecto de investigación  
 
El presente proyecto se hace en conjunto con el Centro de Investigación CIATEQ 
que forma parte de la coordinación de Materiales, Manufactura Avanzada y 
Procesos Industriales del Consejo Nacional de Ciencia y Tecnología (CONACYT) 
[18]. El CIATEQ proporciona el modelo geométrico de la turbina, algunos 
parámetros de diseño y la ubicación donde será instalada. 
 
La metodología usada para las distintas simulaciones es la usada comúnmente para 
la resolución de problemas con CFD, representada en la Fig. 1.3. 
 

 
Fig. 1.3. Metodología para la realización del proyecto de investigación. 

 
Al no tener datos experimentales del rendimiento y comportamiento del rotor la 
turbina eólica para la validación de la simulación hace obligatorio el apego a las 

Búsqueda bibliográfica

Creación de la geometría

Generación de la malla

Selección de propiedades físicas y propiedades de los fluidos

Especificación de condiciones de frontera

Inicialización y control de la solución 

Supervisión de la convergencia

Análisis de resultados

Reporte de resultados y visualización
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recomendaciones marcadas en la literatura y al uso de las buenas prácticas para 
simulaciones de fluidos computacionales.  
 
Para evitar problemas de compatibilidad entre softwares se realizan todas las 
actividades con el software de ANSYS Workbench. Para el trazado y modelado de 
la geometría y volúmenes de control se utiliza ANSYS DesignModeler, para el 
mallado de los volúmenes de control ANSYS Meshing y para la simulación CFD se 
usa de ANSYS Fluent. 
 
Con los datos proporcionados por CIATEQ se calculan los parámetros para definir 
las propiedades del fluido, así como otros datos necesarios para la simulación. Esta 
etapa también incluye la búsqueda bibliográfica.  
 
Se realiza la modelación del rotor y los volúmenes de control (dominio 
computacional) en DesignModeler, posteriormente en ANSYS Meshing se realiza la 
malla, se traslada el archivo a Fluent para realizar la simulación, y finalmente se 
analizan los resultados obtenidos. 
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Capitulo II. Conceptos Básicos de Energía Eólica 
 
 

2.1 Energía eólica 
 
La energía renovable es una fuente de energía limpia que tiene un impacto 
ambiental menor que la tecnología de energía convencional [1]. Se identifica como 
una energía renovable a las energías obtenida de las fuentes de la naturaleza como 
la luz solar, el viento, las olas, el agua, entre otras. 
 
El viento es aire atmosférico en movimiento. La velocidad del movimiento del aire 
define la cantidad de energía en el viento, es decir, la energía cinética del viento. La 
fuente de esta energía es la radiación solar [19]. La energía disponible en el viento 
varía con el cubo de la velocidad del viento [20]. 
 
La radiación del Sol calienta de manera desigual la superficie de la Tierra, más 
fuerte en los trópicos y más débil en las latitudes altas. Además, como resultado de 
tasas diferentes de absorción de radiación solar por el suelo, las rocas, el agua y la 
vegetación, el aire en distintas regiones se calienta a diferentes velocidades. Este 
calentamiento desigual se convierte mediante procesos convectivos en el 
movimiento del aire [19]. Estos efectos térmicos combinados con los efectos 
dinámicos de la rotación de la Tierra producen el viento [21]. 
 
La energía del viento es básicamente la energía del aire que fluye de un lugar a otro 
sobre la superficie de la Tierra. El viento puede producir energía eléctrica o 
mecánica mediante el uso de una turbina eólica que comúnmente consta de hélices, 
álabes o palas. Una turbina eólica funciona de forma general cuando el rotor recibe 
energía cinética del aire, que luego se convierte en energía mecánica o eléctrica, 
según el uso final. La extracción de la energía del viento depende significativamente 
de la eficiencia del rotor y del diseño de los álabes de la turbina conectadas al 
sistema de generación de energía eólica [22]. 
 
La generación de energía eléctrica mediante energía eólica es un proceso de 
creación de electricidad utilizando la energía cinética del viento que se produce 
debido a su movimiento y masa [22]. La energía cinética por unidad de tiempo se 
conoce como potencia cinética (𝑃), se puede expresar mediante la Ec. 2.1 [8].  
 

𝑃𝑎𝑖𝑟𝑒 =
1

2
𝑚̇𝑉∞

2 =
1

2
𝜌𝐴𝑉∞

3 Ec. 2.1 

 
La mayoría de las turbinas eólicas actuales se utilizan para generar electricidad. La 
energía eólica es una fuente de energía alternativa prometedora no solo para 
aplicaciones a gran escala, sino también para aplicaciones de generación de 
energía distribuida y a pequeña escala [22].  
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2.2 Clasificación de aerogeneradores 
 
Las turbinas eólicas se pueden clasificar con base en varios criterios como la 
posición del eje de rotación, la fuerza que origina la rotación, la solides, la potencia 
producida, entre otros criterios [19, 23]. 
 
Centrándonos en el criterio con base a la posición del eje de rotación, las turbinas 
eólicas se pueden clasificar en dos categorías que son turbinas eólicas de eje 
horizontal o HAWT, por sus siglas en inglés (Horizontal Axis Wind Turbine) y 
turbinas eólicas de eje vertical o VAWT, por sus siglas en inglés (Vertical Axis Wind 
Turbine).  
 
Las HAWT parecen estar más avanzadas en sus aplicaciones durante la última 
década y están marcadas como la tecnología dominante en la industria moderna de 
la energía eólica. La mayor eficiencia de los HAWT ha llevado a su amplia aplicación 
[10]. Sin embargo, esta mayor eficiencia energética solo funciona con viento de alta 
velocidad con una dirección predominante. En contraste, para áreas de baja 
velocidad del viento donde la dirección del viento cambia regularmente, favorecen 
a las VAWT [10, 17]. 
 
 

2.2.1 Turbinas Eólicas de Eje Horizontal (HAWT) 
 
Las turbinas eólicas de eje horizontal son turbinas cuyo eje de rotación es paralelo 
al suelo. Los HAWT generalmente están conectados al sistema de red debido a su 
mayor eficiencia. El rotor está diseñado de manera óptima con dos o tres álabes 
para captar la energía del viento [22].  
 
Las principales ventajas de los HAWT son una mejor producción de energía, alta 
eficiencia y flexibilidad del sistema de control. No obstante, también se han 
observado algunos inconvenientes, como el alto requerimiento de la torre para 
asegurar una gran cantidad de energía eólica capturada, alta contaminación 
acústica y mortalidad de aves. Aparte de eso, las HAWT necesitan un mayor 
mantenimiento debido a algunas perturbaciones externas, como interferencias de 
radio, transmisión de televisión [8, 19, 20, 24, 25]. La Fig. 2.1 muestra una turbina 
eólica moderna de eje horizontal. 
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Fig. 2.1. Configuración típica de una turbina eólica moderna de eje horizontal HAWT. Obtenido de [20]. 

 
 

2.2.2 Turbinas Eólicas de Eje Vertical (VAWT) 
 
La turbina eólica de eje vertical es una turbina cuyo eje de rotación es perpendicular 
al suelo. Las VAWT han superado a las HAWT en varias condiciones, 
especialmente cuando se trataba de un patrón de viento complejo (turbulento) y de 
baja velocidad. Además, proporciona un mejor aprovechamiento del espacio debido 
al diseño más pequeño y simple [19].  
 
Otros méritos de las VAWT son un menor nivel de ruido, poder recibir viento de 
cualquier dirección y producir menores esfuerzos en la estructura de soporte debido 
a la ubicación cercana al suelo. Las VAWT requieren menos viento para generar 
energía, lo que las hace adecuadas para áreas de baja velocidad del viento, como 
ciudades y áreas urbanas. Este requisito de bajo nivel de viento las hace aptas para 
ser instalados en las áreas de baja velocidad del viento que están más cerca del 
suelo. A medida que se acercan al suelo, los procesos de control y mantenimiento 
se facilitan. Las VAWT muestran la principal ventaja de poder aprovechar el viento 
desde cualquier dirección en comparación con las HAWT que necesitan un sistema 
de control de guiñada [10, 17].  
 
A pesar de todos los méritos de las VAWT, también se han identificado algunos 
inconvenientes. Los álabes de las VAWT son propensos a la fatiga debido a la gran 
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variación de las fuerzas aplicadas en cada rotación. Los álabes de las VAWT 
convencionales se doblaban con la rotación del rotor, lo que provocaba que se 
agrieten. Desafortunadamente, estos factores llevaron a la baja confiabilidad de los 
VAWT [22].  
 
Las VAWT se pueden dividir en dos tipos principales: tipo Savonius y tipo Darrieus. 
El tipo Savonius usa fuerzas de arrastre y funciona de manera similar a una rueda 
de agua. Por otro lado, el tipo Darrieus usa fuerzas de sustentación o elevación y 
emplea hojas similares a las que se usan en las HAWT [8, 26].  
 

 
Fig. 2.2. Tipos de rotor convencionales para turbinas de eje vertical. Modificado de [25]. 

 
En términos de eficiencia, las turbinas que usan la sustentación son mejores que 
las turbinas que usan el arrastre. Por lo tanto, hoy en día muchas investigaciones 
se centran en las turbinas que usan principalmente fuerzas de sustentación (tipo 
Darrieus). El primer diseño de este tipo de turbina fue patentado en Estados Unidos 
en 1931 por G. J. M. Darrieus [22]. En la Fig. 2.2 muestra los tipos convencionales 
de VAWT. 
 
 

2.3 Eficiencia y relación de velocidad de punta 
 
La eficiencia de la turbina para convertir la energía cinética del viento en energía 
eléctrica o mecánica se conoce como coeficiente de potencia, 𝐶𝑝. Generalmente se 

describe como la relación entre la energía eléctrica producida por la turbina eólica y 
la energía del viento que ingresó a la turbina. El coeficiente de potencia está definido 
por la Ec. 2.2 [19]. 
 

Rotor Savonius Rotor Darrieus Rotor H 
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𝐶𝑝 =
𝑃𝑡𝑢𝑟𝑏𝑖𝑛𝑎

𝑃𝑎𝑖𝑟𝑒
=

𝑇𝜔

1
2 𝜌𝐴𝑉∞

3
 

Ec. 2.2 

 
De acuerdo con la teoría del límite de Betz, las turbinas eólicas idealmente solo 
podrían alcanzar una eficiencia máxima de alrededor del 59% [25].  
 
El límite de Betz es el mismo tanto para las turbinas de eje vertical como para las 
de eje horizontal y corresponde a la eficiencia máxima que una turbina eólica podría 
alcanzar que es 𝐶𝑝,𝑚𝑎𝑥 = 16/27 = 0.5926 [8]. 

 
Las turbinas eólicas alcanzan su máxima eficiencia con una óptima relación de 
velocidad de punta o TSR, por sus siglas en inglés (Tip Speed Ratio). El TSR se 
representa comúnmente con la letra griega 𝜆 (lambda), y está definido como la 
relación entre la velocidad del viento y la velocidad de las puntas de los álabes de 
las turbinas eólicas, como se representa en la Ec. 2.3 [8].  
 

𝑇𝑆𝑅 = 𝜆 =
𝜔𝑟

𝑉∞
 Ec. 2.3 

 
La relación entre la eficiencia del rotor y el TSR se muestra en la Fig. 2.3. Se puede 
observar que para diferentes diseños de turbinas eólicas la máxima eficiencia se 
produjo a diferentes valores de TSR.  
 

 
Fig. 2.3. Relación entre el coeficiente de potencia y la velocidad de punta para distintos rotores de 

turbinas eólicas. Obtenido de [25]. 
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2.4 VAWT Tipo Savonius 
 
El rotor Savonius es una turbina eólica de eje vertical con una sección transversal 
en forma de S, viéndose desde arriba. En la Fig. 2.2 se ilustra la forma del rotor tipo 
Savonius. Es principalmente un dispositivo que funciona con base en las fuerzas de 
arrastre que genera el viento en su paso por la turbina. Sin embargo, también puede 
haber cierta cantidad de sustentación que contribuya a la potencia [8].  
 
Las turbinas eólicas que giran principalmente por fuerzas de arrastre tienden a 
producir un par de arranque alto, por lo que reduce la velocidad necesaria para el 
arranque de la turbina. Por lo tanto, se requiere una velocidad de viento baja para 
que la turbina comience a girar [22]. 
 
El argumento a favor de las turbinas tipo Savonius es que son relativamente 
económicas de construir. Al ser máquinas impulsada por arrastre, tienen 
coeficientes de potencia intrínsecamente bajos. Además, tienen una solidez 
cercana a 1.0, por lo que son muy pesados en relación con la potencia que 
producen. También son difíciles de proteger de daños en vientos fuertes [8]. 
 
La potencia del Savonius se basa en la diferencia de presión a través de la pala o 
álabe que se alejan del viento y la que avanza contra el viento. Esto a su vez está 
relacionado con la diferencia en los coeficientes de arrastre asociados con el lado 
convexo y el lado cóncavo de los álabes. Se puede encontrar una discusión 
detallada de la aerodinámica del rotor Savonius en [26]. 
 
El coeficiente de potencia máxima para cualquier rotor Savonius se produce en una 
relación de velocidad punta inferior a 1.0 [8]. 
 
Las turbinas Savonius convencionales no son adecuadas para la generación de 
electricidad debido a su incapacidad para girar más rápido que la velocidad del 
viento. Sin embargo, investigaciones previas verificaron que la rotación del 
generador se puede incrementar con el uso de caja de cambios. Como las VAWT 
tipo Savonius tiene un coeficiente de potencia más bajo, muchas investigaciones se 
han centrado en la mejora de la eficiencia de la turbina. Esto se debe al hecho de 
que las turbinas Savonius tienen una mejor capacidad de autoarranque que las otras 
VAWT [22].  
 
 

2.5 VAWT Tipo Darrieus 
 
A las turbinas eólicas de eje vertical que usan principalmente fuerzas de 
sustentación o elevación se les cataloga como VAWT tipo Darrieus, en honor a 
Georges Jean Marie Darrieus, quien patentó este tipo de diseño en los Estados 
Unidos en 1926 [27]. En la Fig. 2.4 se muestran las figuras que se presentaron para 
el trámite de patente de Darrieus. La patente cubría dos configuraciones principales: 
álabes curvos y álabes rectos [15, 27]. 
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Fig. 2.4. Figuras de la patente de Darrieus que explican la idea de una turbina eólica de eje vertical 

(VAWT) basada en elevación. Obtenido de [27]. 

 
Considerando la forma de los álabes de la turbina, tienden a producir un par positivo 
en todos los ángulos cuando funcionan en condiciones óptimas. Como resultado, 
los VAWT basados en sustentación son más eficientes que los VAWT basados en 
arrastre. La mayoría de los nuevos VAWT disponibles en el mercado se basan en 
el concepto de sustentación aerodinámica para maximizar la producción de energía, 
pero utilizan formas aerodinámicas diferentes a las del tipo "Darrieus" [19]. Las 
configuraciones de álabes curvos y rectos se han investigado y desarrollado 
evolucionado en distintas configuraciones, como se muestra en la Fig. 2.5, con la 
intención de superar la deficiencia del autoarranque de las turbinas tipo Darrieus. 
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Fig. 2.5. Línea del tiempo del desarrollo de distintas configuraciones para VAWT. Obtenido de [15].  
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La configuración de álabes curvos se conoce como batidor de huevos o phi-rotor 
debido a su apariencia. Existen diversas variaciones del phi-rotor en lo referente a 
la sujeción como las versiones con cables de sujeción, fijas en la torre y en voladizo. 
De manera similar, la configuración de hojas rectas tiene varias configuraciones. Se 
han documentado variaciones de diamante, V/Y y delta (∆) [8, 28].  
 
Otra variación de las turbinas tipo Darrieus es la del rotor Musgrove que cuenta con 
una geometría variable; sin embargo, este ha sido reemplazado por un rotor H de 
paso fijo. Este tipo de turbinas tiene un mejor desempeño que el diseño 
convencional con un diseño y proceso de fabricación más simple. Actualmente, el 
rotor H se ha investigado activamente, incluido el rotor de varios megavatios para 
aplicaciones en alta mar. Además, las mejoras en el rotor H generaron otras tres 
variantes: rotor H articulado, rotor H helicoidal y rotor H inclinado [15]. Para una 
mejor comprensión del desarrollo de las VAWT a lo largo del tiempo se recomienda 
al lector remitirse a [15, 26, 28, 29]. 
 
En comparación con las turbinas tipo Savonius, las turbinas tipo Darrieus producen 
un par de arranque bajo, por lo que requieren de un sistema externo para comenzar 
a girar, pero cuando giran, son mucho más rápidas que las turbinas tipo Savonius. 
En términos de eficiencia, el tipo Darrieus se destaca con el coeficiente de potencia 
más alto que el tipo Savonius a alta velocidad del viento. Por lo tanto, las turbinas 
Darrieus son mucho más favorables para generar electricidad [22].  
 
La velocidad de activación de la turbina Darrieus se mide entre 4 y 5 m/s, mientras 
que la turbina Savonius tiene una velocidad de activación menor de 
aproximadamente 1 m/s [22].  
 
 

2.6 VAWT Híbridas Savonius-Darrieus 
 
Las VAWT híbridas son una combinación de rotores basados en arrastre y 
sustentación, como las turbinas Savonius y Darrieus, respectivamente [30]. Las 
turbinas eólicas híbridas Savonius-Darrieus tiene por objetivo superar las 
limitaciones de cada tipo de VAWT, combinado turbinas de tipo Savonius y Darrieus, 
y se desarrolló con base en los diseños anteriores. En los desarrollos comerciales 
actuales de aerogeneradores pequeños, el diseño híbrido ha ganado mucha 
popularidad [22]. La Fig. 2.6 muestra un ejemplo de un VAWT híbrido.  
 
Sin embargo, las VAWT híbridas enfrentan ciertos desafíos, como nuevas formas 
de desprendimiento de vórtices, la optimización de diseño de sistemas más 
complejos y un rendimiento relativamente más bajo debido a las fuerzas de arrastre 
creadas por la turbina Savonius a valores altos de 𝜆 [14].  
 
Rassoulinejad-Mousavi et al. [31] probaron experimentalmente una VAWT híbrida 
que constaba de una turbina Savonius de 2 álabes y una turbina H de 3 álabes. 
Examinaron dos conjuntos de posiciones variando la posición de la turbina Savonius 
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en la parte inferior de la turbina H y en medio de la turbina H, con el fin de encontrar 
la configuración con el mayor rendimiento. La turbina Savonius ubicada en el centro 
del rotor H obtuvo el diseño óptimo. Bhuyan y Biswas [32] compararon los requisitos 
del par de arranque para un rotor H-Darrieus convencional contra un rotor VAWT 
híbrido con el rotor Savonius en el medio. Los resultados indicaron las capacidades 
de autoarranque de la turbina híbrida en cualquier ángulo de acimut y número de 
Reynolds. Sin embargo, la turbina Savonius actúa como un freno para la turbina 
híbrida a velocidades de viento más altas. 
 
Liang et al. [33] realizaron un estudio para determinar los efectos de relación de 
radio y el ángulo de fijación sobre la eficiencia y el autoarranque mediante un 
enfoque de dinámica de fluidos computacional. Se analizaron varias 
configuraciones para el rotor híbrido. Utilizando aspas aerodinámicas NACA 0012, 
encontraron que una turbina híbrida con dos aspas en el rotor H y una relación de 
diámetro de 0.25 que proporcionaba el rendimiento óptimo del sistema. Los 
requisitos de par de arranque llegaron a ser tan bajos como 0,1 Nm con una 
velocidad del viento baja de 2 m/s y un 𝐶𝑝 máximo de 0.363. 

 

 
Fig. 2.6. VAWT híbrida. Obtenida de [30] 

 
En otra investigación, se diseñó un VAWT híbrido innovador para un sistema más 
sostenible y robusto con una mejor característica de autoarranque [30]. La turbina 
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híbrida está estructurada con dos niveles; cada nivel tiene cuatro rotores Savonius 
de dos álabes y una turbina Darrieus de tres álabes, con la posición de Savonius 
dentro de la turbina Darrieus, ver Fig. 2.6. Se comparo el rendimiento de la turbina 
híbrida con la turbina H sola. Aunque el rotor H demostró mayor 𝐶𝑝 en comparación 

con el tipo híbrido, el rotor H no puede arrancar de forma independiente debido al 
bajo par inicial. La turbina híbrida mostró una mejora en términos de eficiencia y 
rango operativo [30].  
 
Estos estudios respaldan el desarrollo de una VAWT híbrida mediante el uso de una 
turbina tipo arrastre como la turbina Savonius en medio de un rotor H-Darrieus. Esta 
combinación aumenta el par de arranque y la eficiencia a valores de λ más bajos 
[30]. 
 
En resumen, a pesar de todos los inconvenientes y beneficios de las VAWT la 
aceptación depende en gran medida de su rentabilidad, fiabilidad y capacidad de 
autoarranque [22]. 
 
 

2.7 Concentradores de energía eólica 
 
Dado que la potencia producida por una turbina eólica es proporcional a la potencia 
cúbica de la velocidad del viento, como se muestra en la Ec. 2.1, duplicar la 
velocidad del viento significaría un aumento de ocho veces en la producción de 
energía de la turbina eólica [34]. Así mismo, las bajas velocidades del viento dan 
como resultado menos energía por unidad de volumen de aire que pasa a través de 
una turbina. 
 
La instalación de turbinas eólicas convencionales disponibles comercialmente en 
algunos países está limitada porque generalmente las turbinas eólicas diseñadas 
para velocidades de viento superiores a 5m/s. Esto limita la elección de ubicaciones 
donde se pueden implementar [35]. 
 
La idea básica de un concentrador de energía eólica es aumentar el rendimiento de 
la turbina eólica o aumentar el rendimiento energético en relación con el área de 
barrido del rotor, es decir, buscar una reducción drástica en el tamaño del rotor. 
Básicamente, esto se logra mediante dispositivos estáticos, que son estructuras no 
giratorias que producen una aceleración en la velocidad del flujo hacia el rotor o, en 
algunos casos, incluso generan vórtices de concentración [25].  
 
Existe gran variedad de concentradores eólicos y su forma depende de para que 
tipo de turbina sea el concentrador. En la Fig. 2.7 se muestran algunos diseños 
conceptuales de concentrador para HAWT y en la Fig. 2.8 se muestra un ejemplo 
de concentrador para VAWT. 
 
Con lo anterior ha surgido un nuevo concepto de turbina eólica que son las turbinas 
eólicas aumentadas por concentrador o CAWT por sus siglas en inglés 
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(Concentrator Augmented Wind Turbine) que buscan mejorar eficiencia de las 
turbinas eólicas al hacer uso de los concentradores de energía eólica [35]. Se 
recomienda al lector consultar [25, 35] para una explicación más detallada del tema. 
 

 
Fig. 2.7. Conceptos de turbinas eólicas de eje horizontal combinadas con concentradores de energía 

eólica. Obtenido de [25]. 
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Fig. 2.8. Concentrador de energía eólica para turbinas de eje vertical (VAWT). Obtenido de [34]. 

 
Un aspecto para considerar es cuidar que la construcción adicional requerida para 
“pre-concentrar” la energía eólica no sea demasiado costosa, ya que generalmente 
el costo de construir un concentrador efectivo, que también pueda soportar vientos 
extremos ocasionales, siempre ha sido más de lo que vale el dispositivo [8]. 
Además, no se han realizado esfuerzos para comercializar este concepto porque se 
sabe poco sobre el comportamiento del flujo de viento en el CAWT, su influencia en 
la potencia de salida de la turbina y sobre los parámetros óptimos de diseño del 
concentrador [35]. 
 
A pesar de todo, se ha concluido que los CAWT son formas prometedoras de 
aumentar la producción de energía en áreas de baja velocidad del viento, pero su 
desarrollo se ve limitado por la escasa información disponible sobre su operación 
[35]. Thangavelu et al. [36] proponen y prueban por medio de CFD un diseño de 
concentrador para HAWT, Shikha et al. [37] evalúan un concentrador para amplificar 
la velocidad del viento para un pequeño rotor Savonius, y más recientemente Marin 
et al. [38] analizan por medio de CFD un innovador concentrador de energía eólica 
diseñado para cualquier tipo de VAWT. Trabajos de investigación como los 
anteriores y muchos otros más son invaluables para el desarrollo de esta tecnología.  
 
Todavía se necesita realizar más investigación y experimentación para comprender 
las diversas características de flujo que pueden estar presentes en el sistema, como 
la turbulencia, las pérdidas por fricción del concentrador, los remolinos, los efectos 
de viraje y estela, y su influencia en la potencia de salida [35].  
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Capitulo III. Conceptos Básicos de Dinámica de Fluidos 
Computacional 
 
 

3.1 Introducción a dinámica de fluidos computacional 
 
Dinámica de Fluidos Computacional o CFD por sus siglas en inglés (Computational 
Fluid Dynamics) es el análisis por medio de simulaciones computacionales de 
sistemas que involucran el flujo de fluidos, transferencia de calor y fenómenos 
asociados, como reacciones químicas [39]. La CFD es una rama que integra la 
mecánica de fluidos, las matemáticas y las ciencias de la computación [40]. 
 
La dinámica de fluidos computacional ha llegado a la mayoría de las aplicaciones 
industriales y de la investigación académica. Al principio, este campo de estudio se 
limitaba principalmente a las áreas de ingeniería aeronáutica de alta tecnología; sin 
embargo, hoy en día es una metodología ampliamente utilizada [40]. La técnica es 
muy poderosa y abarca una amplia gama de áreas de aplicación industriales y no 
industriales [39].  
 
La CFD se ha convertido en uno de los tres métodos o enfoques básicos empleados 
para resolver problemas de dinámica de fluidos y transferencia de calor, ver Fig. 
3.1. Cada enfoque está fuertemente interrelacionado y no se encuentra aislado. Los 
enfoques son usados para estudiar los diversos aspectos de la dinámica de fluidos 
y para ayudar a los ingenieros en el diseño de equipos y procesos industriales 
relacionados con el flujo de fluidos y la transferencia de calor. La tendencia es hacia 
una mayor confianza y empleo del enfoque computacional, sobre todo cuando los 
flujos son muy complejos [40]. 
 

 
Fig. 3.1. Los tres enfoques básicos para resolver problemas en dinámica de fluidos y transferencia de 

calor. Modificado de [40]. 

 
Los flujos y los fenómenos relacionados al flujo de fluidos se pueden describir 
mediante ecuaciones diferenciales parciales (o integro-diferenciales), que no tienen 
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solución analíticamente, excepto en casos muy particulares y simples. Para obtener 
una solución aproximada de forma numérica, se usa un método de discretización 
que aproxima las ecuaciones diferenciales por un sistema de ecuaciones 
algebraicas, que posteriormente es resuelto en una computadora [41].  
 
Así como la precisión de los datos experimentales depende de la calidad de las 
herramientas utilizadas, la precisión de las soluciones numéricas depende de la 
calidad de las discretizaciones utilizadas [41]. 
 
 

3.2 Estructura de CFD 
 
Los códigos CFD están estructurados en torno a los algoritmos numéricos que 
pueden abordar los problemas de flujo de fluidos. Para proporcionar un fácil acceso 
a su poder de resolución, todos los paquetes comerciales de CFD incluyen 
interFaces de usuario. Todos los códigos contienen tres elementos principales [39]: 
 

1. Pre-Processor 
2. Solver 
3. Post-Procesor 

 
De forma concisa y esquemática se muestra la función de cada uno de estos 
elementos dentro del contexto de un código CFD en la Fig. 3.2; para una explicación 
más detallada se recomienda al lector consultar [39, 40]. 
 

 
Fig. 3.2. Las funciones de interconectividad de los tres elementos principales dentro de un marco de 

análisis CFD. Modificado de [40]. 
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3.3 Resolución de problemas con CFD 
 
La física subyacente de los problemas de fluidodinámica es compleja, los resultados 
obtenidos por un código CFD son, en el mejor de los casos, tan buenos como la 
física y la química integrada en él y, en el peor de los casos, tan buenos como su 
operador [39].  
 
Para la resolución de problemas con CFD se sigue la metodología representada en 
la Fig. 3.3. Existe una etapa previa a la configuración y ejecución de cualquier 
simulación en CFD, que consiste en la identificación y formulación del problema en 
términos de los fenómenos físicos y químicos que intervienen en el proceso y que 
por tanto deben considerarse [39, 40].  
 

 
Fig. 3.3. Metodología para la resolución de problemas con CFD. Elaboración propia con información de 

[40]. 

 
En la mayoría de las simulaciones de CFD se necesitan hacer suposiciones y/o 
simplificaciones para reducir la complejidad a un nivel manejable y que al mismo 
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tiempo se conserven las características principales del problema. Un modelo ideal 
debe presentar la cantidad mínima de complejidad mientras captura la esencia de 
la física relevante [42]. Las decisiones típicas pueden ser modelar un problema en 
dos o tres dimensiones, excluir los efectos de la temperatura ambiente, excluir las 
variaciones de presión sobre la densidad de un flujo de aire, optar por resolver las 
ecuaciones de flujo turbulento, entre muchas otras. La idoneidad de las 
simplificaciones introducidas en esta etapa rige en gran medida la calidad de la 
información generada por la CFD, el usuario debe estar consiente de todas las 
simplificaciones efectuadas [39]. 
 
En las dos primeras etapas de la metodología para la resolución de problemas con 
CFD las tareas principales son el dimensionamiento y la construcción de la 
geometría del dominio computacional, así como el diseño de la malla. 
Posteriormente se ejecuta la simulación. Para determinar el fracaso o el éxito de la 
simulación hay muchos factores que deben considerarse; sin embargo, entre los 
más importantes están la convergencia y la independencia de la malla.  
 
El algoritmo de solución en un software de CFD es de naturaleza iterativa. La 
convergencia generalmente se puede evaluar mediante el seguimiento progresivo 
de los desequilibrios que se acentúan por el avance de los cálculos numéricos de 
las ecuaciones algebraicas a través de cada paso de iteración. Estos desequilibrios 
miden la conservación global de las propiedades de flujo; también se les denomina 
comúnmente como los “residuales” [40].  
 
Una solución convergente se logra cuando los residuos caen por debajo de algún 
criterio de convergencia o tolerancia. Además de examinar los residuales, se 
pueden usar otras variables de control para determinar la convergencia. La 
selección de otras variables de control dependerá en gran medida del problema a 
analizar y de los resultados que se pretenden obtener. Otras variables de control 
pueden ser la fuerza de sustentación, el arrastre, el momento, entre muchas otras 
[40]. En algunas ocasiones, para que una solución converja es necesario modificar 
los ajustes de varios factores de relajación y dispositivos de aceleración de solución. 
No existen pautas sencillas para tomar estas decisiones, ya que dependen del 
problema en particular [39]. 
 
No existe una manera formal de estimar los errores introducidos por un diseño de 
malla inadecuado para un flujo general. La única forma de eliminar errores debido 
a la tosquedad de una malla es realizar un estudio de independencia de malla, que 
es un procedimiento de refinamiento sucesivo de una cuadrícula inicialmente tosca 
hasta que ciertos resultados clave no cambian. Entonces la simulación es 
independiente de la malla. El estudio de la independencia de malla constituye una 
parte esencial de todos los estudios de CFD de alta calidad [39]. 
 
Al final de una simulación, se debe juzgar si los resultados son "suficientemente 
buenos". Es imposible evaluar la validez de los modelos de física y química 
integrados en un código CFD. La CFD no es un sustituto de la experimentación, 
sino una herramienta adicional muy poderosa para resolver problemas. La 
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validación de un código CFD requiere información muy detallada sobre las 
condiciones de contorno de un problema y genera un gran volumen de resultados. 
Para validarlos de manera significativa es necesario producir datos experimentales 
de alcance similar [39].  
 
En ocasiones es posible que no existan los medios para realizar el trabajo 
experimental o no se cuenten con datos experimentales para validar el estudio en 
CFD, en cuyo caso el usuario debe confiar en la experiencia previa, las 
comparaciones con soluciones analíticas de flujos similares y con los con datos de 
alta calidad de problemas estrechamente relacionados e informados en la literatura. 
El objetico principal de cualquier ejercicio de CFD es una mejor comprensión del 
comportamiento de un sistema, pero dado que no existen garantías absolutas con 
respecto a la precisión de una simulación, se deben validar los resultados con 
frecuencia y de manera estricta [39]. 
 
Es imprescindible que se identifique cuidadosamente la física de flujo subyacente al 
problema a resolver. Para mayor claridad y facilidad de referencia, en la Fig. 3.4 se 
presenta un diagrama que destaca las principales características de flujo que se 
pueden encontrar para la simulación en CFD [40]. 
 

 
Fig. 3.4. Diagrama de las características a tener en consideración de la física en una simulación en 

CFD. Modificado de [40] 

 
 

3.4 Flujo turbulento 
 
Todos los flujos que se encuentran en la práctica de la ingeniería se vuelven 
inestables por encima de cierto número de Reynolds [43]. A números de Reynolds 
bajos, los flujos son laminares. A números de Reynolds más altos, se observa que 
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los flujos se vuelven turbulentos. La turbulencia desarrolla un estado de movimiento 
caótico y aleatorio en el que la velocidad y la presión cambian continuamente con 
el tiempo dentro de regiones sustanciales de flujo [39]. 
 
Los flujos en régimen laminar se describen mediante ecuaciones algebraicas; sin 
embargo, los flujos más complejos generalmente a excepción de casos muy simples 
de flujo solo se pueden abordar numéricamente con técnicas de CFD. Los cálculos 
de flujo para aplicaciones de ingeniería deben incluir descripciones generales y 
suficientemente precisas que capturen todos los efectos y las interacciones de la 
turbulencia [39]. La mayoría de los flujos de importancia para la ingeniería son 
turbulentos.  
 
La turbulencia ocasiona la aparición de remolinos con una amplia gama de escalas 
de longitud y tiempo que interactúan de forma compleja y dinámica. Dada su 
importancia se dedica gran esfuerzo de investigación al desarrollo de métodos 
numéricos para capturar los efectos provocados por la turbulencia. Los métodos se 
pueden agrupar en las siguientes tres categorías [39]: 
 

➢ Modelos de turbulencia para ecuaciones de Reynolds-Averageed 
Navier-Stokes (RANS). La atención se centra en el flujo promedio y los 
efectos de la turbulencia en las propiedades del flujo promedio. Antes de la 
aplicación de métodos numéricos, las ecuaciones de Navier-Stokes se 
promedian en el tiempo (o se promedian en conjunto en flujos con 
condiciones de contorno dependientes del tiempo). Aparecen términos 
adicionales en las ecuaciones de flujo promediadas en el tiempo debido a las 
interacciones entre varias fluctuaciones turbulentas. Estos términos 
adicionales se modelan con modelos de turbulencia. Los recursos 
informáticos requeridos para cálculos de flujo razonablemente precisos son 
modestos, por lo que este enfoque ha sido el pilar de los cálculos de flujo de 
ingeniería. 

 
➢ Large Eddy Simulation (LES). Es una forma intermedia de cálculos de 

turbulencia que rastrea el comportamiento de los remolinos más grandes. El 
método implica el filtrado espacial de las ecuaciones inestables de Navier-
Stokes antes de los cálculos, lo que pasa por los remolinos más grandes y 
rechaza los remolinos más pequeños. Los efectos sobre el flujo resuelto (flujo 
medio más grandes remolinos) debido a los remolinos más pequeños no 
resueltos se incluyen por medio del llamado modelo a escala de 
subcuadrícula. Las ecuaciones de flujo no estacionario deben resolverse, por 
lo que las demandas de recursos computacionales en términos de 
almacenamiento y volumen de cálculos son grandes. 

 
➢ Direct Numerical Simulation (DNS). Las simulaciones calculan el flujo 

medio y todas las fluctuaciones de velocidad turbulenta. Las ecuaciones 
inestables de Navier-Stokes se resuelven en cuadrículas espaciales que son 
lo suficientemente finas como para resolver las escalas de longitud de 
Kolmogorov en las que tiene lugar la disipación de energía y con pasos de 
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tiempo lo suficientemente pequeños como para resolver el período de las 
fluctuaciones más rápidas. Estos cálculos son muy costosos en términos de 
recursos computacionales, por lo que el método no se utiliza para cálculos 
de flujo industrial. 

 
Cada método tiene sus ventajas y desventajas, esta fuera del alcance de este 
trabajo analizarlas a detalle, se recomienda al lector remitirse a [39, 40]. 
 
 

3.4.1 Modelos de turbulencia 
 
El modelado de la turbulencia es uno de los tres elementos clave en la Dinámica de 
Fluidos Computacional. Los otros dos elementos clave son la generación de malla 
y el desarrollo de algoritmos [42]. Modelar la turbulencia es una tarea ardua y 
delicada ya que se trata de un fenómeno extremadamente complicado.  
 
Para poder calcular flujos turbulentos con las ecuaciones RANS es necesario usar 
modelos de turbulencia para predecir las tensiones de Reynolds y los términos de 
transporte escalar y cerrar el sistema de ecuaciones de flujo medio. Los modelos de 
turbulencia RANS más comunes se clasifican en función del número de ecuaciones 
de transporte adicionales que deben resolverse junto con las ecuaciones de flujo 
RANS [39].  
 
Existe una gran cantidad de modelos de turbulencia, la elección de uno u otro 
dependerá en gran medida del problema a resolver en CFD. La gran mayoría de los 
estudios numéricos existentes sobre VAWT se basan en simulaciones Unsteady 
Reynolds Averageed Navier-Stokes (URANS). Sin embargo, la precisión de las 
simulaciones de URANS depende en gran medida de la configuración 
computacional [44], entre los parámetros la elección del modelo de turbulencia. 
 

➢ Modelo de una ecuación Spalart-Allmaras (SA) [45]. Se desarrolló 
originalmente para aplicaciones aeroespaciales de flujos limitados por 
paredes. Ha tenido éxito en el modelado de flujos sobre superficies 
aerodinámicas con gradientes de presión adversos. El modelo también se 
hizo popular para aplicaciones de turbo maquinaria. Resuelve una ecuación 
de transporte modelada para la viscosidad turbulenta cinemática, 𝜇𝑡. La 
energía cinética turbulenta, 𝑘, se calcula indirectamente en función de una 
combinación de vorticidad y el tensor de velocidad de deformación. 

 
➢ Modelo de dos ecuaciones 𝒌 − 𝜺  RNG (RNG) [46]. Tiene una forma similar 

al modelo 𝑘 − 𝜀 estándar, se deriva utilizando un método estadístico (teoría 
de renormalización de grupo) para mejorar las predicciones de flujo para 
flujos de remolino y deformación rápida. El modelo RNG calcula los números 
de Prandtl turbulentos de forma analítica, en lugar de utilizar valores 
constantes como en el modelo estándar. El modelo también tiene en cuenta 
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los efectos del número de Reynolds bajo en contraste con el modelo 
estándar, que es básicamente un modelo de número de Reynolds alto. 

 
➢ Modelo de dos ecuaciones 𝒌 − 𝜺 Realizable (RKE) [47]. Está desarrollado 

para mejorar las predicciones de flujo del modelo 𝑘 − 𝜀 estándar para flujos 
con fuertes características de curvatura aerodinámica, rotación y vórtice. 
Incluye una ecuación de transporte modificada para la tasa de disipación, 𝜀, 
y se deriva con base en la ecuación de transporte exacta de la fluctuación de 
vorticidad cuadrática media. La ecuación modificada hace que el modelo sea 
'realizable', es decir, consistente con la física del flujo turbulento, lo que no 
es el caso para los modelos 𝑘 − 𝜀 estándar y 𝑘 − 𝜀 RNG. Además, se utiliza 
una formulación alternativa para la viscosidad turbulenta. 
 

➢ Modelo de dos ecuaciones SST 𝒌 − 𝝎 (SST) [48]. A través de una función 

de mezcla, combina la precisión y robustez del modelo 𝑘 − 𝜔 estándar [42] 
en la región cercana a la pared con la insensibilidad de flujo libre del modelo 
𝑘 − 𝜀 estándar [49], en una formulación transformada, lejos de la pared. 
Además, el transporte del esfuerzo cortante turbulento se incluye en la 
formulación de la viscosidad turbulenta para mejorar las predicciones del 
inicio de la separación del flujo para flujos en superficies lisas con gradientes 
de presión adversos, como los flujos sobre superficies aerodinámicas. 
 

➢ Modelo de tres ecuaciones SST 𝒌 − 𝝎 con modelo de transición de 
intermitencia adicional (SSTI) [50]. Una ecuación de transporte adicional 
para la intermitencia, 𝛾, se combina con las ecuaciones de transporte SST 
𝑘 − 𝜔 para predecir la transición del flujo de laminar a turbulento. El modelo 
SSTI es un modelo basado en correlación, lo que implica que se emplean 
correlaciones empíricas para el número de Reynolds de momento-espesor 
crítico, 𝑅𝑒𝜃𝑐, sensibilizarlo a la intensidad de turbulencia de corriente libre, 
𝑅𝑒, gradiente de presión, etc., para activar el modelo. De manera similar a 
los otros modelos de transición de ingeniería, el modelo solo es aplicable 
para el flujo limitado por la pared, por lo tanto, predecirá los flujos de corte 
libre como totalmente turbulentos. 
 

➢ Modelos de cuatro ecuaciones SST de transición (TSST) [51, 52]. 
También conocido como modelo 𝛾 − 𝑅𝑒𝜃, acopla dos ecuaciones de 
transporte adicionales, una para 𝛾 y otra para 𝑅𝑒𝜃, con las ecuaciones de 

transporte SST 𝑘 − 𝜔 para permitir que el modelo SST 𝑘 − 𝜔 prediga el inicio 
y la duración de la transición del flujo. La ecuación de intermitencia se usa 
para desencadenar la transición localmente, mientras que la ecuación de 
espesor de momento se emplea para capturar los efectos no locales del flujo 
para sensibilizar el modelo a la intensidad de la turbulencia de corriente libre 
y escala de longitud, 𝑅𝑒, gradiente de presión, etc. El modelo de transición 
es un modelo basado en correlaciones, lo que implica que se emplean 
correlaciones empíricas para 𝑅𝑒𝜃𝑐 para activar el modelo o para reconocer 
los casos en los que la transición podría pasarse por alto u evitarse debido a 
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niveles de turbulencia muy altos o bajos. El modelo ha sido probado para 
muchas aplicaciones de ingeniería diferentes [53–56] y es capaz de predecir 
las transiciones naturales, inducidas por separación y de derivación para 
flujos delimitados por paredes. Similar a los otros modelos de transición de 
ingeniería, el modelo predecirá los flujos de corte libre como completamente 
turbulentos. Los limitadores de producción turbulenta se incluyen para evitar 
una predicción excesiva de energía cinética turbulenta en regiones de 
estancamiento. 
 

 
Existen más modelos de turbulencia, de los presentados anteriormente; sin 
embargo, son algunos de los más populares empleados comúnmente en 
simulaciones de VAWT. Cada modelo de turbulencia tiene sus ventajas y 
desventajas, está fuera de este trabajo analizarlos a detalle, se recomienda al lector 
remitirse a [42, 57] para una descripción más detallada de la turbulencia y los 
modelos de turbulencia. 
 
Ghasemian et al. [12], hacen una recapitulación de todos los aspectos a considerar 
en una simulación CFD para VAWT: modelos de turbulencia, tamaño del dominio, 
solides del rotor, entre otros. Recapitulan 3 modelos turbulentos, sin hacer una 
comparación directa entre ellos. 
 
Rezaeiha et al. [44] realizan un análisis comparativo de siete modelos de turbulencia 
(SA, RNG, RKA, SST, SSTI, KKL y TSST) de uso común para simulaciones CFD 
de VAWT. La validación de las pruebas se hace con base en tres conjuntos de 
experimentos para tres VAWT con diferentes características geométricas que 
operan en una amplia gama de condiciones operativas, desde pérdida dinámica 
hasta régimen óptimo y régimen de flujo altamente rotacional. Se centran en la 
estela de la turbina, el rendimiento de potencia de la turbina y la aerodinámica de 
los álabes. Se emplean simulaciones URANS de alta fidelidad con flujo 
incompresible. El extenso análisis revela una alta sensibilidad de los resultados de 
la simulación al modelo de turbulencia. Los resultados muestran que los modelos 
SA, RNG, RKA y KKL fallan reproduciendo el rendimiento aerodinámico de las 
VAWT. Solo los modelos, SST, SSTI y TSST son capaces de exhibir un acuerdo 
razonable con todos los conjuntos de datos experimentales. Recomiendan los 
modelos SSTI y TSST como modelos de elección, especialmente en el régimen de 
flujo de transición. Hasta el momento no hay otro trabajo aparte del de Rezaeiha et 
al. [44], que realicen una comparación tan extensa y directa de modelos de 
turbulencia para VAWT. 
 
Para una comparación de modelos de turbulencia empleados en simulaciones de 
VAWT se recomienda ampliamente las referencias [12, 44]. 
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3.5 Malla del dominio computacional. 
 
La generación de la malla constituye uno de los pasos más importantes después de 
la creación de la geometría del dominio computacional [40]. Para realizar una 
simulación en CFD se requiere hacer una subdivisión del dominio en varios 
subdominios más pequeños que no se superpongan entre sí, esto da como 
resultado la generación de la malla o cuadrícula que está compuesta de celdas, 
elementos o volúmenes de control. 
 
La malla es esencialmente una representación discreta del dominio geométrico en 
el que se resolverá el problema [41]. El flujo del fluido se modela en cada una las 
celdas, en donde se resuelve numéricamente para determinar los valores de las 
propiedades del flujo (velocidad, presión, temperatura y entre otros parámetros de 
transporte). Esto produce la solución CFD. 
 
La precisión de una solución CFD se rige por el número de elementos en la malla. 
En general, un gran número de celdas conduce a una solución precisa; sin embargo, 
la precisión de una solución depende en gran medida por la calidad de los 
elementos y de las limitaciones impuestas por los costos computacionales y los 
tiempos de cálculo, que aumentan conforme aumenta el número de elementos [40]. 
Por lo anterior la malla debe generarse buscando la mejor relación entre precisión 
y el costo computacional (tiempo) de la solución. 
 
 

3.5.1 Malla estructurada. 
 
Las mallas regulares o mallas estructuradas (structured grid) consisten en familias 
de líneas de cuadrícula con la propiedad de que los miembros de una sola familia 
no se cruzan entre sí y se cruzan con cada miembro de las otras familias solo una 
vez, ver Fig. 3.5 y Fig. 3.6. Esto permite numerar consecutivamente las líneas de un 
determinado conjunto. La posición de cualquier punto de cuadrícula (o volumen de 
control) dentro del dominio se identifica de forma única mediante un conjunto de dos 
(en 2D) o tres (en 3D) índices, (i, j, k) [41]. 
 

 
Fig. 3.5. Ejemplo de malla estructurada. Obtenido de [40]. 

 
 



34 
 

 
Fig. 3.6. Malla estructurada en H. Obtenida de [40]. 

 
La malla estructurada es la distribución más simple, ya que es equivalente a una 
cuadrícula cartesiana [40]. Cada punto tiene cuatro vecinos más cercanos en dos 
dimensiones y seis en tres dimensiones.  
 
La conectividad de estas mallas simplifica la programación y la matriz del sistema 
de ecuaciones algebraicas. Al tener forma regular facilita la gestión de datos, que 
facilita la programación y el desarrollo de una técnica de solución.  
 
La desventaja de las mallas estructuradas es que para geometrías más complejas 
aumenta la no ortogonalidad, disminuyendo la calidad de los elementos lo que 
puede causar soluciones. Por ello solo se pueden usar para dominios de solución 
geométricamente simples [40]. Otra desventaja es que puede ser difícil controlar la 
distribución de los puntos de la cuadrícula: la concentración de puntos en una región 
por razones de precisión produce un espacio innecesariamente pequeño, ver Fig. 
3.6 y Fig. 3.7, en otras partes del dominio de la solución y un desperdicio de 
recursos. Este problema se exagera en los problemas 3D. Las celdas largas y 
delgadas también pueden afectar negativamente a la convergencia [41]. 
 
 

3.5.2 Malla no estructurada 
 
Es el tipo de malla más flexible, puede ajustarse a cualquier dominio de solución y 
son las más recomendadas para las geometrías complejas [41]. Los elementos 
pueden tener cualquier forma; sin embargo, las formas más típicas de un elemento 
no estructurado son el triángulo en dos dimensiones o el tetraedro en tres 
dimensiones [40]. No existe una restricción en el número de elementos vecinos o 
nodos.  
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Las mallas no estructuradas son adecuadas para manejar geometrías de formas 
arbitrarias, especialmente para dominios que tienen límites de alta curvatura [40, 
41]. La Fig. 3.7 ilustra el interior de un cilindro circular que se ha llenado a través de 
las rejillas estructuradas y no estructuradas. 
 

 
Fig. 3.7. Malla estructurada y no estructurada para un círculo. Obtenido de [40]. 

 
La ventaja de la flexibilidad se compensa con la desventaja de la irregularidad de la 
estructura de datos. Una celda elemental puede tener un número arbitrario de 
celdas vecinas adjuntas, lo que complica enormemente el tratamiento y la conexión 
de datos. La matriz del sistema de ecuaciones algebraicas ya no tiene una 
estructura diagonal [41].  
 
Las celdas triangulares (bidimensionales) o tetraédricas (tridimensionales) en 
comparación con las celdas cuadriláteras (bidimensionales) o hexaédricas 
(tridimensionales) generalmente son ineficaces para resolver las capas límite de la 
pared [40]. En la mayoría de los casos, la malla produce celdas muy largas, 
delgadas, triangulares o tetraédricas adyacentes a los límites de la pared, lo que 
crea problemas importantes en la aproximación de los flujos de difusión. 
 
Otra desventaja en relación con el tratamiento de datos y la conectividad de las 
celdas elementales es el requisito de algoritmos de solución más complejos para 
resolver las variables del campo de flujo. Los solucionadores de los sistemas de 
ecuaciones algebraicas suelen ser más lentos que los de las cuadrículas 
estructuradas. Esto resultar en mayores tiempos computacionales para obtener una 
solución [40]. 
 

Malla estructurada Malla no estructurada 

 

Vértice 

Vértice Vértice 

Vértice 
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3.5.3 Malla estructurada en bloques 
 
Las mallas estructuradas en bloques también son llamadas mallas compuestas o 
mallas multibloque (block-structured grids, composite o chimera grids) son un caso 
especial de las mallas estructuradas [40].  
 
En una malla estructurada en bloques, hay una subdivisión de dos o más niveles 
del dominio de la solución, también puede verse como un ensamble de varios 
bloques de mallas unidos entre sí [41]. Las uniones de cada cara de bloques 
adyacentes pueden ser regulares, es decir, con caras de celda coincidentes o 
arbitrarias, es decir, con interFaces de celda que no coinciden [40], ver Fig. 3.8. 
 

 
Fig. 3.8. Malla estructurada en bloques con caras de elementos coincidentes y no coincidentes. 

Obtenido de [40]. 

Caras de elementos coincidentes 

Caras de elementos no coincidentes 
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La información entre los diferentes bloques se logra a través de la interpolación. Las 
ventajas de emplear dichas cuadrículas son que los dominios complejos se tratan 
con facilidad y pueden emplearse especialmente para seguir cuerpos en 
movimiento en entornos estáticos [41].  
 
Las desventajas son que la conservación generalmente no se mantiene ni se aplica 
en los límites de los bloques, y el proceso de interpolación puede introducir errores 
o problemas de convergencia si la solución exhibe una fuerte variación cerca de la 
interfaz. 
 
Como práctica común, la calidad de la cuadrícula generalmente se mejora mediante 
la colocación de elementos cuadriláteros o hexaédricos en la resolución de capas 
límite cerca de paredes sólidas, mientras que los elementos triangulares o 
tetraédricos se generan para el resto del dominio de flujo. Esto generalmente 
conduce tanto a soluciones precisas como a una mejor convergencia para los 
métodos de solución numérica [40]. La Fig. 3.9 ilustra un ejemplo de una cuadrícula 
que consta de elementos cuadriláteros cerca de las paredes y elementos 
triangulares para el resto del dominio. 
 

 
Fig. 3.9. Malla que consta de elementos estructurados cerca de las paredes y elementos no 

estructurados en la parte restante del dominio de flujo. Obtenida de [40]. 

 
  

Vista aumentada 
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3.6 Cálculos de capa limite 
 
El estudio del rendimiento del rotor para las VAWT se basa en la obtención del valor 
del par, torque o momento en las paredes de los álabes del rotor, con lo cual se 
puede obtener el 𝐶𝑝 de la turbina eólica. El valor del torque se calcula sobre la 

superficie del álabe del rotor. Se impone una condición de no deslizamiento (no slip 
condition) en las paredes de los álabes, lo que contribuye a la formación de una 
capa límite y crea la necesidad de un tratamiento preciso en la superficie de los 
álabes. Esto requiere un mallado lo suficientemente fino cerca de las paredes, 
también denominado mallado de capa límite [58]. 
 
La malla de la capa límite se puede preparar automáticamente mediante el software 
de mallado, la precisión depende de los valores de entrada proporcionados al 
software antes de ejecutar el proceso de mallado. La distancia del primer nodo de 
malla a la superficie del álabe del rotor es un valor de entrada importante, que se 
calcula cuidadosamente, ya que la idoneidad de la malla generada para la 
simulación depende de este parámetro. 𝑦+ es un parámetro adecuado para estimar 
el valor correcto de la distancia del primer nodo a la pared del álabe [58]. La distancia 
del primer nodo a la pared, 𝑦+, es la proporción entre las influencia turbulenta y 
laminar en una celda [59]. 
 
No es posible conocer el valor exacto de 𝑦+ antes de realizar la simulación, ya que 
depende del perfil de velocidad real sobre la pared, y este solo se conoce hasta 
finalizar la simulación. Debido a tal problemática el valor de la distancia del primer 
nodo se estima para una placa plana utilizando los parámetros de flujo. Los valores 
más bajos de 𝑦+ indican que el primer nodo está en la subcapa laminar, lo que 
sugiere ajustar el perfil de velocidad lineal y los valores más altos de 𝑦+ indican el 
uso de la ley logarítmica [58].  
 
En el presente trabajo se aplica un 𝑦+ ≈ 1 para obtener mejores soluciones 
cercanas a la pared, como lo demuestran [40, 59–67]. La distancia del primer nodo 
desde la pared se calcular despejando ∆𝑦𝑝 de la Ec. 3.1, obtenida de [39]. 

 

𝑦+ =
∆𝑦𝑝

𝜈
√

𝜏𝑤

𝜌
 Ec. 3.1 

 
 

3.7 Flujo estacionario y no estacionario  
 
En CFD es común el uso de nomenclatura en idioma inglés para flujo estacionario 
el equivalente es Steady Flow y para flujo no estacionario el equivalente es 
Unsteady Flow. En los flujos estacionarios los parámetros de flujo, como la 
velocidad, la presión y la densidad para cualquier punto son independientes del 
tiempo, permaneciendo constantes. Aclarando que las propiedades pueden diferir 
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de un punto a otro, pero no cambian para un mismo punto con respecto al tiempo 
[68].  
 
El flujo estacionario ideal solo se presenta en el flujo laminar. En la práctica siempre 
hay ligeras variaciones en las propiedades del flujo. En el flujo turbulento, hay 
fluctuaciones continuas en la velocidad y la presión en cada punto. Pero si esta tasa 
de cambio de presión y velocidad son iguales en ambos lados de un valor promedio 
constante, el flujo se puede considerar como estacionario. Se le denomino flujo 
estacionario medio. 
 
En un flujo no estacionario o inestable los parámetros del flujo en cualquier punto 
dependen del tiempo, es decir, van cambiando [68]. El flujo inestable es un 
fenómeno transitorio. Puede ser que con el tiempo se convierta en flujo constante o 
cero. Por ejemplo, cuando se cierra una válvula en el extremo de descarga de la 
tubería, provocando que la velocidad en la tubería disminuya a cero; sin embargo, 
mientras tanto, habrá fluctuaciones tanto en la velocidad como en la presión dentro 
de la tubería. 
 
El flujo inestable también puede incluir un movimiento periódico como el de las olas 
de las playas. La diferencia entre estos casos y el flujo estacionario medio es que 
hay mucha desviación de la media y la escala de tiempo también es mucho más 
larga [69]. 
 
En CFD al calcular flujos no estacionarios, se tiene una cuarta dirección de 
coordenadas a considerar: el tiempo. Al igual que con las coordenadas espaciales, 
el tiempo debe discretizarse. La principal diferencia entre las coordenadas de 
espacio y tiempo radica en la dirección de la influencia: mientras que una fuerza en 
cualquier lugar del espacio puede influir en el flujo en cualquier otro lugar, la fuerza 
en un instante dado afectará el flujo solo en el futuro; no hay influencia en el pasado 
[41]. 
 
En las simulaciones no estacionarias no se pueden imponer condiciones a la 
solución en ningún momento después del inicio del cálculo, únicamente se pueden 
imponer las condiciones de frontera [41]. Para ser fieles a la naturaleza del tiempo, 
esencialmente todos los métodos de solución avanzan en el tiempo paso a paso o 
en forma de "marcha".  
 
 

3.8 Malla en movimiento 
 
En los softwares CFD por defecto las ecuaciones de flujo de fluidos y transferencia 
de calor se resuelven en un marco de referencia estacionario (o inercial). Sin 
embargo, hay muchos problemas en los que es ventajoso resolver las ecuaciones 
en un marco de referencia móvil (o no inercial). Dichos problemas generalmente 
involucran partes móviles (como palas giratorias, impulsores, álabes, entre otros), y 
lo que interesa es el flujo alrededor de estas partes móviles. En la mayoría de los 
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casos, las partes móviles hacen que el problema sea inestable cuando se resuelve 
desde el marco estacionario. Sin embargo, con un marco de referencia móvil, el flujo 
alrededor de la parte móvil puede (con ciertas restricciones) modelarse como un 
problema de estado estacionario con respecto al marco móvil [70]. 
 
Muchas aplicaciones de ingeniería requieren el uso de mallas móviles. Un ejemplo 
importante es la interacción rotor-estator, que es bastante común en las 
turbomáquinas y las mezcladoras: Se trata de dos mallas (o más), una malla está 
unida al estator y no se mueve, mientras que la otra malla está unida al rotor y le 
permite moverse libremente en el tiempo [40]. Existe una interfaz entre ambas 
mallas. 
 
Hay varios enfoques para las mallas en movimiento. Si las mallas coinciden en la 
interfaz en el momento inicial, se puede permitir que la parte giratoria de la rejilla se 
mueva mientras se mantienen los puntos límite "pegados" a la rejilla fija, hasta que 
la deformación se vuelve sustancial; luego, los puntos límite "saltan" una celda hacia 
adelante y permanecen pegados a la nueva ubicación por un tiempo. Este es un 
tipo de enfoque de malla tipo "clic" [41]. 
 
Otra posibilidad es dejar que la malla móvil se "deslice" a lo largo de la interfaz sin 
deformarse. En este caso, las cuadrículas no coinciden en la interfaz, por lo que 
algunos elementos tienen más vecinos que otros. Sin embargo, esta situación es 
completamente análoga a la que se encuentra en las redes estructuradas en 
bloques con caras que no coinciden; la única diferencia es que la conectividad de la 
celda cambia con el tiempo y debe restablecerse después de cada paso de tiempo 
[41].  
 
Otra alternativa es que la región de superposición entre ambas mallas cambie con 
el tiempo y la relación entre ambas debe restablecerse después de cada paso de 
tiempo, es decir, después de cada paso de tiempo se realiza un nuevo mallado. La 
malla fija puede cubrir todo el "entorno" en el que se mueve el cuerpo [41]. 
 
Las mismas ecuaciones y métodos de discretización se aplican tanto a la malla fija 
como a la móvil. Las cuadrículas no tienen que coincidir en la interfaz; esto permite 
flexibilidad en el empleo de diferentes tipos de mallas y/o lograr la finura deseada 
en los dominios respectivos. Exceptuando las dificultades para asegurar la 
conservación exacta de las propiedades de flujo, no hay limitaciones en la 
aplicabilidad de las mallas móviles [40]. 
 
 

3.8.1 Modelado de flujos con marcos de referencia móviles 
 
Cuando se activa un marco de referencia móvil, las ecuaciones de movimiento se 
modifican para incorporar los términos de aceleración adicionales que ocurren 
debido a la transformación del marco de referencia estacionario al móvil. Al resolver 
estas ecuaciones en estado estacionario, se puede modelar el flujo alrededor de las 
partes móviles [71].  
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Para muchos problemas, puede ser posible referenciar todo el dominio 
computacional a un solo marco de referencia en movimiento. Esto se conoce como 
el enfoque del marco de referencia único (o SRF, Single Reference Frame), también 
existen otros enfoques en los que se requieren múltiples marcos de referencia (o 
MRF, Multiple Reference Frame). Sin embargo, si la interacción no estacionaria del 
flujo entre las partes fijas y móviles es importante, puede emplear el enfoque de 
malla deslizante (sliding mesh) para capturar el comportamiento transitorio del flujo 
[72]. 
 
En la técnica de marco de referencia único, se cuentan con dos mallas unidas 
mediante una interfaz. Ambas mallas son estáticas, pero las ecuaciones 
gobernantes se modifican para simular el efecto del movimiento, otorgando una 
solución aproximada al comportamiento que tendría. Se puede utilizar la técnica de 
simulación SRF o MRF de estado estable para obtener una solución inicial para una 
simulación de malla deslizante transitoria en una turbomáquina [70]. 
 
 

3.8.2 Modelado de flujos con malla deslizante 
 
La técnica de malla deslizante (o Sliding Mesh) permite configurar un problema en 
el que las zonas o mallas separadas se mueven entre sí. El movimiento puede ser 
de traslación o de rotación. El movimiento relativo de los componentes estacionarios 
y móviles (por ejemplo, en una máquina giratoria) dará lugar a interacciones 
transitorias [70].  
 
En la técnica de malla deslizante, se cuenta con dos o más mallas, en la que todos 
los límites y las celdas de una zona de malla dada se mueven juntas en un 
movimiento de cuerpo rígido. En esta situación, los nodos de la malla se mueven en 
el espacio (en relación con las coordenadas globales fijas), pero las celdas definidas 
por los nodos no se deforman. Las zonas de malla que se mueven adyacentes entre 
sí se pueden vincular a través de una o más interFaces. Siempre que las interFaces 
permanezcan en contacto entre sí (es decir, se “deslicen” a lo largo de un límite de 
superposición común en la interfaz), las interFaces se pueden actualizar a medida 
que se mueven las mallas y el fluido puede pasar de una zona a otra [71]. 
 
La solución transitoria que se busca en una simulación de malla deslizante es 
periódica en el tiempo. Es decir, la solución transitoria se repite con un período 
relacionado con las velocidades de las mallas en movimiento [70]. 
 
Cuando se desea una solución precisa en el tiempo (en lugar de una solución 
promediada en el tiempo) para la interacción rotor-estator, se debe usar la malla 
deslizante para calcular el campo de flujo no estacionario, ya que es el método más 
preciso para simular flujos en múltiples marcos de referencia en movimiento, pero 
también es más exigente desde el punto de vista computacional que los marcos de 
referencia [70]. 
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Para problemas en los que no se deforma el cuerpo o la malla, se recomienda el 
modelo de malla deslizante, ya que es más simple y eficiente [70].  
 
 

3.8.3 Modelado de flujos con mallas dinámicas. 
 
La técnica de malla dinámica se puede usar para modelar flujos donde la forma del 
dominio cambia con el tiempo debido al movimiento en los límites del dominio. La 
malla dinámica permite mover los límites de una zona de celda en relación con otros 
límites de la zona y ajustar la malla en consecuencia [71].  
 
El movimiento de los límites puede ser rígido, como los pistones que se mueven 
dentro de un cilindro de motor o una aleta que se desvía en el ala de un avión, o 
deformables, como la pared elástica de un globo durante el inflado o una pared 
arterial flexible que responde al pulso de presión del corazón [70]. En cualquier caso, 
los nodos que definen las celdas en el dominio deben actualizarse en función del 
tiempo y, por lo tanto, las soluciones de malla dinámica son inherentemente 
inestables. Las ecuaciones gobernantes que describen el movimiento del fluido son 
diferentes de las que se usan para mover marcos de referencia [71]. 
 
La malla dinámica debe usarse si la malla se está deformando o si el movimiento 
de la malla es una función de la solución, también es mucho más demandante en 
términos computacionales en comparación con las técnicas de marcos de referencia 
móviles y la técnica de malla deslizante [70]. 
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Capítulo IV. Procedimiento para simulación en CFD 
 
En el presente capitulo se describe a grandes rasgos el proceso de trabajo. Se 
aplica la metodología presentada en el Capítulo III, para la solución de problemas 
con CFD esquematizada en la Fig. 3.3. Para mayores detalles en algunos aspectos 
como la construcción del rotor, el mallado y la configuración del solucionador se 
pueden consultar el Anexo A, Anexo B y Anexo C.  
 
Los temas que se abordan en el capítulo son: creación de la geometría; generación 
de la malla; selección de propiedades físicas y propiedades de los fluidos; 
especificación de condiciones de frontera e inicialización, control de la solución y 
supervisión de la convergencia.  
 
El rango de operación de la turbina es de 2.5m/s a 10m/s, se realizan 6 simulaciones 
usando la técnica de Sliding Mesh a diferentes velocidades para abarcar el rango 
operativo (2.5m/s, 4m/s, 5.5m/s, 7m/s, 8.5m/s y 10m/s) y poder estimar el 𝐶𝑝 y 

potencia generada por la turbina. En la técnica de simulación empleada se usan dos 
mallas “rotor” y “estator”. En la malla del rotor se encuentra la geometría del rotor 
de la turbina eólica y es la que tendrá movimiento a una determinada velocidad 
angular en función de la velocidad del viento. La malla del estator es estática. 
 
Se elaboran tres mallas para el rotor, tres mallas para el estator y se evalúan 
distintas combinaciones para realizar el estudio de independencia de malla para la 
velocidad de 7m/s, la combinación de malla obtenida a partir del estudio se emplea 
para el resto de las simulaciones de las velocidades faltantes. Primeramente, se 
evalúa la combinación de las tres mallas del rotor con la malla más densa y con 
mejor calidad del estator. Habiendo seleccionado la malla del rotor se procede a 
combinar y evaluar con el resto de las mallas del estator. Finalmente, se selecciona 
la combinación óptima de malla de estator y rotor.  
 
Debido a la falta de datos experimentales con los cuales poder comparar los 
resultados de la simulación, el proceso de trabajo se respalda con base en la 
literatura especializada, para temas referentes al uso del software se consultaron 
los manuales de usuario [70–76] y material elaborado por la empresa del software 
para el empleo de Moving Reference Frames y Sliding Mesh [77]. Así mismo, se 
añade al proceso de trabajo la validación de la configuración del solucionador de 
CFD mediante la simulación de una turbina eólica reportada en la literatura que 
contara con simulación [66] y datos experimentales [78]. 
 
 

4.1 Creación de la geometría  
 
CIATEQ diseñó y proporcionó la geometría en formato IGS de la turbina eólica de 
eje vertical, así como algunos parámetros de diseño. La turbina costa de dos 
rotores: un rotor H y un rotor Savonius, se trata de un diseño de turbina híbrida H-
Savonius, la Fig. 4.1 muestra la geometría recibida con todos los detalles.  
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El rotor H está compuesto por tres álabes rectos con un pérfil asimétrico NACA2415 
distribuidos uniformemente, tiene una altura de 2m y un diámetro de 2.4m. El rotor 
tipo Savonius cuenta con un total de 12 álabes semicirculares, distribuidos en dos 
niveles, cada nivel tiene 6 álabes, ver Fig. 4.1, está ubicado en el centro del rotor, 
tiene una altura de 1m y un diámetro de 96cm. 
 
En el Capítulo III se mencionó que en la mayoría de las simulaciones de CFD se 
necesitan hacer suposiciones y/o simplificaciones para reducir la complejidad a un 
nivel manejable y que al mismo tiempo se conserven las características principales 
del problema. En las simulaciones de VAWT con CFD, es una práctica habitual 
realizar una primera simplificación quitando todos los elementos de soporte que no 
contribuyen o afectan en gran medida a la aerodinámica del rotor de la turbina; 
ejemplos de esto se puede encontrar en la literatura [12, 30, 33, 44, 59, 65, 66, 79-
83]. A la geometría de la turbina eólica facilitada por CIATEQ se realiza la 
simplificación anteriormente mencionada, dejando únicamente los 12 álabes de la 
turbina Savonius y los 3 álabes de la turbina Darrieus.  
 

 
Fig. 4.1. Vista dimétrica del rotor de la turbina H-Savonius con los elementos de soporte y sujeción 

 
La simplificación se realiza para ahorrar recursos computacionales ya que los 
detalles innecesarios de la geometría como los pernos, tuercas y elementos de 
soporte, dificultan la simulación al exigir mayor capacidad de cómputo tanto para el 
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proceso de simulación como para el proceso de mallado, complicando los cálculos 
y aumentando el tiempo de simulación. La simplificación realizada al rotor se 
muestra en la Fig. 4.2. 
 

  
Fig. 4.2. Vista dimétrica del rotor H-Savonius sin los elementos de soporte y sujeción. 

 
Es necesario decidir si el modelado y simulación de la turbina se realiza en dos o 
tres dimensiones. En cualquiera de los dos escenarios, 3D o 2D, es necesario tener 
en consideración los factores más importantes para una simulación de VAWT en los 
que se encuentran la discretización del espacio, la extensión del dominio 
computacional, las condiciones de frontera y el modelado de turbulencia. El tamaño 
del paso de tiempo es otro parámetro crucial en los flujos no estacionarios y es de 
particular relevancia para el análisis VAWT, debido a su aerodinámica no 
estacionaria inherente [67]. 
 
El modelado en 3D demanda una gran cantidad de recursos computacionales y 
tiempo de simulación que hace que estos modelos sean casi prohibitivos para fines 
de diseño e históricamente ha llevado a los investigadores a emplear modelos de 
2D [67].  
 
Desde la perspectiva técnica, los modelos 2D permiten capturar los efectos físicos 
relevantes de la dinámica de fluidos; sin embargo, estos modelos tienden a 
sobrestimar la potencia generada por la turbina y su coeficiente de potencia, 𝐶𝑝 [67]. 

Esto se debe a diversos factores como vórtices de arrastre, pérdidas de punta, 
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divergencia de flujo a lo largo del tramo debido al efecto de ducto, entre muchos 
otros.  
 
Se han publicado pocos estudios en 3D en comparación con 2D sobre simulaciones 
de VAWT. Construir un modelo de flujo 3D factible y confiable de VAWT requiere 
considerar varios parámetros numéricos. Así mismo, las mallas computacionales 
empleadas en la mayoría de los estudios en 3D parecen bastante toscas si se 
comparan con sus contrapartes en 2D, esto debido a las restricciones por el costo 
computacional. 
 
Por ejemplo, la malla empleada por Untaroiu et al. [83] para simular una turbina H 
de dos álabes es de casi 8 millones de elementos (7.9𝑥10^6 elementos) con un 

𝑦+ ≈ 6, la turbina que analizaron fue una H-Darrieus de 2 álabes con perfil 
NACA0018 con una cuerda de 6cm, altura de 1m y diámetro de 1m. . En las 
simulaciones de VAWT de 2D se tiende a emplear una malla con un 𝑦+ que varía 
entre 1 y 2 [40, 59–67].  
 
Otro ejemplo lo proporciona Balduzzi et al. [84] al emplear una malla con un 𝑦+ ≈ 1 
de 64 millones de elementos para simular la mitad de un solo álabe de una turbina 
H-Darrieus utilizando más de 16 000 núcleos de procesador en un clúster IBM 
BG/Q. La simulación constó de 12 revoluciones y duró 653 horas (27.2 días). Así 
mismo estiman que para asegurar un nivel adecuado de refinamiento espacial se 
necesitaría una malla con más de 100 millones de elementos para modelar el rotor 
de la turbina completa. La turbina que analizaron fue una H-Darrieus de 3 álabes 
con perfil NACA0021 con una cuerda de 8.58cm, altura de 1.5m y diámetro de 
1.03m. 
 
Por lo anterior y para poder proporcionar datos confiables a CIATEQ que le permitan 
corroborar el diseño de su turbina se decide hacer la simulación en 2D. Sin 
embargo, la turbina híbrida no mantiene la misma sección a lo largo del eje de 
rotación, debido a las distintas alturas de los rotores, en el rotor H la altura es de 2m 
mientras que en el rotor Savonius es de 1m. Tomando un plano perpendicular al eje 
de rotación y moviéndolo de abajo hacia arriba, se observa que al inicio en el plano 
solo se encuentran los tres álabes de la turbina H, conforme se avanza aparecen 
los 12 álabes de la turbina Savonius, teniendo en este punto los álabes de la turbina 
H y la turbina Savonius, conforme se sigue avanzando desaparecen los álabes de 
la turbina Savonius quedando únicamente los álabes de la turbina H, ver Fig. 4.3. 
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Fig. 4.3. Planos perpendiculares al eje de rotación de la turbina híbrida.  

 
El plano superior e inferior que aparecen en la Fig. 4.3 son iguales, corresponden a 
la turbina H, el plano central corresponde a la turbina híbrida. Para calcular la 
potencia y el 𝐶𝑝 de la turbina híbrida se emplearán dos simulaciones. La primera 

simula la turbina híbrida, sección central, en 2D bajo la suposición de que la altura 
de ambos rotores (H y Savonius) es de 1m. La segunda simulación correspondiente 
a la parte restante de la turbina (0.5m del rotor H superior a la sección de la turbina 
híbrida y 0.5m del rotor H inferior a la sección de la turbina híbrida) se aproxima 
mediante la simulación en 2D de un rotor H con una altura de 1m, ver Fig. 4.4. 
 
A la geometría simplificada de la Fig. 4.2, se le realiza ingeniería inversa para 
determinar las medidas de sus componentes y posteriormente se modela en dos 
dimensiones en ANSYS DesignModeler.  
 
Los dominios computacionales se realizan en dos archivos independientes, uno 
para el rotor y otro para el estator. Para construir el dominio del rotor, se trazan los 
álabes del rotor tipo Savonius y después se hace uso de la herramienta “Surfaces 
From Sketch”, para el rotor H se importa el perfil NACA2415 y se usa la herramienta 
“Surface From Edges”. Ver Fig. 4.5. Se hace un nuevo Sketch con la geometría de 
una circunferencia con centro en el origen y después se hace uso de la herramienta 
“Surfaces From Sketch”. Finalmente se usan operaciones booleanas para obtener 
el dominio computacional final del rotor, restándole a la circunferencia los álabes de 
la turbina híbrida. Todo con la finalidad de no tener espesor y poder realizar la 
simulación en 2D, ver Fig. 4.6. 
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Fig. 4.4. Proceso de simplificación para la simulación de la turbina híbrida en 2D. 
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Fig. 4.5. Geometría del rotor simplificado en 2D creada con ANSYS DesignModeler. 

 
Para el estator se hace un rectángulo con un hueco circular. En lo referente al 
dimensionamiento de los volúmenes se realizó una amplia búsqueda en la literatura 
[12, 30, 33, 44, 59, 65, 66, 79–83], y con base en las recomendaciones de Rezaeiha 
et al. [66] se dimensionan los volúmenes.  
 

 
Fig. 4.6. Dominio computacional del rotor creada con ANSYS DesignModeler. 

 
El diámetro del dominio para el rotor es de 1.5𝐷, ver Fig. 4.6, siendo 𝐷 el diámetro 

del rotor, para el estator tiene dimensiones de 20𝐷 𝑥 30𝐷, el centro del hueco 
circular de 1.5𝐷 para el rotor se encuentra a 10𝐷 respecto del frente, a 20𝐷 respecto 
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del reverso y centrado respecto de los laterales (a 10𝐷 de cada lateral), como se 
muestra en la Fig. 4.7.  
 

 
Fig. 4.7. Plano del dominio computacional del estator. 

 
Se nombran las diferentes partes del dominio del rotor y del estator como se muestra 
en la Fig. 4.8 y Fig. 4.9, respectivamente. Para mayor detalle del dominio del rotor 
se puede consultar la Fig. A.28. 
 

 
Fig. 4.8. Nomenclatura del dominio computacional del rotor. 
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Fig. 4.9. Nomenclatura del dominio computacional del estator. 

 
En el caso de la geometría de los discos de inducción, igualmente, fue realizada en 
ANSYS DesignModeler en un Skech se traza el perfil elíptico de los discos y se usa 
la operación de Revolve para crear los discos en 3D. Los discos tienen un diámetro 
de 6.5m, la separación entre discos es de 1.6m que es la sección más estrecha del 
área sombreada de la Fig. 4.10, el espesor de los discos es de 0.9m. Los discos 
fueron diseñados para una turbina de eje vertical con un diámetro de 2.3m y una 
altura de 1.5m.  
 
Se empleo un dominio computacional lo bastante grande para evitar que las paredes 
estuvieran cerca de los discos e influyeran en el desarrollo del flujo del viento. 
Descontando el área transversal de los discos al área de la cara frontal del volumen 
de control el porcentaje de área libre para que circule el viento es de 97.9%, que es 
el área sombreada de la Fig. 4.11.  
 
Se modeló un volumen de control de un prisma rectangular de 22m de ancho por 
20m alto por 30m de largo, el centro de los discos se encuentra a 10m de la Cara A 
y 20m de la Cara B, ver Fig. 4.12. Se nombran las diferentes partes del dominio, 
para las superficies u áreas que son la Cara A se nombra como Inlet, la Cara B 
como Outlet, las 4 caras iguales restantes del prisma rectangular se nombran como 
Outline y la superficie de los discos inductores como Disc, el interior del dominio 
computacional, que es un volumen, se nombra como Inside. 
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Fig. 4.10. Vista trasversal de los discos de inducción, el área sombreada en gris oscuro representa la 

reducción que sufre el viento al pasar por los discos. 

 

 
Fig. 4.11. Figura representativa del porcentaje de reducción de área con los discos de inducción. 

 

 
Fig. 4.12. Dominio computacional de los discos de inducción. 
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4.2 Generación de la malla 
 
El diseño de la malla para el dominio computacional del estator usa una malla 
estructurada con elementos cuadráticos, refinando en la zona próxima a 
InterfaceEstator que es donde se ubicaría el dominio del rotor, ver Fig. 4.13. La 
utilización de las herramientas y las técnicas de mallado se explica a detalle en el 
Anexo B. Se realizaron tres mallas el número de elementos y nodos de encuentran 
en la Tabla 4.1. 
 

 
Fig. 4.13. Malla del estator con detalles del refinamiento de malla, malla E1. 
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Tabla 4.1. Número de elementos y nodos para cada malla del estator. 

Malla E1 E2 E3 

Número de elementos 364,068 151,364 62,664 

Numero de nodos 365,560 152,288 63,256 

 
El diseño de la malla para el dominio computacional del rotor usa una malla no 
estructurada con elementos triangulares y rectangulares. Los elementos 
triangulares son los predominantes, se refina la malla cerca de los álabes (RotorH, 
RotorS_Interior y RotorS_Exterior) y en el límite del dominio (InterfaceRotor), ver 
Fig. 4.14. Se emplea una inflación con los elementos rectangulares en las paredes 
de los álabes, con la finalidad de mejorar la calidad de la malla, obtener un mayor 
detalle de la capa límite, buscar una solución más precisa y una mejor convergencia. 
La utilización de las herramientas y las técnicas de mallado se explica a detalle en 
el Anexo B. Se realizaron tres mallas el número de elementos y nodos de 
encuentran en la Tabla 4.2. 
 

 
Fig. 4.14. Malla del rotor con detalles del refinamiento de malla, versión R1. 
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Tabla 4.2. Número de elementos y nodos para cada malla del rotor 

Malla R1 R2 R3 

Número de elementos 1,051,697 585,542 487,467 

Numero de nodos 830,219 517,202 428,569 

 
Un parámetro fundamental para la simulación de VAWT, y que forma parte de la 
etapa de mallado para poder aplicar la herramienta de inflación correctamente, es 
el cálculo del grosor del primer estrato de la malla de la capa limite. Es imposible 
calcular este valor de forma exacta, ya que está relacionado de forma directamente 
proporcional al valor de 𝑦+, ver Ec. 3.1. El valor de 𝑦+ se conoce únicamente al 
finalizar la simulación para una malla especifica. Para lidiar con esta problemática, 
en la práctica, se despeja ∆𝑦𝑝 de la Ec. 3.1 y con un valor de 𝑦+ deseado, los 

parámetros geométricos del dominio computacional y los parámetros de flujo para 
la simulación, se calcula un aproximado. Existen herramientas online que facilitan 
el cálculo anterior, como la ofrecida por la empresa Cadence® en su sitio web oficial 
[85]. Para las simulaciones del rotor de la turbina eólica se usa un 𝑦+ ≈ 1. 
 
Dado que el valor del grosor del primer estrato de la malla de la capa limite depende 
de la velocidad del flujo, esta cambiara en el rango de velocidades para las que se 
realizara las simulaciones, los valores para cada velocidad se pueden consultar en 
la Tabla B.2 para el rotor H y en el anexo B para el rotor Savonius. Igualmente, al 
cambiar el grosor de la primera capa de la inflación, cambia el número de elementos 
en la malla; sin embargo, este cambio es despreciable y se toman como referente 
los valores presentados en la Tabla 4.2. 
 
En los discos de inducción se utilizó una malla no estructurada con elementos 
tetraédricos y prismas triangulares. Los elementos tetraédricos predominan y se 
empleó una inflación con los elementos primas triangulares alrededor de la zona de 
los discos de inducción como se muestra en la Fig. 4.15.  
 
Se usó un refinamiento de la malla en el área de los discos de inducción por el 
método de esfera de influencia, el centro de la esfera corresponde al centro de los 
discos de inducción a la mitad de la altura que los separa. La malla para la geometría 
elíptica cuenta con aproximadamente de 3.7 millones de elementos. 
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Fig. 4.15. Malla de los discos de inducción con detalle del refinamiento de malla. 

 
 

4.3 Selección de propiedades físicas y propiedades de los fluidos 
 
Para el rotor, con los datos proporcionados por CIATEQ son la ubicación de la 
instalación, el TSR de la turbina H, siendo este de 3 y el rango de velocidades de 
viento a las que opera la turbina, desde 2.5m/s a la velocidad de corte de 10m/s. La 
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ubicación de la turbina eólica será en una de las instalaciones con las que cuenta 
de CIATEQ, en la sede de CIATEQ Zapopan, Jalisco, México. Ver Fig. 4.16.  
 

 
Fig. 4.16. Ubicación de CIATEQ, Zapopan, Jalisco, obtenida de Google Earth [86]. 

 
El fluido de trabajo para las simulaciones CFD presentadas en este trabajo es el 
aire, el cual puede modelarse como compresible (densidad variable) o 
incompresible (densidad constante).  
 
Las propiedades más importantes de los fluidos simples son la densidad y la 
viscosidad [41]. La velocidad de un flujo afecta sus propiedades de varias formas. 
La relación entre la velocidad del flujo y la velocidad del sonido en el fluido (el 
número de Mach) determina si es necesario considerar el intercambio entre la 
energía cinética del movimiento y los grados internos de libertad en una simulación 
CFD. Para números de Mach pequeños, 𝑀𝑎 < 0.3, el flujo puede considerarse 
incompresible [41]. Literatura más especializada para simulaciones de turbinas 
eólicas de eje vertical de baja potencia indican que el aire se modela en régimen 
turbulento e incompresible siempre que el número de Mach sea menor que 0.1 [67]. 
 
Se denomina al flujo compresible o incompresible según el número de Mach, 
aunque la compresibilidad es una propiedad del fluido. Esta es solo una terminología 
común, ya que el flujo de un fluido compresible con un número de Mach bajo es 
esencialmente incompresible. 
 
El número de Mach está definido como la relación entre la velocidad del cuerpo o 
del viento y la velocidad del sonido [87], matemáticamente se expresa en la Ec. 4.1. 
 

𝑀𝑎 =
𝑉∞

𝑎
=

𝑉∞

√𝛾𝑅𝑇
=

𝑉∞

√
𝛾𝑝
𝜌

=
𝑉∞

√
𝑐𝑝𝑝
𝑐𝑣𝜌

 
Ec. 4.1 
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Cabe señalar que la relación 𝑅𝑇 = 𝑝/𝜌 es válida para gases ideales. Procedemos a 
calcular el número de Mach máximo que podremos obtener en nuestras 
simulaciones. Para las simulaciones utilizaremos velocidades desde los 2.5m/s 
hasta los 10m/s; sin embargo, como también analizaremos los discos inductores 
con los que se espera que exista un aumento de velocidad que se espera que sea 
menor de 1.5 veces 𝑈∞, la mayor velocidad que podríamos obtener seria de 15m/s. 
Para evitar cualquier posible inconveniente se evalua con 20m/s. 
 
La densidad del aire es 𝜌 = 1.225𝑘𝑔/𝑚3 a condiciones estándar 15 °C y a nivel del 
mar (𝑝 = 101.325𝐾𝑃𝑎 = 1𝑎𝑡𝑚) de acuerdo a la norma ISO 2533:1975 [88].  
 
Del libro Termodinámica [89] de la Tabla A-2, titulada Calores específicos de gas 
ideal de varios gases comunes se obtienen los valores de 𝑐𝑝 = 1.005 𝑘𝐽/𝑘𝑔 ∙ 𝐾 y 

𝑐𝑣 = 0.718 𝑘𝐽/𝑘𝑔 ∙ 𝐾. Se calcula el número de Mach con la Ec. 4.1. 
 

Ma =
20𝑚/𝑠

√
(1.005 𝑘𝐽/𝑘𝑔 ∙ 𝐾)(101325𝑃𝑎)

(0.718 𝑘𝐽/𝑘𝑔 ∙ 𝐾)(1.225𝑘𝑔/𝑚3)

≈ 0.05878 

 
Al obtener un numero de Mach menor de 0.1 se puede modelar el aire como 
incompresible, es decir, con densidad constante. 
 
 

4.3.1 Cálculo de densidad 
 
Manwell et al. [8], calculan la densidad del aire con la ecuación de los gases ideales, 
despejando la densidad como se muestra en la Ec. 4.2. 
 

𝜌 =
𝑝

𝑅𝑎𝑖𝑟𝑒𝑇
 Ec. 4.2 

 
Es necesario conocer entonces la temperatura y la presión del aire en el lugar de 
instalación de la turbina. La presión disminuye con la elevación sobre el nivel del 
mar. Para determinar la presión en la atmósfera en el lugar de instalación de la 
turbina se precisa conocer la altura sobre el nivel del mar a la altura del centro del 
rotor de la turbina. La presión en la atmósfera estándar internacional hasta una 
altura de 5000m se puede aproximar mediante la Ec. 4.3 [8], como nota aclaratoria 
la presión obtenida por la ecuación se encuentra en unidades de kPa. 
 

𝑝 = 101.29 − (0.011837)𝑧 + (4.793 × 10−7)𝑧2 Ec. 4.3 

 
De Google Earth [86] se obtiene la altura sobre el nivel del mar que es 
aproximadamente de 1600m. Al desconocer si la turbina será instalada encima de 
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alguno de los edificios o si será a nivel de piso de las instalaciones de CIATEQ se 
toma el valor de 𝑧 = 1600𝑚 como una buena aproximación, sustituyendo en la Ec. 
4.3 para estimar la presión.  
 

𝑝 = 101.29 − (0.011837)1600 + (4.793 × 10−7)16002 = 83.578𝑘𝑃𝑎 
 
En la práctica, en cualquier lugar, las fluctuaciones de temperatura diarias y 
estacionales tienen un efecto mucho mayor en la densidad del aire que los cambios 
diarios y estacionales en la presión y la humedad del aire [8]. Por tanto, la 
temperatura necesaria es la temperatura anual promedio. 
 
El Sistema CLICOM es una base de datos de estaciones climáticas superficiales de 
México del Servicio Meteorológico Nacional (SMN), en la que se pueden obtener 
datos de temperaturas, precipitación, evaporación y unidades de calor [90].  
 
Se descargan los datos de temperatura promedio de la estación meteorológica más 
cercana al lugar de instalación y que cuente con varios años de mediciones. La 
estación seleccionada es Guadalajara (DGE) con Id:14066, ver Fig. 4.18, con los 
datos de la temperatura diaria promedio se calcula el promedio de la temperatura 
anual para los años 2000 al 2014, ver Fig. 4.17. 
 
Se obtiene una temperatura promedio para el rango de tiempo del año 2000 al 2014, 
siendo de 𝑇𝑝𝑟𝑜𝑚𝑒𝑑𝑖𝑜 = 𝑇 = 20.99°𝐶 ≈ 21°𝐶. Finalmente, se sustituye el valor de la 

temperatura 𝑇 = 21 + 273.15 = 294.15 𝐾 y la presión 𝑝 = 83.577𝑘𝑃𝑎 en la Ec. 4.2, 
obteniéndose la densidad del aire en el sitio de instalación. 
 

𝜌 =
𝑝

𝑅𝑇
=

83.578𝑘𝑃𝑎

(294.15 𝐾 )(286.9𝑁 ∙ 𝑚/𝑘𝑔 ∙ 𝐾)
= 0.99036 𝑘𝑔/𝑚3 

 
En el caso de los discos de inducción se usará la densidad del aire a condiciones 
estándar de temperatura y presión, que es 𝜌 = 1.225𝑘𝑔/𝑚3 de acuerdo a la norma 
ISO 2533:1975 [88].  
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Fig. 4.17. Temperatura anual promedio en el sitio de instalación de la turbina eólica. 

 

 
Fig. 4.18. Ubicación de CIATEQ, Zapopan y la estación meteorológica Guadalajara (DGE) con Id:14066, 

obtenida de Google Earth [86]. 
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4.3.2 Cálculo de la viscosidad  
 
La variación de la viscosidad con la presión es pequeña para la mayor parte de los 
gases. Del libro Flujo de fluidos en válvulas, accesorios y tuberías [91] apéndice A-
4a, titulado: Viscosidades de gases y vapores de hidrocarburos, para los gases 
dados en A-4a la corrección de la viscosidad debida a la presión es inferior al 10% 
para presiones de hasta 34 atm. Se emplea la ley de Sutherland [91]. 
 
Teniendo como dato la temperatura anual promedio del aire 𝑇 = 21 °𝐶 se obtiene: 
 

𝜇 = 0.000018188 𝑘𝑔/𝑚 ∙ 𝑠 = 1.8188 × 10−5 𝑘𝑔/𝑚 ∙ 𝑠 
 
Para corroborar el resultado se puede utilizar The Engineering ToolBox [92], donde 
a 21°C obtenemos una viscosidad de 𝜇 = 0.00001817, entre ambas viscosidades 
hay una diferencia menor al 0.2%. Se toma el valor de 𝜇 = 0.000018188 𝑘𝑔/𝑚 ∙ 𝑠 
para realizar la simulación de la turbina. En el caso de la simulación de los discos 
de inducción se usa la viscosidad del aire a condiciones estándar de temperatura y 
presión. 
 
 

4.3.3 Modelo de turbulencia  
 
Con base en lo explicado anteriormente en la sección 2.4.1.- Modelos de turbulencia 
del Capítulo III y a lo expuesto en la literatura [12, 44], de la gran variedad de 
modelos de turbulencia, para la inicialización de la simulación RANS del rotor con 
la técnica de Frame Motion y para la simulación RANS de los discos de inducción 
se usa el modelo 𝑘 −  𝜔 SST de dos ecuaciones (SST).  
 
Para la simulación URANS del rotor con la técnica de Sliding Mesh se usa el modelo 
de 4 ecuaciones SSt de transición (TSST). Se emplean los modelos anteriormente 
mencionados debido a que son modelosa robustos que son ampliamente utilizados 
en simulaciones de VAWT y a las recomendaciones de trabajos especializados 
como el de Rezaeiha et al. [44].  
 
 

4.3.4 Cálculo de velocidad angular  
 
Con los datos proporcionados por CIATEQ para el rotor H (𝑇𝑆𝑅 = 3 y 𝑟 = 𝐷/2 =
1.2𝑚), las diferentes velocidades del viento a evaluar y usando la definición de TSR 
expresada en términos matemáticos en la Ec. 2.3, se puede calcular la velocidad 
angular a la cual giraría la turbina eólica H-Savonius, despejando la velocidad 
angular de la definición de TSR, obteniendo la Ec. 4.4. 
 

𝜔 =
𝑇𝑆𝑅 ∗ 𝑉∞

𝑟
 Ec. 4.4 
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Al ser un cuerpo solido toda la turbina debe girar a la misma velocidad angular. La 
relación para las distintas velocidades de viento y su correspondiente velocidad 
angular se muestran en la Tabla 4.3.  
 

Tabla 4.3. Relación de velocidades del viento y velocidad angular del rotor. 

𝑽∞ (𝒎/𝒔) 2.5 4 5.5 7 8.5 10 

𝝎 (𝒓𝒂𝒅/𝒔) 6.25 10 13.75 17.5 21.25 25 

 
 

4.3.5 Cálculo del paso de tiempo (Time Step) 
 
La simulación del rotor de la turbina eólica con la técnica de Sliding Mesh es en 
estado no estacionario, en otras palabras, es dependiente del tiempo. El valor del 
paso de tiempo es un parámetro necesario para el software CFD como parte de la 
configuración.  
 
El paso de tiempo mínimo requerido de las simulaciones URANS está determinado 
por las escalas de tiempo de los fenómenos inestables y complejos que ocurren en 
el flujo. Para el caso de turbinas eólicas, se tiende a correlacionar el paso de tiempo 
con la revolución de la turbina y expresarlo como incremento azimutal, 𝑑𝜃. El 
incremento azimutal se define entonces como el número de grados que gira la 
turbina por paso de tiempo [65].  
 
Estudios han demostrado la importancia significativa de la elección correcta del 
incremento azimutal en la precisión y confiabilidad de las simulaciones CFD de 
VAWT [65, 66, 93–97]. La complejidad del flujo en los VAWT varía con las 
condiciones de operación y los parámetros geométricos de cada turbina en 
particular.  
 
Rezaeiha et al. [66] recomienda un incremento azimutal de 0.5° para minimizar el 
efecto de la resolución temporal en el rendimiento de la turbina; sin embargo, 
también advierte que la introducción de ángulos de inclinación en las álabes o la 
aplicación de perfiles aerodinámicos más gruesos o asimétricos posiblemente 
requiera un 𝑑𝜃 más pequeño para predecir con precisión la aerodinámica. Hosseini 
et al. [30] simulan en 2D usando un incremento azimutal de 1°, una turbina híbrida 
H-Savonius estructurada con dos niveles; cada nivel tiene cuatro rotores Savonius 
de dos álabes y una turbina Darrieus de tres álabes, ver Fig. 2.6. Por lo anterior, se 
realiza el estudio comparativo del rendimiento de la turbina híbrida diseñada por 
CIATEQ con un incremento azimutal de 0.5° y 0.25°, para una velocidad de 7m/s. 
 
Un incremento azimutal más pequeño demanda un mayor tiempo de simulación, ya 
que por cada revolución se requiere un mayor número de pasos de tiempo. Para 
calcular el número de pasos por revolución se dividen los 360° de una revolución 
entre el valor del incremento azimutal en grados. Para un incremento azimutal de 
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0.5° se requieren 720 pasos de tiempo por revolución y para 0.25° se requieren 
1440.  
 
El número de pasos requeridos para la simulación corresponde al Number of Time 
Steps requerido en la configuración de Fluent, se obtiene multiplicando el número 
de revoluciones por el número de pasos por revolución, ver Tabla 4.4 
 

Tabla 4.4. Relación entre el Incremento Azimutal y el número de pasos por revolución 

Incremento Azimutal 0.5° 0.25° 

Número de pasos por revolución  720 1440 

Número de pasos para 25 revoluciones 18,000 36,000 

 
Para calcular el tiempo de paso se necesita definir el incremento azimutal y el dato 
de la velocidad angular de la turbina, para el cálculo se hace uso de la Ec. 4.5, 
obtenida de [59]. La Ec. 4.5 puede deducirse a partir de la definición velocidad 
angular establecida en cualquier libro de Dinámica, para usarla es necesario ser 
congruente con las unidades empleadas para cada termino.  
 

𝑡 =
𝑑𝜃

𝜔
 Ec. 4.5 

 
Tabla 4.5. Relación entre la velocidad del viento, velocidad angular, incremento azimutal y paro de 

tiempo. 

𝑽∞ (𝒎/𝒔) 𝝎 (𝒓𝒂𝒅/𝒔) 𝒅𝜽 𝒕 (𝒔) 

2.5 6.25 0.5° 0.00139626 

4 10 0.5° 0.00087266 

5.5 13.75 0.5° 0.00063467 

7 17.5 0.5° 0.00049867 

7 17.5 0.25° 0.00024934 

8.5 21.25 0.5° 0.00041067 

10 25 0.5° 0.00034907 

 
 

4.4 Especificación de condiciones de frontera 
 
La elección de las condiciones de frontera es uno de los factores más importantes 
para la simulación de VAWT [67]. Las simulaciones de VAWT mediante la técnica 
de Sliding Mesh reportadas en la literatura definen las condiciones de frontera para 
la superficie de los álabes (RotorH, RotorS_Interior y RotorS_Exterior) y para la 
entrada del fluido (Inlet) como condiciones pared antideslizante (no-slip wall 
condition) y velocidad uniforme de entrada (uniform velocity inlet), respectivamente 
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[30, 33, 59, 60, 65–67, 79, 80, 82, 84, 98–104]. La nomenclatura usada para 
referirse a las zonas puede consultarse en la Fig. 4.8 y Fig. 4.9. 
 
La condición para la zona de la salida del fluido (Outlet), en la mayoría de los casos, 
es una presión estática manométrica de cero (zero gauge static pressure) [30, 44, 
59, 60, 65, 66, 80, 98, 100–104]; no obstante, existe en la literatura otras 
condiciones. Lam et al. [82] impone una condición de flujo de difusión cero para 
todas las variables de flujo y aplica una corrección general del balance de masa. 
Durrani et al. [79], usan la condición de presión de campo lejano (pressure farfield) 
tanto para la zona de Outlet como la de Outline. Liang et al. [33], de forma similar 
para las zonas de Outlet y Outline usa condición de frontera abierta (open boundary 
condition).  
 
Sin embargo, donde se encuentra una mayor variedad en la aplicación de condición 
de frontera es en la zona Outline. La tendencia es la imposición de la condición de 
simetría (symmetry) [30, 44, 66, 80, 98–100]. Qin et al. [101] y Lositaño et al. [102] 
usan la condición de campo lejano (farfield), Ostos et al. [59] y Mauro et al. [103] 
imponen la condición de pared (wall), Kacprzak et al. [60] usa una pared libre (free-
slip wall) y Dobrev et al. [104] utiliza la dirección, magnitud y sentido de la velocidad 
de entrada. 
 
Para la simulación del rotor de la turbina eólica se crea una interface en las zonas 
denominadas InterfaceRotor e InterfaceEstator, para la transferencia de información 
entre la malla del estator y la malla del rotor. Con base en la literatura, en las zonas 
nombradas como RotorH, RotorS_Interior y RotorS_Exterior, correspondientes a los 
álabes de la turbina se impone una condición de paredes antideslizantes (no-slip 
wall condition). Para Inlet se impone una velocidad uniforme de entrada (uniform 
velocity inlet), para Outlet una presión estática manométrica de cero (zero gauge 
static pressure) y para Outline la condición de simetría (symmetry), ver Fig. 4.19.  
 

 
Fig. 4.19. Condiciones de frontera. 
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Para los discos de inducción, ver Fig. 4.12, se defe la cara A como entrada del flujo 
del viento con una velocidad constante y uniforme; la cara B como salida del flujo 
del viento a presión atmosférica, la velocidad del viento en las caras adyacentes se 
definieron de forma idéntica en magnitud y dirección a la velocidad de entrada y 
para los discos se definieron como pared. 
 
 

4.5 Inicialización y control de la solución 
 
La simulación del rotor de la turbina eólica se realiza en dos simulaciones. La 
primera es una simulación de flujo en estado estacionario con la técnica de Single 
Reference Frame (Frame Motion), esta sirve como inicialización para la segunda 
simulación. La segunda es una simulación de flujo en estado no estacionario, por lo 
que es dependiente del tiempo, y se efectuá con la técnica de Sliding Mesh.  
 
El esquema numérico usado en la primera simulación es Coupled, para la segunda 
simulación el esquema numérico usado es el SIMPLE. El solucionador utilizado es 
pressure-based con una discretización de segundo orden tanto para el esquema 
espacial como para el temporal. 
 
En la simulación en estado estacionario se establecen 15000 iteraciones, para 
asegurar la convergencia. Se utiliza un límite de 40 iteraciones por paso de tiempo, 
en el caso de la segunda simulación y se establece un criterio mínimo de 

convergencia de 1𝑥10−5 para todos los residuales. 
 
 

4.6 Supervisión de la convergencia 
 
La convergencia generalmente se evalúa mediante el seguimiento progresivo de los 
residuales [40]. Además de examinar los residuales, se pueden usar otras variables 
de control para determinar la convergencia.  
 
En la simulación de flujo en estado estacionario se considera solamente los 

residuales. Estos deben caer por debajo del límite de tolerancia (1𝑥10−5) para 
determinar la convergencia. La supervisión se realiza con la observación de la 
gráfica de residuales y con la consola de Fluent en la que se muestra el valor de 
cada residual.  
 
En la simulación en estado no estacionario, la convergencia se define con base en 
el número de revoluciones de la turbina antes de alcanzar una condición estadística 
de estado estable, generalmente se evalúa el torque promedio por revolución o 
coeficiente de torque por revolución [96]. 
 
Se monitorea el torque instantáneo producido por la turbina en cada paso de tiempo 
hasta completar una revolución, se promedia y posteriormente se compara con sus 
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revoluciones anteriores hasta lograr la condición estadística de estado estable. En 
cada paso de tiempo se monitorean los residuales, los cuales deben de caer debajo 
del límite de tolerancia para considerar que el valor de torque instantáneo ha 
convergido. La supervisión se realiza con la observación de la gráfica de residuales, 
la consola de Fluent en la que se muestra el valor de cada residual y con gráficas 
de torque.  
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Capitulo V. Resultados de simulación en software CFD 
 
En las simulaciones en estado no estacionario, es importante iniciar el muestreo de 
datos solo después de que la solución haya alcanzado una condición estadística de 
estado estable. Para el caso de las turbinas eólicas, se suele correlacionar la 
convergencia de la simulación URANS con la revolución de la turbina y expresarla 
como el número mínimo de revoluciones que se necesitan antes de alcanzar la 
condición estadística de estado estable [65]. 
 
La complejidad del flujo para los VAWT varía en función de las condiciones 
geométricas y de funcionamiento del rotor para cada turbina (solides y TSR), por lo 
que no existe un número de revoluciones en particular para alcanzar la solución. El 
criterio de convergencia más usado en la literatura es comparar el valor promedio 
del torque de una revolución completa entre dos revoluciones sucesivas. En la 
mayoría de los trabajos, las simulaciones se detienen cuando esta diferencia es 
inferior al 1% [96]. En la Tabla 5.1 se describen algunos ejemplos de trabajos de 
simulación de VAWT y el número de revoluciones que necesito la simulación para 
alcanzar la convergencia.  
 
Tabla 5.1. Ejemplos de simulaciones de VAWT y número de revoluciones para alcanzar la convergencia. 

Autor principal 
Núm. de 

revoluciones para 
convergencia 

Durrani et al. [79] 7 

Lopez Mejia et al. [105] 10 

Shahizare et al. [97] 10 

Balduzzi et al. [84] 12 

Hosseini et al. [30] 10 

Dobrev et al. [104] 3 

Mauro et al. [103] 3-5 

Kacprzak et al. [60] 6-8 

Lositaño et al. [102] 10 

Lam et al. [82] 29 

 
Rezaeiha et al. [65] establece un mínimo de 20 revoluciones como requisito de 
criterio de convergencia, independientemente de la solidez y la relación de velocidad 
de la punta, para garantizar que la simulación haya alcanzado una condición 
estadística de estado estable, usando el criterio en la literatura se encuentran 
estudios en los que se reporta los resultados de los valores obtenidos en la vigésima 
primera revolución [44, 98, 100].  
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Balduzzi et al. [96] sugiere que el margen del 1 % no es adecuado en determinadas 
simulaciones de turbinas, ya que una tendencia de convergencia muy plana puede 
introducir variaciones significativas en el valor del torque final. Existen simulaciones 
reportadas en la literatura que usan el valor de 0.1% como criterio de convergencia 
[84, 96, 105]. 
 
Considerando lo anterior, se usa como criterio de convergencia el valor de 0.5% de 
diferencia entre el valor promedio del torque de una revolución y sus dos 
revoluciones sucesivas. El criterio se cumple entre la décima séptima y decima 
novena revolución, dependiendo de la simulación. Los valores reportados 
corresponden a la vigésima quinta revolución.  
 
Se elaboran 5 combinaciones de malla a partir de las tres mallas para el rotor y las 
tres mallas para el estator, ver Tabla 5.2. 
 

Tabla 5.2. Combinación de mallas de rotor y estator para la simulación de la turbina híbrida. 

Malla 1 2 3 4 5 

Malla Rotor R1 R2 R3 R2 R2 

Malla Estator E1 E1 E1 E2 E3 

Núm. de elementos 1,415,765 949,610 851,535 736,906 645,206 

 
Para comprender todos los gráficos presentados a continuación es necesario tener 
presente que durante una revolución del álabe, el ángulo de ataque y la velocidad 
relativa percibida por el perfil cambian continuamente, dando como resultado una 
fluctuación instantánea de las fuerzas y el par que actúan sobre la turbina [67]. 
 
 

5.1 Comparación incremento azimutal  
 
Se realiza el estudio comparativo del rendimiento de la turbina híbrida con un 
incremento azimutal de 0.5° y 0.25°, para una velocidad de 7m/s y utilizando la malla 
1, que es la malla con mayor cantidad de elementos, ver Tabla 5.2. En la Fig. 5.1 y 
la Fig. 5.2 se muestran el torque de la turbina desde el inicio de la simulación con la 
técnica de Sliding Mesh hasta finalizar las 25 revoluciones. En las gráficas se 
muestran tres líneas, correspondientes al torque generado por el rotor H, el torque 
del rotor Savonius y el torque del rotor híbrido que corresponde al torque de toda la 
turbina. El torque del rotor híbrido es la suma del torque del rotor H y el rotor 
Savonius.  
 
La Fig. 5.3, Fig. 5.4 y Fig. 5.5 son comparativas del torque con incremento azimutal 
de 0.5° y 0.25° del rotor híbrido, el rotor H y el rotor Savonius, respectivamente. No 
existe una gran diferencia entre el incremento azimutal de 0.5° y 0.25° en el torque 
del rotor híbrido y el rotor H (Fig. 5.3 y Fig. 5.4). 
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En la Fig. 5.4 se observa que a partir de la tercera revolución se repite un 
comportamiento sinusoidal. En la Fig. 5.6 se representa el torque de cada rotor en 
la vigésima quinta revolución y se observa claramente que el rotor H genera tres 
ondas sinusoidales por revolución, lo cual es consistente con lo reportado en la 
literatura [25, 30, 97, 102, 105]. 
 
En la Fig. 5.5 no se presenta un comportamiento repetitivo, después de la tercera 
revolución solamente se observa que el torque permanece en un determinado 
rango. En la Fig. 5.5 y Fig. 5.6 se observa que el torque generado es siempre 
negativo, es decir, el rotor Savonius actúa como un freno para la turbina híbrida, 
concordando con lo reportado en la literatura [32]; sin embargo no existe un rotor 
similar reportado en la literatura por lo que no se cuenta con una gráfica de torque 
esperada con la cual comparar. El comportamiento del rotor Savonius será 
analizado de forma más detallada en la siguiente sección.  
 
La diferencia porcentual entre el torque promedio de la turbina híbrida en la vigésima 
quinta revolución entre el incremento azimutal de 0.5° y 0.25° es 1.5%; sin embargo, 
el tiempo de simulación se duplica. Por lo anterior se opta por realizar las 
simulaciones faltantes con un incremento azimutal de 0.5° 
 

 
Fig. 5.1. Torque simulado en 25 revoluciones con la malla 1 y con un incremento azimutal de 0.5° con 

una velocidad de entrada de viento de 7 m/s. 
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Fig. 5.2. Torque simulado en 25 revoluciones con la malla 1 y con un incremento azimutal de 0.25° con 

una velocidad de entrada de viento de 7 m/s. 

 
 

 
Fig. 5.3. Comparación del torque del rotor híbrido con un incremento azimutal de 0.5° y 0.25° con una 

velocidad de entrada de viento de 7 m/s. 
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Fig. 5.4. Comparación del torque del rotor H de la turbina híbrida con un incremento azimutal de 0.5° y 

0.25° con una velocidad de entrada de viento de 7 m/s. 

 

 
Fig. 5.5. Comparación del torque del rotor Savonius con un incremento azimutal de 0.5° y 0.25° con una 

velocidad de entrada de viento de 7 m/s. 

 



72 
 

 
Fig. 5.6. Comparación del torque en la vigésima quinta revolución con un incremento azimutal de 0.5° y 

0.25° con una velocidad de entrada de viento de 7 m/s. 

 
 

5.2 Análisis Rotor Savonius 
 
Para descartar la falta de tiempo (revoluciones) para que el rotor logre un estado 
estable en la que se pudieran observar patrones de torque se simulan 25 
revoluciones más de la turbina híbrida. En el Fig. 5.7 se muestra el torque del rotor 
Savonius de la vigésima a la quincuagésima revolución. No se aprecia un patrón, el 
torque es siempre permanece negativo y oscila entre los valores de 0 y -2 N m. 
 

 
Fig. 5.7. Torque del rotor Savonius de la turbina híbrida de la 21. ° a la 50.° revolución con una velocidad 

de entrada de viento de 7 m/s. 
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Para analizar a detalle el funcionamiento del rotor Savonius de la turbina híbrida, se 
simuló únicamente el rotor Savonius a diferentes velocidades angulares (17.5rad/s, 
10rad/s y 5rad/s) y con una velocidad del viento de entrada de 7m/s. Se referirá 
como “rotor Savonius” al rotor Savonius de la turbina híbrida, simulada en conjunto 
al rotor H de la turbina híbrida y como “turbina Savonius” al rotor Savonius simulado 
de forma aislada, sin el rotor H. Además, se analiza el torque producido por cada 
nivel de la turbina Savonius, cada nivel contiene 6 álabes semicirculares. La 
nomenclatura usada para diferenciar cada nivel es Savonius Interior y Savonius 
Exterior, ver Fig. 4.8.  
 
Los resultados del torque para la turbina Savonius a diferentes velocidades 
angulares se encuentran en la Fig. 5.8, Fig. 5.9 y Fig. 5.10 para 17.5rad/s, 10rad/s 
y 5rad/s respectivamente, se presentan las últimas 4 revoluciones de la simulación. 
El torque de la turbina Savonius es la suma del torque del rotor Savonius Interior y 
Savonius Exterior. En las tres gráficas se aprecia que el torque del Savonius Interior 
es siempre positivo y tiene menor variación comparada con el rotor Savonius 
Exterior.  
 
El torque del rotor Savonius Exterior tiende a desplazarse de forma vertical hacia 
arriba conforme de disminuye la velocidad angular, es decir, tiende a dar un torque 
positivo a velocidades angulares bajas. 
 

 
Fig. 5.8. Torque de la turbia Savonius y sus rotores interior y exterior a 17.5rad/s en la 22.° a la 25.° 

revolución con una velocidad de entrada de viento de 7 m/s. 
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Fig. 5.9. Torque de la turbia Savonius y sus rotores interior y exterior a 10rad/s en la 22.° a la 25.° 

revolución con una velocidad de entrada de viento de 7 m/s. 

 

 
Fig. 5.10. Torque de la turbia Savonius y sus rotores interior y exterior a 5rad/s en la 22.° a la 25.° 

revolución con una velocidad de entrada de viento de 7 m/s. 

 
En la Fig. 5.11 se presenta la comparativa del torque del rotor Savonius de la turbina 
híbrida a 17.5rad/s y el torque de la turbina Savonius a distintas velocidades 
angulares. Si observamos el torque del rotor Savonius y la turbina Savonius ambos 
a 17.5rad/s se puede apreciar que la del rotor Savonius es menor, esto debido 
probablemente a que el rotor H absorbe parte de la energía cinética del viento. En 
la Fig. 5.12 y Fig. 5.13 se compara el torque del rotor Savonius Exterior y Savonius 
Interior a diferentes velocidades angulares. 
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Fig. 5.11. Comparativa del torque del rotor Savonius de la turbina híbrida a 17.5rad/s y de la turbia 

Savonius a 17.5rad/s, 10rad/s y 5rad/s en la 22.° a la 25.° revolución con una velocidad de entrada de 
viento de 7 m/s. 

 

 
Fig. 5.12. Comparativa del torque del rotor exterior de la turbia Savonius a 17.5rad/s, 10rad/s y 5rad/s en 

la 22.° a la 25.° revolución con una velocidad de entrada de viento de 7 m/s. 

 

 
Fig. 5.13. Comparativa del torque del rotor interior de la turbia Savonius a 17.5rad/s, 10rad/s y 5rad/s en 

la 22.° a la 25.° revolución con una velocidad de entrada de viento de 7 m/s. 
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5.3 Convergencia rotor 
 
Se realiza un estudio de independencia de malla con un incremento azimutal de 0.5° 
para la malla del rotor, usando la malla E1 para el estator, ver Tabla 5.2. En la Fig. 
5.14, Fig. 5.15 y Fig. 5.16 se muestra la comparativa del torque generado en las 
últimas tres revoluciones con las mallas 1, 2 y 3 de la turbina híbrida, el torque del 
rotor H y el rotor Savonius, respectivamente.  
 

 
Fig. 5.14. Comparación torque del rotor híbrido con las mallas 1, 2 y 3 en la 23.°, 24.° y 25.° revolución 

con un incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 

 

 
Fig. 5.15. Comparación torque del rotor H con las mallas 1, 2 y 3 en la 23.°, 24.° y 25.° revolución con un 

incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 
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Fig. 5.16. Comparación torque del rotor Savonius con las mallas 1, 2 y 3 en la 23.°, 24.° y 25.° 

revolución con un incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 

 
La Fig. 5.17 muestra a detalle el torque generado con las mallas 1, 2 y 3 de cada 
rotor y de la turbina híbrida en su vigésima quinta revolución.  
 

 
Fig. 5.17. Comparación torque con las mallas 1, 2 y 3 en la vigésima quinta revolución con un 

incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 

 
Debido a la falta de un valor experimental con el cual comparar los valores obtenidos 
en las simulaciones y con base en la premisa de que la precisión de una solución 
CFD se rige por el número de elementos en la malla, un gran número de celdas 
conduce a una solución precisa [40], se comparan los valores de torque promedio 
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de la vigésima quinta revolución obtenidos con las mallas 1, 2 y 3 contra el torque 
obtenido con un incremento azimutal de 0.25°, siendo la diferencia de 1.5%, 3.9% y 
4.2%. 
 
Las diferencias porcentuales son menores al 5%, se elige entonces la malla R2 
como la malla para el rotor debido a que se considera optimo el equilibrio entre 
número de elementos y demanda de recursos computacionales.  
 
 

5.4 Comparación del torque del rotor H y del rotor H de la turbina 
híbrida. 

 

 
Fig. 5.18. Comparación torque generado por la turbina H y por el rotor H de la turbina Híbrida en la 23.°, 

24.° y 25.° revolución con un incremento azimutal de 0.5°. 

 
La propuesta de trabajo para calcular la potencia y el 𝐶𝑝 de la turbina híbrida es usar 

dos simulaciones 2D; una simula la sección de la turbina híbrida que cuenta con 
una altura de 1m y la otra simulación corresponde a la parte restante de la turbina 
H, 1m de altura, ver Fig. 4.4. Los resultados de ambas simulaciones para el rotor H 
de la turbina híbrida y para la turbina H con un incremento azimutal de 0.5° y en la 
vigésima quinta revolución se muestran en la Fig. 5.18. No se aprecia mucha 
diferencia en el torque producido, la diferencia más clara es en referente a los 
máximos y mínimos del torque. La diferencia porcentual del torque entre el rotor H 
de la turbina híbrida y la turbina H es de 2.09%, por ello para calcular el torque total 
de la turbina híbrida completa se aproximará mediante la suma del torque de la 
turbina híbrida y el torque del rotor H, ya que no existe una diferencia significativa 
que amerite realizar la simulación y el gasto computacional para simular la turbina 
H únicamente. 
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5.5 Convergencia estator 
 
Se realiza un estudio de independencia de malla con un incremento azimutal de 0.5° 
para la malla del estator, usando la malla R2 para el rotor, ver Tabla 5.2. En la Fig. 
5.19, Fig. 5.20 y Fig. 5.21 se muestra la comparativa del torque generado en las 
últimas tres revoluciones con las mallas 2, 4 y 5 de la turbina híbrida, el torque del 
rotor H y el rotor Savonius, respectivamente.  
 

 
Fig. 5.19. Comparación torque de la turbina híbrida con las mallas 2, 4 y 5 en la 23.°, 24.° y 25.° 
revolución con un incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 

 
 

 
Fig. 5.20. Comparación torque del rotor H con las mallas 2, 4 y 5 en la 23.°, 24.° y 25.° revolución con un 

incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 
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Fig. 5.21. Comparación torque del rotor Savonius con las mallas 2, 4 y 5 en la 23.°, 24.° y 25.° 

revolución con un incremento azimutal de 0.5° con una velocidad de entrada de viento de 7 m/s. 

 
 

 
Fig. 5.22. Comparación torque del rotor Savonius y sus rotores interior y exterior de la turbina híbrida 

con las mallas 4 y 5 en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 0.5° con una 
velocidad de entrada de viento de 7 m/s. 

 
La Fig. 5.22 muestra de forma comparativa el torque por el rotor Savonius Interior y 
Savonius Exterior con las mallas 2, 4 y 5. La Fig. 5.23 muestra a detalle el torque 
generado con las mallas 2, 4 y 5 de cada rotor y de la turbina híbrida en su vigésima 
quinta revolución.  
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Fig. 5.23. Comparación torque con las mallas 2, 4 y 5 en la vigésima quinta revolución con un 

incremento azimutal de 0.5°. 

 
De igual forma debido a la falta de un valor experimental con el cual comparar los 
valores obtenidos en las simulaciones, se comparan los valores de torque promedio 
de la vigésima quinta revolución obtenidos con las mallas 2, 4 y 5 contra el torque 
obtenido con un incremento siendo la diferencia de  3.9%, 2.2% y 5.8%, se elige 
combinación de malla 4 (malla R2 y malla E2) como la malla para realizar el resto 
de las simulaciones con diferente velocidad de viento debido a que se considera 
optimo el equilibrio entre número de elementos, tiempo y demanda de recursos 
computacionales.  
 
 

5.6 Potencia y 𝑪𝒑 de la turbina híbrida 
 
La Fig. 5.24, Fig. 5.25, Fig. 5.26, Fig. 5.27, Fig. 5.28 y Fig. 5.29 muestran el torque 
de la turbina híbrida y sus rotores en las ultima tres revoluciones simuladas con la 
malla 4 y un incremento azimutal de 0.5°. Se observa un comportamiento 
predominante sinusoidal de la turbina híbrida debido a que predomina el 
comportamiento sinusoidal del rotor H. El torque de la turbina híbrida varia 
ligeramente en sus picos máximos y mínimos debido a las fluctuaciones del rotor 
Savonius. El rotor Savonius proporciona un torque neto negativo, que es la suma 
del Savonius Interior y el Sabonius Exterior. El torque del Savonius Interior es 
positivo y tiende a tener un valor prácticamente constante en cada revolución en 
comparación con el torque generado por el Savonius Exterior que es negativo y 
fluctúa en mayor medida. 
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Fig. 5.24. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de viento de 2.5m/s. 
 

 

 
Fig. 5.25. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de viento de 4m/s. 
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Fig. 5.26. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de viento de 5.5m/s. 

 

 
Fig. 5.27. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de de viento de 7m/s. 

 



84 
 

 
Fig. 5.28. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de viento de 8.5m/s. 

 
 

 
Fig. 5.29. Torque de la turbina híbrida en la 23.°, 24.° y 25.° revolución con un incremento azimutal de 

0.5° con una velocidad de entrada de viento de 10m/s. 

 
Para calcular la potencia de la turbina híbrida se obtiene el torque total que es la 
suma del torque de la turbina híbrida y del rotor H, y posteriormente se multiplica 
por su velocidad angular. El coeficiente de potencia, 𝐶𝑝 se calcula usando la Ec. 2.2. 

Los resultados se presentan en la Tabla 5.3 y en el Fig. 5.30. 
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Tabla 5.3. Relación de velocidades del viento y potencia disponible 

𝑽∞ (𝒎/𝒔) 𝝎(𝒓𝒂𝒅/𝒔) 𝑷𝒕𝒖𝒓𝒃𝒊𝒏𝒂 (𝑾) 𝑷𝒂𝒊𝒓𝒆 (𝑾) 𝑪𝒑 

2.5 6.25 7.0 37.1 0.189 

4 10 32.6 152.1 0.214 

5.5 13.75 88.9 395.5 0.225 

7 17.5 200.1 815.3 0.245 

8.5 21.25 365.3 1459.7 0.250 

10 25 602.9 2376.9 0.254 

 

 
Fig. 5.30. Potencia generada por la turbina y potencia disponible a diferentes velocidades del viento. 

 
 

5.7 Discos inductores 
 
En la simulación el viento ingresa por Inlet (Cara A) y fluye a través del prisma hasta 
la salida Oulet (Cara B), ver Fig. 4.12. Los datos obtenidos de las simulaciones son 
el aumento de la velocidad de viento debido a los discos de inducción. Se tomaron 
21 puntos representativos en 3 planos, es decir 7 puntos por plano: Disco Frontal 
(DF), Disco Posterior (DP), Rotor Frontal (RF), Rotor Posterior (RP), Rotor Izquierdo 
(RI), Rotor Derecho (RD) y Centro (C).  
 
El plano central se ubica a la mitad de la distancia entre los discos inductores; el 
plano superior se encuentra ubicado en el espacio que separa el disco de inducción 
y la parte superior del rotor de la turbina eólica; el plano inferior se encuentra ubicado 
en el espacio que separa el disco de inducción y la parte inferior del rotor de la 
turbina eólica. Ver Fig. 5.31 y Fig. 5.32. 
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En la Fig. 5.33 y Fig. 5.34 se muestran los contornos de velocidades para los discos 
de inducción elípticos, para una velocidad de entrada de 12m/s. Se observa que el 
viento efectivamente se acelera de forma homogénea en el interior entre los discos 
inductores elípticos.  
 

 
Fig. 5.31. Vista transversal de los planos usados de referencia.  

 

 
Fig. 5.32. Vista superior de los planos usados de referencia. 
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Fig. 5.33. Contorno de la velocidad de viento centrada y perpendicular a la cara A. Velocidad de viento 

de entrada 12m/s 

 

 
Fig. 5.34. Contorno de la velocidad de viento perpendicular a la cara superior. Velocidad de viento de 

entrada 12m/s 

 
En la Fig. 5.35, Fig. 5.36 y Fig. 5.37 se presentan los resultados de la velocidad del 
viento en 5 puntos de cada plano (superior, central o inferior) para todo el rango de 
velocidades de entrada de 3m/s a 12 m/s. Los puntos que son DF, RF, C, RP y DP 
están ordenados para que se pueda seguir el cambio de la velocidad en un mismo 
sentido, ya que los puntos se encuentran en el plano perpendicular a la cara del 
viento, ver Fig. 5.33.  
 
Los valores de la velocidad para los puntos restantes que son RI y RD, ver Fig. 5.32, 
no se encuentran graficados ya que la diferencia porcentual con el valor del punto 
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C que se encuentre en el mismo plano (central, superior o inferior) es menor al 1.5% 
por lo que no se apreciaría significativamente en las gráficas.  
 

 
Fig. 5.35. Velocidades en los puntos de referencia para el plano superior. 

 

 
Fig. 5.36. Velocidades en los puntos de referencia para el plano central. 
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Fig. 5.37. Velocidades en los puntos de referencia para el plano inferior. 

 
En la Fig. 5.38 se analiza más a detalle el comportamiento de la velocidad del viento 
en su paso por los discos, en forma comparativa para los tres planos (superior, 
central e inferior). La Fig. 5.38 es representativa del modelo, ya que el patrón se 
repite para las otras velocidades, se tomó la velocidad de 12m/s para que 
coincidieran con la velocidad de las Fig. 5.33 y Fig. 5.34. Se observa que la 
tendencia de velocidades de viento es idéntica en los planos superior e inferior en 
sus respectivos puntos. Esto es de esperarse por la simetría geométrica de los 
discos respecto del plano central y a la velocidad constante y uniforme de entrada. 
También se observa que el patrón es ligeramente diferente en el plano central. 
 

 
Fig. 5.38. Comparativa del patrón de velocidad de viento para 12m/s en los planos superior, central e 

inferior.  
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Los discos inductores elípticos siguen el mismo patrón de cambio en la velocidad 
del viento en sus tres planos (superior, central e inferior) aumentando hasta el punto 
central (C) y posteriormente disminuyendo hasta la salida del disco (DP). Haciendo 
un promedio con los valores de los puntos RF, RP, RD, RI y C en los tres planos, 
que son los puntos donde se encontraría el rotor de la turbina eólica, y 
comparándolo con el de la velocidad de entrada se observa un aumento del 15%.  
 
Lo anterior concuerda con la finalidad de los discos inductores que es mejorar el 
rendimiento del rotor de una turbina eólica de eje vertical. 
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Capítulo VI 
 

6.1 Conclusiones  
 
El estudio del estado del arte de las turbinas eólicas de eje vertical muestra las 
ventajas de desempeño sobre las turbinas eólicas de eje horizontal al no necesitar 
sistema de guiñada, tener un mantenimiento más sencillo, funcionar a velocidades 
de viento menores y flujos complejos y turbulentos sobre todo para zonas urbanas.  
 
La simulación numérica con software CFD representa una alternativa confiable para 
la evaluación del desempeño del diseño de una turbina eólica de eje vertical. Existen 
muchos aspectos a considerar para garantizar la confiabilidad de los resultados 
obtenidos entre los más importantes: la malla del dominio computacional, el modelo 
de turbulencia, el tipo de simulación (dependiente del tiempo o no dependiente del 
tiempo) y la técnica de simulación (Sliding Mesh, Dynamic Mesh, Single Reference 
Frame). Preferentemente se debería validar la simulación con datos 
experimentales. Ante la falta de datos experimentales la simulación realizada se 
respalda fuertemente en la literatura. Los resultados presentados concuerdan con 
lo reportado, la forma sinusoidal del torque del rotor H y la negatividad del torque 
del rotor Savonius operando como un freno para la turbina híbrida. La potencia 
generada permanece debajo del límite de Betz y el 𝐶𝑝 de la turbina se encuentra 

dentro de los rangos para turbinas eólicas de eje vertical. 
 
Los discos inductores elípticos aumentan la velocidad del viento de forma 
homogénea en la zona del rotor alrededor de un 15% respecto de la velocidad de 
entrada al producirse un efecto Venturi. Este incremento del 15% podría 
aprovecharse para las turbinas eólicas de eje vertical y aumentar la potencia 
generada de la turbina en aproximadamente un 50% 
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6.2 Recomendaciones 
 
Las simulaciones son una aproximación de la realidad, que permiten una mejor 
compresión de los fenómenos físicos al ofrecer más datos y una gran facilidad para 
visualizarlos en comparación con la experimentación. La técnica de Sliding Mesh 
fuerza al rotor a girar a la velocidad angular programada y ofrece resultados 
confiables cuando la velocidad angular introducida en el software es idéntica o 
próxima a la velocidad angular real. La finalidad del presente trabajo es obtener 
resultados que permitan corroborar el diseño de la turbina, por lo que la técnica de 
Sliding Mesh cumple con el cometido. Sin embargo, se recomienda el uso de otra 
técnica de simulación como las mallas dinámicas para predecir con certeza el 
desempeño de la turbina y se puedan obtener mayor variedad de datos como la 
velocidad angular de la turbina para determinada velocidad de viento. 
 
Se estimó por medio de la simulación RANS y sin turbina la optimización de los 
concentradores eólicos de discos inductores. Evaluar de forma experimental la 
optimización de los concentradores eólicos de discos inductores usando una turbina 
eólica sería lo ideal. Para predecir mediante simulación la optimización de los 
concentradores eólicos de discos inductores es necesario realizar estudios en 2D 
para obtener perfiles de velocidad y realizar un dimensionamiento optimo del 
dominio computacional para una posterior simulación en 3D. En la simulación en 3D 
lo idóneo es probar los discos con una turbina eólica usando mallas dinámicas. 
 
 
 
 

  



93 
 

Referencias bibliográficas 
[1] J. Salgado y M. A. Borjas, “Energía del viento”, Energías Altern., pp. 18–29, 

2010. 
[2] Sener, “Prospectivas de Energías Renovables (2018-2032)”, Secretaria de 

Energía. p. 73, 2018, [En línea]. Disponible en: https://www.gob.mx/sener. 
[3] Sener, “Prospectivas de Energías Renovables (2012-2026)”. 1369. 
[4] Gobierno del Estado de Jalisco, “Plan Estatal de Desarrollo Jalisco (PED) 

2013-2033”, p. 484, 2016. 
[5] Cabildo de Tenerife y Banco de Ideas de Negocios Ambientales Sostenibles 

BINAS, “Instalación de energía minieólica en viviendas unifamiliares”. . 
[6] Fundación de la Energia de la Comunidad de la Madrid y Consejería de 

Ecnonomía y Hacienda de la Cominidad de Madrid, “Guía sobre Tecnología 
Minieólica”. Madrid. 

[7] “The Wind Power”, 2021. 
https://www.thewindpower.net/windfarms_list_es.php (consultado sep. 03, 
2020). 

[8] J. F. Manwell, J. G. McGowan, y A. L. Rogers, WIND ENERGY EXPLAINED 
Theory, Design and Application Second Edition, Second Edi. 2009. 

[9] M. Islam, D. S. K. Ting, y A. Fartaj, “Aerodynamic models for Darrieus-type 
straight-bladed vertical axis wind turbines”, Renew. Sustain. Energy Rev., vol. 
12, núm. 4, pp. 1087–1109, 2008, doi: 10.1016/j.rser.2006.10.023. 

[10] R. Kumar, K. Raahemifar, y A. S. Fung, “A critical review of vertical axis wind 
turbines for urban applications”, Renew. Sustain. Energy Rev., vol. 89, núm. 
February, pp. 281–291, 2018, doi: 10.1016/j.rser.2018.03.033. 

[11] M. R. Islam, S. Mekhilef, y R. Saidur, “Progress and recent trends of wind 
energy technology”, Renew. Sustain. Energy Rev., vol. 21, pp. 456–468, 2013, 
doi: 10.1016/j.rser.2013.01.007. 

[12] M. Ghasemian, Z. N. Ashrafi, y A. Sedaghat, “A review on computational fluid 
dynamic simulation techniques for Darrieus vertical axis wind turbines”, 
Energy Convers. Manag., vol. 149, pp. 87–100, 2017, doi: 
10.1016/j.enconman.2017.07.016. 

[13] X. Jin, G. Zhao, K. Gao, y W. Ju, “Darrieus vertical axis wind turbine: Basic 
research methods”, Renew. Sustain. Energy Rev., vol. 42, pp. 212–225, 2015, 
doi: 10.1016/j.rser.2014.10.021. 

[14] M. M. Aslam Bhutta, N. Hayat, A. U. Farooq, Z. Ali, S. R. Jamil, y Z. Hussain, 
“Vertical axis wind turbine - A review of various configurations and design 
techniques”, Renew. Sustain. Energy Rev., vol. 16, núm. 4, pp. 1926–1939, 
2012, doi: 10.1016/j.rser.2011.12.004. 

[15] W. Tjiu, T. Marnoto, S. Mat, M. H. Ruslan, y K. Sopian, “Darrieus vertical axis 
wind turbine for power generation I: Assessment of Darrieus VAWT 
configurations”, Renew. Energy, vol. 75, pp. 50–67, 2015, doi: 
10.1016/j.renene.2014.09.038. 

[16] N. C. Batista, R. Melício, V. M. F. Mendes, M. Calderón, y A. Ramiro, “On a 
self-start Darrieus wind turbine: Blade design and field tests”, Renew. Sustain. 
Energy Rev., vol. 52, pp. 508–522, 2015, doi: 10.1016/j.rser.2015.07.147. 

[17] F. Toja-Silva, A. Colmenar-Santos, y M. Castro-Gil, “Urban wind energy 



94 
 

exploitation systems: Behaviour under multidirectional flow conditions - 
Opportunities and challenges”, Renew. Sustain. Energy Rev., vol. 24, pp. 
364–378, 2013, doi: 10.1016/j.rser.2013.03.052. 

[18] CIATEQ, “CIATEQ Bienvenidos”, 2020. 
https://www.ciateq.mx/index.php/conoce-ciateq.html (consultado jul. 21, 
2020). 

[19] T. M. Letcher, Wind Energy Engineering A Handbook for Onshore and 
Offshore Wind Turbines. . 

[20] T. Burton, D. Sharpe, N. Jenkins, y E. Bossanyi, Wind Energy Handbook. 
WILEY, 2001. 

[21] K. Ptasinski, “Renewable energy resources, vol 89”. 2015. 
[22] A. Yusof y M. R. Mohamed, “Vertical Axis Wind Turbines: An Overview”, Lect. 

Notes Electr. Eng., vol. 632, pp. 821–835, 2020, doi: 10.1007/978-981-15-
2317-5_68. 

[23] J. D. Jiménez Licea, “ANÁLISIS DE OPERACIÓN Y FUNCIONAMIENTO DE 
UNA MÁQUINA EÓLICA PARA SUMINISTRO DE ENERGÍA ELÉCTRICA A 
UNA CASA HABITACIÓN”, Instituto Politecnico nacional, Unidad 
Azcapotzalco, 2016. 

[24] D. Wood, Small Wind Turbines Analysis, Design and Application. Springer, 
2012. 

[25] E. Hau, Wind Turbines Fundamentals, Technologies, Application, Economics, 
Second Edi. Springer. 

[26] I. Paraschivoiu, Wind Turbine Design: With Emphasis on Darrieus Concept. 
POLYTECHNIC INTERNATIONAL PRESS, 2002. 

[27] J. M. Darrieus Georges, “Turbine having its rotating shaft transverse to the 
flow of the current”, US1835018A, 1926. 

[28] H. J. Sutherland, D. E. Berg, y T. D. Ashwill, “SANDIA REPORT, SAND2012-
0304, A Retrospective of VAWT Technology”, 2012. 

[29] W. Tjiu, T. Marnoto, S. Mat, M. H. Ruslan, y K. Sopian, “Darrieus vertical axis 
wind turbine for power generation II: Challenges in HAWT and the opportunity 
of multi-megawatt Darrieus VAWT development”, Renew. Energy, vol. 75, pp. 
560–571, 2015, doi: 10.1016/j.renene.2014.10.039. 

[30] A. Hosseini y N. Goudarzi, “Design and CFD study of a hybrid vertical-axis 
wind turbine by employing a combined Bach-type and H-Darrieus rotor 
systems”, Energy Convers. Manag., vol. 189, núm. March, pp. 49–59, 2019, 
doi: 10.1016/j.enconman.2019.03.068. 

[31] S. M. Rassoulinejad-Mousavi, M. Jamil, y M. Layeghi, “Experimental study of 
a combined three bucket H-rotor with savonius wind turbine”, World Appl. Sci. 
J., vol. 28, núm. 2, pp. 205–211, 2013, doi: 
10.5829/idosi.wasj.2013.28.02.1429. 

[32] S. Bhuyan y A. Biswas, “Investigations on self-starting and performance 
characteristics of simple H and hybrid H-Savonius vertical axis wind rotors”, 
Energy Convers. Manag., vol. 87, pp. 859–867, 2014, doi: 
10.1016/j.enconman.2014.07.056. 

[33] X. Liang, S. Fu, B. Ou, C. Wu, C. Y. H. Chao, y K. Pi, “A computational study 
of the effects of the radius ratio and attachment angle on the performance of 
a Darrieus-Savonius combined wind turbine”, Renew. Energy, vol. 113, pp. 



95 
 

329–334, 2017, doi: 10.1016/j.renene.2017.04.071. 
[34] S. Shikha, T. S. Bhatti, y D. P. Kothari, “Air concentrating nozzles: A promising 

option for wind turbines”, Int. J. Energy Technol. Policy, vol. 3, núm. 4, pp. 
394–412, 2005, doi: 10.1504/IJETP.2005.008403. 

[35] C. Shonhiwa y G. Makaka, “Concentrator Augmented Wind Turbines: A 
review”, Renew. Sustain. Energy Rev., vol. 59, pp. 1415–1418, 2016, doi: 
10.1016/j.rser.2016.01.067. 

[36] S. K. Thangavelu, C. Y. Goh, y C. V. Sia, “Design and Flow Simulation of 
Concentrator Augmented Wind Turbine”, IOP Conf. Ser. Mater. Sci. Eng., vol. 
501, núm. 1, 2019, doi: 10.1088/1757-899X/501/1/012041. 

[37] Shikha, T. S. Bhatti, y D. P. Kothari, “A new vertical axis wind rotor using 
convergent nozzles”, LESCOPE 2003 - 2003 Large Eng. Syst. Conf. Power 
Eng. Energy Futur. Conf. Proc., vol. 110016, pp. 177–181, 2003, doi: 
10.1109/LESCPE.2003.1204700. 

[38] G. J. Marin Tellez, V. Lopez Garza, P. Marin Tellez, y A. Santibañez 
Maldonado, “Inductor Disc CFD Analysis for VAWT”, J. Technol. Eng., vol. 5, 
núm. 16, pp. 1–11, 2021, doi: 10.35429/JTEN.2021.16.5.1.11. 

[39] H. K. Versteeg y W. Malalasekera, An Introduction to Computational Fluid 
Dynamics, Second Edi. 2007. 

[40] J. Tu, G. Heng Yeoh, y C. Liu, Computational Fluid Dynamics A Practical 
Approach. 1995. 

[41] M. Peric y J. H. Ferziger, Computational Methods for Fluid Dynamics, 3rd 
Editio. . 

[42] D. C. Wilcox, Turbulence Modeling for CFD, vol. 3035, núm. September. DCW 
Industries, 2016. 

[43] T. Petrila y D. Trif, Basics of Fluid Mechanics and Introduction to 
Computational Fluid Dynamics. Springer. 

[44] A. Rezaeiha, H. Montazeri, y B. Blocken, “On the accuracy of turbulence 
models for CFD simulations of vertical axis wind turbines”, Energy, vol. 180, 
pp. 838–857, 2019, doi: 10.1016/j.energy.2019.05.053. 

[45] P. R. Spalart y S. R. Allmaras, “One-Equatlon Turbulence Model for 
Aerodynamic Flows”, en 30th Aerospace Sciences Meeting & Exhibit, 1992, 
p. 23, doi: https://doi.org/10.2514/6.1992-439. 

[46] V. Yakhot y S. A. Orszag, “Renormalization group analysis of turbulence. I. 
Basic theory”, J. Sci. Comput., vol. 1, núm. 1, pp. 3–51, 1986, doi: 
https://doi.org/10.1007/BF01061452. 

[47] T.-H. Shih, W. W. Liou, A. Shabbir, Z. Yang, y J. Zhu, “A new k-ϵ eddy viscosity 
model for high reynolds number turbulent flows”, Notes Numer. Fluid Mech. 
Multidiscip. Des., vol. 133, núm. 3, pp. 105–116, 1994, doi: 
https://doi.org/10.1016/0045-7930(94)00032-T. 

[48] F. R. Menter, “Zonal two equation k-ω turbulence models for aerodynamic 
flows”, 1993, doi: 10.1142/9789812774071_0006. 

[49] B. E. Launder y D. B. Spalding, Lectures in mathematical models of 
turbulence. London, England: Academic Press, 1972. 

[50] ANSYS Inc., “ANSYS Fluent theory guide 16.1”. 2015. 
[51] F. R. Menter, R. B. Langtry, S. R. Likki, Y. B. Suzen, P. G. Huang, y S. Völker, 

“A correlation-based transition model using local variables - Part I: Model 



96 
 

formulation”, J. Turbomach., vol. 128, núm. 3, pp. 413–422, 2006, doi: 
10.1115/1.2184352. 

[52] R. B. Langtry y F. R. Menter, “Correlation-based transition modeling for 
unstructured parallelized computational fluid dynamics codes”, AIAA J., vol. 
47, núm. 12, pp. 2894–2906, 2009, doi: 10.2514/1.42362. 

[53] B. Blocken et al., “Aerodynamic drag in cycling pelotons: New insights by CFD 
simulation and wind tunnel testing”, J. Wind Eng. Ind. Aerodyn., vol. 179, pp. 
319–337, 2018, doi: https://doi.org/10.1016/j.jweia.2018.06.011. 

[54] B. Blocken, T. van Druenen, Y. Toparlar, y T. Andrianne, “Aerodynamic 
analysis of different cyclist hill descent positions”, J. Wind Eng. Ind. Aerodyn., 
vol. 181, pp. 27–45, 2018, doi: https://doi.org/10.1016/j.jweia.2018.08.010. 

[55] F. R. Menter, R. Langtry, y S. Völker, “Transition Modelling for General 
Purpose CFD Codes”, Flow, Turbul. Combust., vol. 77, núm. 1, pp. 277–303, 
2006, doi: 10.1007/s10494-006-9047-1. 

[56] R. B. Langtry, F. R. Menter, S. R. Likki, Y. B. Suzen, P. G. Huang, y S. Völker, 
“A Correlation-Based Transition Model Using Local Variables—Part II: Test 
Cases and Industrial Applications”, J. Turbomach., vol. 128, núm. 3, pp. 423–
434, mar. 2004, doi: 10.1115/1.2184353. 

[57] D. Lars, An introduction to Turbulence Models, vol. 756. 2009. 
[58] S. Sharma y R. K. Sharma, “Performance improvement of Savonius rotor 

using multiple quarter blades – A CFD investigation”, Energy Convers. 
Manag., vol. 127, pp. 43–54, 2016, doi: 
https://doi.org/10.1016/j.enconman.2016.08.087. 

[59] I. Ostos, I. Ruiz, M. Gajic, W. Gómez, A. Bonilla, y C. Collazos, “A modified 
novel blade configuration proposal for a more efficient VAWT using CFD 
tools”, Energy Convers. Manag., vol. 180, núm. August 2018, pp. 733–746, 
2019, doi: https://doi.org/10.1016/j.enconman.2018.11.025. 

[60] K. Kacprzak y K. Sobczak, “Numerical analysis of the flow around the Bach-
type Savonius wind turbine”, J. Phys. Conf. Ser., vol. 530, núm. 1, 2014, doi: 
10.1088/1742-6596/530/1/012063. 

[61] M. Shaheen, M. El-Sayed, y S. Abdallah, “Numerical study of two-bucket 
Savonius wind turbine cluster”, J. Wind Eng. Ind. Aerodyn., vol. 137, pp. 78–
89, 2015, doi: https://doi.org/10.1016/j.jweia.2014.12.002. 

[62] G. Ferrari, D. Federici, P. Schito, F. Inzoli, y R. Mereu, “CFD study of Savonius 
wind turbine: 3D model validation and parametric analysis”, Renew. Energy, 
vol. 105, pp. 722–734, 2017, doi: 
https://doi.org/10.1016/j.renene.2016.12.077. 

[63] M. Tahani, A. Rabbani, A. Kasaeian, M. Mehrpooya, y M. Mirhosseini, “Design 
and numerical investigation of Savonius wind turbine with discharge flow 
directing capability”, Energy, vol. 130, pp. 327–338, 2017, doi: 
https://doi.org/10.1016/j.energy.2017.04.125. 

[64] H. Yu y J. Thé, “Validation and optimization of SST k-ω turbulence model for 
pollutant dispersion within a building array”, Atmos. Environ., vol. 145, pp. 
225–238, 2016, doi: https://doi.org/10.1016/j.atmosenv.2016.09.043. 

[65] A. Rezaeiha, H. Montazeri, y B. Blocken, “Towards accurate CFD simulations 
of vertical axis wind turbines at different tip speed ratios and solidities: 
Guidelines for azimuthal increment, domain size and convergence”, Energy 



97 
 

Convers. Manag., vol. 156, núm. September 2017, pp. 301–316, 2018, doi: 
10.1016/j.enconman.2017.11.026. 

[66] A. Rezaeiha, I. Kalkman, y B. Blocken, “CFD simulation of a vertical axis wind 
turbine operating at a moderate tip speed ratio: Guidelines for minimum 
domain size and azimuthal increment”, Renew. Energy, vol. 107, pp. 373–385, 
2017, doi: 10.1016/j.renene.2017.02.006. 

[67] N. Franchina, G. Persico, y M. Savini, “2D-3D Computations of a Vertical Axis 
Wind Turbine Flow Field: Modeling Issues and Physical Interpretations”, 
Renew. Energy, pp. 1170–1189, 2019, doi: 10.1016/j.renene.2018.09.086. 

[68] J.-M. Chapallaz, P. Eichenberger, y G. Fischer, Manual on Pumps Used as 
Turbines. Vieweg, 1992. 

[69] P. C. Swain, “CE 15008 Fluid Mechanics. LECTURE NOTES Module-II”. 2016. 
[70] ANSYS Inc., “ANSYS FLUENT User’s Guide”, Knowledge Creation Diffusion 

Utilization, vol. 15317, núm. July. pp. 724–746. 
[71] ANSYS Inc., “ANSYS FLUENT Theory Guide”, núm. July, p. 1068. 
[72] ANSYS Inc., “ANSYS FLUENT Tutorial Guide”. . 
[73] ANSYS Inc., “ANSYS FLUENT Workbench Tutorial Guide”. . 
[74] ANSYS Inc., “ANSYS Meshing Tutorial Guide”. . 
[75] ANSYS Inc., “ANSYS Meshing User’s Guide”. . 
[76] ANSYS Inc., “DesignModeler User’s Guide”. . 
[77] ANSYS Inc., “Introduction to ANSYS FLUENT. Workshop 5. Using Moving 

Reference Frames and Sliding Meshes”, 2010, núm. December, pp. 1–35. 
[78] G. Tescione, D. Ragni, C. He, C. J. Simão Ferreira, y G. J. W. van Bussel, 

“Near wake flow analysis of a vertical axis wind turbine by stereoscopic particle 
image velocimetry”, Renew. Energy, vol. 70, pp. 47–61, 2014, doi: 
https://doi.org/10.1016/j.renene.2014.02.042. 

[79] N. Durrani, H. Hameed, H. Rahman, y S. Chaudhry, “A Detailed Aerodynamic 
Design and Analysis of a 2-D Vertical Axis Wind Turbine Using Sliding Mesh 
in CFD”, núm. January, pp. 1–16, 2011, doi: 10.2514/6.2011-541. 

[80] J. Zhu, H. Huang, y H. Shen, “Self-starting aerodynamics analysis of vertical 
axis wind turbine”, Adv. Mech. Eng., vol. 7, núm. 12, pp. 1–12, 2015, doi: 
10.1177/1687814015620968. 

[81] A. Orlandi, M. Collu, S. Zanforlin, y A. Shires, “3D URANS analysis of a vertical 
axis wind turbine in skewed flows”, J. Wind Eng. Ind. Aerodyn., vol. 147, pp. 
77–84, 2015, doi: https://doi.org/10.1016/j.jweia.2015.09.010. 

[82] H. F. Lam y H. Y. Peng, “Study of wake characteristics of a vertical axis wind 
turbine by two- and three-dimensional computational fluid dynamics 
simulations”, Renew. Energy, vol. 90, pp. 386–398, 2016, doi: 
https://doi.org/10.1016/j.renene.2016.01.011. 

[83] A. Untaroiu, H. G. Wood, P. E. Allaire, y R. J. Ribando, “Investigation of Self-
Starting Capability of Vertical Axis Wind Turbines Using a Computational Fluid 
Dynamics Approach”, J. Sol. Energy Eng., vol. 133, núm. 4, oct. 2011, doi: 
10.1115/1.4004705. 

[84] F. Balduzzi, J. Drofelnik, A. Bianchini, G. Ferrara, L. Ferrari, y M. S. 
Campobasso, “Darrieus wind turbine blade unsteady aerodynamics: a three-
dimensional Navier-Stokes CFD assessment”, Energy, vol. 128, pp. 550–563, 
2017, doi: https://doi.org/10.1016/j.energy.2017.04.017. 



98 
 

[85] Cadence, “Compute Grid Spacing for a Given Y+”. 
http://www.pointwise.com/yplus/index.html (consultado ene. 05, 2021). 

[86] “Google Earth”. https://earth.google.com/web/ (consultado ago. 13, 2020). 
[87] J. J. Chattot y M. M. Hafez, Theoretical and Applied Aerodynamics and 

Related Numerical Methods. . 
[88] International Standard Organisation, “ISO 2533:1975 Standard Atmosphere”. 

. 
[89] Y. A. Çengel y M. A. Boles, Termodinámica, Septima Ed. Mc Graw Hill. 
[90] CICESE, “CLICOM”, 2021. http://clicom-mex.cicese.mx/. 
[91] CRANE, Flujos de Fluidos en Válvulas Accesorios y Tuberías. McGRAW 

HILL. 
[92] “The Engineering ToolBox”. https://www.engineeringtoolbox.com/air-

absolute-kinematic-viscosity-d_601.html (consultado dic. 07, 2020). 
[93] C. J. Simão Ferreira, A. van Zuijlen, H. Bijl, G. van Bussel, y G. van Kuik, 

“Simulating dynamic stall in a two-dimensional vertical-axis wind turbine: 
verification and validation with particle image velocimetry data”, Wind Energy, 
vol. 13, núm. 1, pp. 1–17, ene. 2010, doi: https://doi.org/10.1002/we.330. 

[94] F. Trivellato y M. Raciti Castelli, “On the Courant–Friedrichs–Lewy criterion of 
rotating grids in 2D vertical-axis wind turbine analysis”, Renew. Energy, vol. 
62, pp. 53–62, 2014, doi: https://doi.org/10.1016/j.renene.2013.06.022. 

[95] M. Elkhoury, T. Kiwata, y E. Aoun, “Experimental and numerical investigation 
of a three-dimensional vertical-axis wind turbine with variable-pitch”, J. Wind 
Eng. Ind. Aerodyn., vol. 139, pp. 111–123, 2015, doi: 
https://doi.org/10.1016/j.jweia.2015.01.004. 

[96] F. Balduzzi, A. Bianchini, R. Maleci, G. Ferrara, y L. Ferrari, “Critical issues in 
the CFD simulation of Darrieus wind turbines”, Renew. Energy, vol. 85, pp. 
419–435, 2016, doi: https://doi.org/10.1016/j.renene.2015.06.048. 

[97] B. Shahizare, N. Nazri Bin Nik Ghazali, W. T. Chong, S. S. Tabatabaeikia, y 
N. Izadyar, “Investigation of the Optimal Omni-Direction-Guide-Vane Design 
for Vertical Axis Wind Turbines Based on Unsteady Flow CFD Simulation”, 
Energies, vol. 9, núm. 3. 2016, doi: 10.3390/en9030146. 

[98] M. R. Tirandaz y A. Rezaeiha, “Effect of airfoil shape on power performance 
of vertical axis wind turbines in dynamic stall: Symmetric Airfoils”, Renew. 
Energy, vol. 173, pp. 422–441, 2021, doi: 
https://doi.org/10.1016/j.renene.2021.03.142. 

[99] S. ed-Dı̂n Fertahi et al., “CFD performance enhancement of a low cut-in speed 
current Vertical Tidal Turbine through the nested hybridization of Savonius and 
Darrieus”, Energy Convers. Manag., vol. 169, pp. 266–278, 2018, doi: 
https://doi.org/10.1016/j.enconman.2018.05.027. 

[100] A. Rezaeiha, H. Montazeri, y B. Blocken, “Characterization of aerodynamic 
performance of vertical axis wind turbines: Impact of operational parameters”, 
Energy Convers. Manag., vol. 169, pp. 45–77, 2018, doi: 
https://doi.org/10.1016/j.enconman.2018.05.042. 

[101] N. Qin, R. Howell, N. Durrani, K. Hamada, y T. Smith, “Unsteady flow 
simulation and dynamic stall behaviour of vertical axis wind turbine blades”, 
Wind Eng., vol. 35, núm. 4, pp. 511–527, 2011, doi: 10.1260/0309-
524X.35.4.511. 



99 
 

[102] I. C. M. Lositaño y L. A. M. Danao, “Steady wind performance of a 5 kW three-
bladed H-rotor Darrieus Vertical Axis Wind Turbine (VAWT) with cambered 
tubercle leading edge (TLE) blades”, Energy, vol. 175, pp. 278–291, 2019, doi: 
https://doi.org/10.1016/j.energy.2019.03.033. 

[103] S. Mauro, S. Brusca, R. Lanzafame, y M. Messina, “CFD modeling of a ducted 
Savonius wind turbine for the evaluation of the blockage effects on rotor 
performance”, Renew. Energy, vol. 141, pp. 28–39, 2019, doi: 
https://doi.org/10.1016/j.renene.2019.03.125. 

[104] I. Dobrev y F. Massouh, “CFD and PIV investigation of unsteady flow through 
Savonius wind turbine”, Energy Procedia, vol. 6, pp. 711–720, 2011, doi: 
https://doi.org/10.1016/j.egypro.2011.05.081. 

[105] O. D. Lopez Mejia, O. E. Mejia, K. M. Escorcia, F. Suarez, y S. Laín, 
“Comparison of Sliding and Overset Mesh Techniques in the Simulation of a 
Vertical Axis Turbine for Hydrokinetic Applications”, Processes, vol. 9, núm. 
11. 2021, doi: 10.3390/pr9111933. 

[106] “Airfoil Tools”. http://airfoiltools.com/index. 
[107] G. T. Mase, R. E. Smelser, y G. E. Mase, CONTINUUM MECHANICS FOR 

ENGINEERS, Third Edit. CRC Press. 
 

 
  



100 
 

Anexo A. Creación de la geometría 
 
En cualquier simulación por medio de CFD se requiere definir el dominio 
computacional. Para evitar errores de compatibilidad se realiza la creación de la 
geometría desde cero en ANSYS.  
 
Para trabajar de forma limpia, ordenada y cómoda, se recomienda cambiar el color 
del fondo. En Ansys Workbench en el menú superior se selecciona Tools y Options. 
En la nueva ventana emergente en el menú izquierdo seleccionar Appearance. 
Escoger Uniform para Background Style, color blanco para Background Color y 
Background Color 2, y Off para ANSYS Logo. Posteriormente dar OK para guardar 
los cambios. Ver Fig. A.1. 
 

 
Fig. A.1. Menú Options de ANSYS Workbench. 

 
Se inicia el programa de ANSYS Workbench, en la sección de Toolbox (sección 
izquierda, en el panel de trabajo que se muestra por defecto), en el submenú 
Component Systems, se selecciona y se arrastra dos veces el módulo de Geometry 
a la sección de Project Schematic. Se renombran los módulos como “Rotor” y 
“Estator”. Ver Fig. A.2. 
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Fig. A.2. Vista de inicio de ANSYS Workbench con dos módulos de Geometry. 

 
Para iniciar DesignModeler, en los módulos de Geometry que se arrastraron 
previamente a la sección de Project Schematic, dar un clic en Geometry del segundo 
renglón, a continuación, clic derecho para mostrar un nuevo menú contextual y 
seleccionar la opción New DesignModeler Geometry… (segunda opción del menú 
contextual). Ver Fig. A.3. 
 

 
Fig. A.3. Proceso para iniciar DesignModeler.  
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A.1 Construcción geométrica del rotor 
 
 

A.1.1 Rotor H 
 
Es necesario obtener el perfil aerodinámico de los álabes de la turbina eólica, para 
el caso en particular es un perfil asimétrico NACA2415. De Airfoil Tools [106] se 
busca el perfil deseado y se selecciona la opción Source dat file, ver Fig. A.4. Se 
abre una nueva pestaña en el navegador en la que se muestra las coordenadas de 
los puntos que forman el perfil aerodinámico, la primera columna son las 
coordenadas en el eje horizontal o eje X y la segunda columna son las coordenadas 
en el eje vertical o eje Y. Se selecciona y copian las coordenadas del perfil 
aerodinámico.   
 

 
Fig. A.4. Perfil NACA2415 en la página web Airfoil Tools. Obtenido de [106]. 

 
En una hoja de cálculo se pega la información para poder modificarla, la hoja de 
cálculo a usar es Microsoft Excel. Se selecciona toda la columna donde se pegó las 
coordenadas, en el menú superior se selecciona la pestaña Datos y la opción Texto 
en columnas. En la nueva pestaña emergente, se da clic en Siguiente, en la sección 
de Separadores, se selecciona Espacio y se da clic en Finalizar. Ver Fig. A.5. 
 
Con la hoja de cálculo se realizan todas las operaciones para tener como resultado 
las coordenadas de la ubicación del perfil aerodinámico respecto del origen de 
coordenadas de la turbina. El orden para realizar las operaciones sobre las 
coordenadas del perfil aerodinámico es el siguiente: 
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1) Redimensionamiento. 
2) Traslación horizontal. 
3) Traslación vertical. 
4) Rotación. 

 
Se gráfica el perfil aerodinámico en Microsoft Excel usando un gráfico de dispersión 
con líneas rectas y marcadores para verificar el cambio en cada paso.  
 

 
Fig. A.5. Menú del asistente para convertir texto en columnas.  

 
Para el redimensionamiento del perfil se multiplican todas las coordenadas por el 
valor de la cuerda del álabe. Para la traslación horizontal se resta un determinado 
valor a las coordenadas en el eje X menor a la longitud de la cuerda del álabe, para 
la traslación vertical se suma un determinado valor a las coordenadas en el eje Y 
cercano al radio de la turbina H. Finalmente, para la rotación se hace uso de la 
Matriz de Rotación [107] para cada punto del perfil aerodinámico. Los valores de 
traslación horizontal, vertical y rotación no se pueden compartir por razones de 
confidencialidad del diseño de la turbina eólica híbrida.  
 
Se seleccionan y copian el valor de las coordenadas finales del perfilo aerodinámico. 
En un libro nuevo de Excel, en la columna C se pegan los valores del perfil 
aerodinámico. En la columna A se rellena con el numero 1 hasta la última fila que 
tenga valores del perfil, en la columna B se enumera del 1 hasta la enésima posición 
con un incremento de 1 hasta la última fila que tenga valores del perfil que tenga 
algún valor en la columna C. En la columna E se rellena con el número 0 hasta la 
última fila que tenga valores del perfil. Se seleccionan las coordenadas del perfil 
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aerodinámico y se le aplica el formato de Número, se configura para cinco 
decimales. En la Fig. A.6 se muestra el resultado final con un perfil aerodinámico 
diferente para otra turbina eólica. 
 

 
Fig. A.6. Configuración de los datos ordenados en Microsoft Excel de un perfil aerodinámico NACA 

simétrico para exportar a ANSYS DesignModeler. 

 
Se selecciona en el menú superior, la pestaña de Archivo, posteriormente Guardar 
como, nombramos el archivo, escogemos Texto (delimitado por tabulaciones) (*.txt) 
y se da clic en Guardar. Ver Fig. A.7. 
 

 
Fig. A.7. Configuración del guardado del perfil aerodinámico para exportar a ANSYS DesignModeler. 
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En DesignModeler en el menú superior en la pestaña de Units se verifica que estén 
seleccionadas las unidades con las que se trabajara. En el menú superior en la 
pestaña Concept, se selecciona 3D Curve, ver Fig. A.8, se abre un nuevo menú en 
la sección Details View, ver Fig. A.9, en Curve renombrar como CurveNACA2415, 
en Definition seleccionar From Coordinates File, en Coordinates File seleccionar el 
archivo creado previamente con las coordenadas del perfil aerodinámico con 
extensión .txt, en Coordinates Unit seleccionar las unidades con las que se trabajó 
el perfil en Microsoft Exel, en este caso Millimeter, en Base Plane seleccionar 
XYPlane, finalmente en el menú superior en la barra de herramientas 
seleccionamos Generate, ver Fig. A.12. 
 

 
Fig. A.8. Menú de la pestaña Concept. 

 

 
Fig. A.9. Details View del submenú Concept → 3D Curve 

 
En el menú superior en la pestaña Create se selecciona Point, ver Fig. A.10, se abre 
un nuevo menú en la sección Details View, ver Fig. A.11, en Point renombrar como 
PointNACA2415, en Type seleccionar Construction Point, en Definition seleccionar 
From Coordinates File, en Coordinates File seleccionar el archivo creado 
previamente con las coordenadas del perfil aerodinámico con extensión .txt, en 
Coordinates Unit seleccionar las unidades con las que se trabajó el perfil, en este 
caso Millimeter, en Base Plane seleccionar XYPlane, finalmente en el menú superior 
en la barra de herramientas seleccionamos Generate. 
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Fig. A.10. Menú de la pestaña Create, con detalle del submenú Delete. 

 

 
Fig. A.11. Details View del submenú Create → Point 

 
En el menú superior en la barra de herramientas seleccionar Zoom to Fit, 
posteriormente Box Zoom, ver Fig. A.12, para hacer un acercamiento a los últimos 
puntos del perfil aerodinámico  
 

 
Fig. A.12. Barra de herramientas de DesignModeler 

Zoom to Fit 

Box Zoom Display Points 

New Sketch 

Selection Filter: Edges 

Selection Filter: Face 
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En el menú superior en la pestaña Concept, se selecciona Lines From Points, ver 
Fig. A.8, se abre un nuevo menú en la sección Details View, en Lines From Points 
renombrar como LineCierreNACA2415, en la sección Graphics seleccionar los 
últimos dos puntos del perfil aerodinámico con el mouse y manteniendo presionada 
la tecla Ctrl, dar clic en Apply de Point Segments de la sección Details View, ver Fig. 
A.13, y clic en Generate del menú superior en la barra de herramientas.  
 

 
Fig. A.13. Vista del área de trabajo en DesignModeler para la creación de la línea de cierre del perfil 

aerodinámico. 

 
En el menú superior en la pestaña Concept, se selecciona Surface From Edges, ver 
Fig. A.8, se abre un nuevo menú en la sección Details View, en Line-Body Tool 
renombrar como NACA2415, en la sección Graphics seleccionar la curva del perfil 
y la línea de cierre con el mouse y manteniendo presionada la tecla Ctrl, dar clic en 
Apply de Edges en la sección Details View, y clic en Generate del menú superior en 
la barra de herramientas. 
 
En el menú superior en la pestaña Create se selecciona Delete y Body Delete, ver 
Fig. A.10, se abre un nuevo menú en la sección Details View, en BodyDelete 
renombrar como BDeleteLineBody, seleccionar en Line Body de la sección de Tree 
Outline, ver Fig. A.14, dar clic en Apply en la sección Details View, y clic en Generate 
del menú superior en la barra de herramientas. Para dejar de visualizar los puntos 
de construcción del perfil NACA2415, se deselecciona Display Points de la barra de 
herramientas, ver Fig. A.12.  
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Fig. A.14. Vista de la seleecion de Line Body en la sección de Tree Outline. 

 
En el menú superior en la pestaña Create se selecciona Pattern, ver Fig. A.10, se 
abre un nuevo menú en la sección Details View, ver Fig. A.15, en Pattern renombrar 
como PatternAlabe, en Pattern Type seleccionar Circular, en Geometry seleccionar 
Surface Body de la sección de Tree Outline, en Axis seleccionar XYPlane de la 
sección de Tree Outline, en FD2, Angle seleccionar Evenly Spaced, en FD3, Copies 
(>=0) especificar 2, y clic en Generate del menú superior en la barra de 
herramientas. 
 

 
Fig. A.15. Details View del submenú Create → Pattern. 

 
Con el procedimiento anterior se construye los tres álabes del rotor H, ver Fig. A.16. 
En la sección de Tree Outline, renombramos los cuerpos solidos que se han 
formado como se muestra en la Fig. A.17.  
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Fig. A.16. Vista del rotor H de la turbina eólica de eje vertical híbrida. 

 

 
Fig. A.17. Vista de la sección de Tree Outline mostrando la nomenclatura usada. 
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A.1.2 Rotor Savonius 
 
Para la construcción del rotor Savonius, se selecciona XYPlane en la sección del 
Tree Outline, se da clic en New Sketch en la barra de herramientas, ver Fig. A.12. 
Se crea la geometría del rotor Savonius en dos Sketchs, uno para el rotor interno y 
otro para el rotor externo. Se usan las diversas herramientas que aparecen en la 
pestaña Sketching en la sección inferior izquierda del Tree Outline, ver Fig. A.17, 
para trazar la geometría como en cualquier otro programa CAD, las dimensiones no 
se pueden compartir por razones de confidencialidad del diseño de la turbine eólica. 
Los Sketchs quedan como se muestra en la Fig. A.18. 
 

 
Fig. A.18. Sketchs para la construcción del rotor Savonius. 

 
En el menú superior en la pestaña Concept, se selecciona Surface From Sketches, 
ver Fig. A.8, se abre un nuevo menú en la sección Details View, ver Fig. A.19, en 
Surface From Sketches renombrar como SurfaceSavonius, seccionar los dos 
Sketchs creados para la geometría del rotor Savonius con el mouse y manteniendo 
presionada la tecla Ctrl en la sección de Tree Outline, dar clic en Apply de Base 
Objects en la sección Details View, y clic en Generate del menú superior en la barra 
de herramientas. 
 

 
Fig. A.19. Details View del submenú Concept → Surface From Sketches. 
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En el menú superior en la pestaña Create se selecciona Pattern, ver Fig. A.10, se 
abre un nuevo menú en la sección Details View, ver Fig. A.15, en Pattern renombrar 
como PatternSavonius, en Pattern Type seleccionar Circular, en Geometry 
seleccionar los dos Surface Body de la sección de Tree Outline, en Axis seleccionar 
XYPlane de la sección de Tree Outline, en FD2, Angle seleccionar Evenly Spaced, 
en FD3, Copies (>=0) especificar 5, y clic en Generate del menú superior en la barra 
de herramientas. Con lo cual se genera el rotor Savonius, ver Fig. A.20 

 

 
Fig. A.20. Vista del rotor Savonius de la turbina eólica de eje vertical híbrida. 

 
 

A.1.3 Dominio Computacional 
 
Se procede a crear el dominio computacional para la simulación. Para el rotor se 
selecciona XYPlane en la sección del Tree Outline, se da clic en New Sketch en la 
barra de herramientas. Se crea un cirulo con centro en el origen de coordenadas y 
con diámetro de 1.5 veces el diámetro de la turbina eólica, usando las herramientas 
de la pestaña de Sketching en la sección inferior izquierda del Tree Outline. En el 
menú superior en la pestaña Concept, se selecciona Surface From Sketches, ver 
Fig. A.8, se abre un nuevo menú en la sección Details View, ver Fig. A.21, en 
Surface From Sketches renombrar como SurfaceCircular, seccionar con el mouse 
el Sketch del círculo creado anteriormente en la sección de Tree Outline, dar clic en 
Apply de Base Objects en la sección Details View, en Operation seleccionar Add 
Frozen y clic en Generate del menú superior en la barra de herramientas.  
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Fig. A.21. Details View del submenú Concept → Surface From Sketches para SurfaceCircular. 

 
En la sección del Tree Outline renombramos el ultimo Surface Body creado que se 
muestra en un azul más claro como DominioRotor, ver Fig. A.22.  
 

 
Fig. A.22. Vista de la sección Tree Outline y Graphics antes de la operación Booleana. 

 
En el menú superior en la pestaña Create se selecciona Boolean, ver Fig. A.10, se 
abre un nuevo menú en la sección Details View, ver Fig. A.23, en Operation 
seleccionar Subtract, en Target Bodies seleccionar DominioRotor de la sección Tree 
Outline, en Tool Bodies seleccionar con el mouse presionando la tecla Ctrl 
Alabe1NACA2415, Alabe2NACA2415, Alabe3NACA2415 y todos los Surface Body 
de la sección Tree Outline, ver Fig. A.22, y clic en Generate del menú superior en la 
barra de herramientas. Con lo anterior se genera el dominio computacional del rotor 
para la simulación, ver Fig. A.24.  
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Fig. A.23. Details View del submenú Create → Boolean. 

 

 
Fig. A.24. Vista de la sección Tree Outline y Graphics antes de la operación Booleana. 

 
En la sección Tree Outline seleccionar DomioRotor con el mouse, en la sección 
Details View, ver Fig. A.25, en Fluid/Solid seleccionar Fluid.  
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Fig. A.25. Details View de la selección de DominioRotor de la sección Tree Outline. 

 
Se procede a nombrar las diferentes partes del dominio. En la sección de Graphics 
se selecciona usando los filtros de selección Faces y Edges, según corresponda, 
ubicados en barra de herramientas en el menú superior, ver Fig. A.12, usando el 
mouse y manteniendo presionada la tecla Ctrl para selecciones múltiples.  
 
Con la selección hecha, se da clic derecho y se escoge Named Selection, ver Fig. 
A.26, se abre un nuevo menú en la sección Details View, ver Fig. A.27, en Named 
Selection se nombra según sea el caso, ver Fig. A.28, en Geometry clic en Apply y 
clic en Generate del menú superior en la barra de herramientas.  
 

 
Fig. A.26. Menu contextual de la sección de Graphics. 
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Fig. A.27. Details View de la selección de Named Selection del menú contextual de la sección de 

Graphics. 

 

 
Fig. A.28. Nomenclatura con vista detallada de la geometría del rotor. 

 
Se usa el filtro de Face para nombrar InsideRotor, que es la superficie que del círculo 
menos la superficie de los álabes de la turbina H y de la turbina Savonius. Se usa 
el filtro de Edge para InterfaceRotor, RotorS_Exterior, RotorS_Interior y RotorH. 
Para RotorH se seleccionan las 3 curvas NACA2415 y las 3 líneas rectas que cierran 
el perfil aerodinámico, para InterfaceRotor se selecciona la curva cilíndrica, para el 
RotorS_Interno se seleccionan las cuatro líneas (dos curvas y dos rectas) de los 
seis perfiles semicirculares ubicados más al centro de la turbina, para 
RotorS_Externo se seleccionan las cuatro líneas (dos curvas y dos rectas) de los 
seis perfiles semicirculares ubicados más al exterior de la turbina, como se muestra 
en detalle en la Fig. A.28. 
 
Las superficies nombradas aparecen en el Tree Outline. Finalmente se guarda el 
avance con Save Proyect y se cierra DesignModeler 
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A.2 Construcción geométrica del estator 
 
En Workbench se abre DesignModeler en el módulo de Geometry correspondiente 
al estator. Se selecciona XYPlane en la sección del Tree Outline, se da clic en New 
Sketch en la barra de herramientas. Se crea la geometría del estator usando las 
diversas herramientas que aparecen en la pestaña Sketching en la sección inferior 
izquierda del Tree Outline siguiendo el plano de la Fig. 4.7. El centro del círculo es 
el origen de coordenadas.  
 
En el menú superior en la pestaña Concept, se selecciona Surface From Sketches, 
ver Fig. A.8, se abre un nuevo menú en la sección Details View, en Surface From 
Sketches renombrar como SurfaceEstator, seccionar el Sketch creado en la sección 
de Tree Outline, dar clic en Apply de Base Objects en la sección Details View, y clic 
en Generate del menú superior en la barra de herramientas. 
 
Se selecciona XYPlane en la sección del Tree Outline, se da clic en New Sketch en 
la barra de herramientas. Se trazan las líneas azules siguiendo el plano de la Fig. 
A.29. 
 

 
Fig. A.29. Plano de las divisiones para la geometría del estator. 

 
En el menú superior en la pestaña Tools se selecciona Face Split, ver Fig. A.30, se 
abre un nuevo menú en la sección Details View, ver Fig. A.31, en Face Split Type 
seleccionar By Points and Edges, en Target Face seleccionar Surface Body de la 
sección de Tree Outline, en Tool Geometry usando el filtro de selección Edges en 
la sección de Graphics se selecciona una de las líneas azules de la Fig. A.29 
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trazadas anteriormente, y clic en Generate del menú superior en la barra de 
herramientas.  Se repite el procedimiento anterior hasta dividir la superficie en 12 
partes como se muestra en la Fig. A.32.  
 

 
Fig. A.30. Menú de la pestaña Tools. 

 

 
Fig. A.31. Details View del submenú Tools → Face Split 

 

 
Fig. A.32. Divisiones de la geometría del estator. 
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En la sección del Tree Outline se renombra Surface Body como DominioEstator, 
seleccionar DomioEstator con el mouse, en la sección Details View en Fluid/Solid 
seleccionar Fluid.  
 
Se procede a nombrar las diferentes partes del dominio. En la sección de Graphics 
se selecciona usando los filtros de selección Faces y Edges, según corresponda, 
ubicados en barra de herramientas en el menú superior, usando el mouse y 
manteniendo presionada la tecla Ctrl para selecciones múltiples. Con la selección 
hecha, se da clic derecho y se escoge Named Selection, se abre un nuevo menú en 
la sección Details View, en Named Selection se nombra según sea el caso, ver Fig. 
4.9, en Geometry clic en Apply y clic en Generate del menú superior en la barra de 
herramientas.  
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Anexo B. Generación de la Malla 
 
En el programa de ANSYS Workbench, en la sección de Toolbox (sección izquierda, 
en el panel de trabajo que se muestra por defecto), en el submenú Component 
Systems, se selecciona y se arrastra dos veces el módulo de Mesh a la sección de 
Project Schematic colocando el módulo enfrente del módulo de Geometry, ver Fig. 
B.1. Se renombran los módulos como “MallaR”, para el rotor y “MallaE” para el 
estator.  
 

 
Fig. B.1. Selección y arrastre de los módulos de Mesh a la sección Project Schematic en ANSYS 

Workbench. 

 
Seleccionar y mantener presionado con clic izquierdo del mouse la segunda fila del 
módulo de Geometry, arrastrarlo hasta la fila Geometry del módulo Mesh y dejar de 
presionar el clic izquierdo del mouse, ver Fig. B.2. Para iniciar ANSYS Meshing dar 
doble clic sobre Mesh, ubicada en la tercera fila del módulo Mesh. 
 

 
Fig. B.2. Vista del proceso para compartir información entre módulo de Geometry y Mesh.  
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B.1 Malla rotor 
 
Se abre ANSYS Meshing del módulo MallaR en ANSYS Workbench. En ANSYS 
Meshing en la sección de Outline se selecciona Mesh, ver Fig. B.3, en la sección 
Details (ubicada en la esquina inferior izquierda de la pantalla), ver Fig. B.4, en el 
apartado Defaults, en Physics Preference seleccionar CFD, en Solver Preference 
seleccionar Fluent. En el apartado Sizing en Use Adaptative Sizing seleccionar No, 
en Mesh Defeaturing seleccionar No, en Capture Curvature seleccionar No. En el 
apartado Quality en Smoothing seleccionar Hight. 
 

 
Fig. B.3. Menú contextual de la selección de Mesh en la sección de Outline, con submenú Insert 
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Fig. B.4. Details de la selección Mesh del rotor de la sección Outline. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Method. Se abre un nuevo menú en la sección Details, ver Fig. B.5, en Geometry 
seleccionar la geometría del dominio computacional en la sección gráfica, en 
Method seleccionar Triangles. 
 

 
Fig. B.5. Details del submenú Insert → Method→ All Triangles. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Inflation. Se abre un nuevo menú en la sección Details, ver Fig. B.6, en Geometry 
seleccionar la geometría del dominio computacional en la sección gráfica, en 
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Boundary Scoping Method seleccionar Named Selections, en Boundary seleccionar 
RotorH, en Inflation Option seleccionar First Layer Thickness, en First Layer Height, 
especificar el valor según corresponda en la Tabla B.2, en Maximum Layer y en 
Growth Rate indicar el según corresponda en la Tabla B.1. Renombrar Inflation de 
la sección Outline, del apartado Mesh, con el nombre de Inflation H, ver Fig. B.12. 
 

 
Fig. B.6. Details del submenú Insert → Inflation H. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Inflation. Se abre un nuevo menú en la sección Details, ver Fig. B.6 como referencia, 
en Geometry seleccionar la geometría del dominio computacional en la sección 
gráfica, en Boundary Scoping Method seleccionar Named Selections, en Boundary 
seleccionar RotorS_Interior y RotorS_Exterior manteniendo presionada la tecla Ctrl, 
en Inflation Option seleccionar First Layer Thickness, en First Layer Height, 

especificar el valor 5.5𝑥10−5 , en Maximum Layer y en Growth Rate indicar el según 
corresponda en la Tabla B.1. Renombrar Inflation de la sección Outline, del apartado 
Mesh, con el nombre de Inflation Savonius, ver Fig. B.12. 
 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.7, en Geometry 
seleccionar la geometría del dominio computacional en la sección gráfica, en Type 
seleccionar Element Size, en Element Size especificar el valor de 0.1m. 
 

 
Fig. B.7. Details del submenú Insert → Sizing, para Body Sizing. 
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En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.8, en Geometry 
usando el filtro de selección Edge (ubicado en la parte superior de la sección gráfica) 
se selecciona en la sección gráfica la circunferencia de la figura que corresponde a 
la parte del dominio nombrada como InterfaceRotor, ver Fig. A.28, en Type 
seleccionar Number of Divisions, en Number of Divisions y en Growth Rate indicar 
el según corresponda en la Tabla B.1. Renombrar Edge Sizing de la sección Outline, 
del apartado Mesh, con el nombre de Edge Sizing Interface, ver Fig. B.12. 
 

 
Fig. B.8. Details del submenú Insert → Sizing, para Edge Sizing Interface. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.10, en Geometry 
usando el filtro de selección Edge (ubicado en la parte superior de la sección gráfica) 
y presionando la tecla Ctrl se selecciona en la sección gráfica las tres líneas curvas 
correspondientes a los álabes NACA2415 del rotor H, ver Fig. B.9, en Type 
seleccionar Number of Divisions, en Number of Divisions y en Growth Rate indicar 
el según corresponda en la Tabla B.1, en Capture Curvature seleccionar Yes, en 
Curvature Normal Angle especificar 0.5°. Renombrar Edge Sizing de la sección 
Outline, del apartado Mesh, con el nombre de Edge Sizing NACA2415, ver Fig. B.12. 
 

 
Fig. B.9. Línea curva y línea recta del álabe NACA2415. 
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Fig. B.10. Details del submenú Insert → Sizing, para Edge Sizing NACA2415. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.8 como referencia, 
en Geometry usando el filtro de selección Edge (ubicado en la parte superior de la 
sección gráfica) y presionando la tecla Ctrl se selecciona en la sección gráfica las 
tres líneas rectas correspondientes a los álabes NACA2415 del rotor H, ver Fig. B.9, 
en Type seleccionar Number of Divisions, en Number of Divisions y en y Growth 
Rate indicar el según corresponda en la Tabla B.1. Renombrar Edge Sizing de la 
sección Outline, del apartado Mesh, con el nombre de Edge Sizing NACA2415 
Recta, ver Fig. B.12. 
 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.10 como referencia, 
en Geometry usando el filtro de selección Edge (ubicado en la parte superior de la 
sección gráfica) y presionando la tecla Ctrl se selecciona en la sección gráfica las 
dos líneas curvas de cada uno de los álabes del rotor Savonius, ver Fig. B.11, en 
Type seleccionar Number of Divisions, en Number of Divisions y en y Growth Rate 
indicar el según corresponda en la Tabla B.1, en Capture Curvature seleccionar 
Yes, en Curvature Normal Angle especificar 0.5°. Renombrar Edge Sizing de la 
sección Outline, del apartado Mesh, con el nombre de Edge Sizing Savonius, ver 
Fig. B.12. 
 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.8 como referencia, 
en Geometry usando el filtro de selección Edge (ubicado en la parte superior de la 
sección gráfica) y presionando la tecla Ctrl se selecciona en la sección gráfica las 
dos líneas rectas de cada uno de los álabes del rotor Savonius, ver Fig. B.11, en 
Type seleccionar Number of Divisions, en Number of Divisions y en y Growth Rate 
indicar el según corresponda en la Tabla B.1. Renombrar Edge Sizing de la sección 
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Outline, del apartado Mesh, con el nombre de Edge Sizing Savonius Recta, ver Fig. 
B.12. 
 

 
Fig. B.11.Líneas curvas y líneas rectas de los álabes de la turbina Savonius. 

 
Finalmente, para generar la malla en el menú superior en la pestaña Home, se da 
clic en Generate. La malla obtenida se muestra en la Fig. B.13. Se guarda el proceso 
del proyecto en el menú superior en la pestaña File y Save Project. 
 

 
Fig. B.12. Nomenclatura empleada para las distintas herramientas de mallado aplicadas al rotor. 
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Tabla B.1. Relación de las mallas del rotor y sus valores para las técnicas de mallado.  

Malla R1 R2 R3 

Inflation H 
Maximum Layer 
Growth Rate 

 
20 
1.15 

 
15 
1.2 

 
15 
1.2 

Inflation Savonius 
Maximum Layer 
Growth Rate 

 
15 
1.15 

 
15 
1.2 

 
15 
1.2 

Edge Sizing Interface 
Number of Divisions 
Growth Rate 

 
720 
1.2 

 
540 
1.2 

 
360 
1.2 

Edge Sizing NACA2415 
Number of Divisions 
Growth Rate 

 
2300 
1.1 

 
2000 
1.2 

 
1700 
1.2 

Edge Sizing NACA2415 Recta 
Number of Divisions 
Growth Rate 

 
10 
1.1 

 
10 
1.2 

 
6 
1.2 

Edge Sizing Savonius 
Number of Divisions 
Growth Rate 

 
1300 
1.1 

 
1000 
1.2 

 
800 
1.2 

Edge Sizing Savonius Recta 
Number of Divisions 
Growth Rate 

 
10 
1.1 

 
10 
1.2 

 
5 
1.2 

 
 

Tabla B.2. Tamaño de First Layer Height a las diferentes velocidades de viento para la técnica de 
Inflation aplicada a los álabes del rotor H  

𝑽∞ (𝒎/𝒔) 2.5 4 5.5 7 8.5 10 

First Layer Height (𝒎) 4𝑥10−5  4𝑥10−5 4𝑥10−5 4𝑥10−5 3𝑥10−5 2𝑥10−5 
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Fig. B.13. Malla del rotor, malla R2. 

 
 

B.2 Malla estator 
 
Se abre ANSYS Meshing del módulo MallaE en ANSYS Workbench. En ANSYS 
Meshing en la sección de Outline se selecciona Mesh, ver Fig. B.3, en la sección 
Details (ubicada en la esquina inferior izquierda de la pantalla), ver Fig. B.14, en el 
apartado Defaults, en Physics Preference seleccionar CFD, en Solver Preference 
seleccionar Fluent, en Element Size, especificar 0.25m. En el apartado Sizing en 
Use Adaptative Sizing seleccionar Yes, en Resolution especificar 3, en Mesh 
Defeaturing seleccionar No, en Transition seleccionar Fine, en Initial Size Seed 
seleccionar Part. En el apartado Quality en Smoothing seleccionar Hight. 
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Fig. B.14. Details de la selección Mesh del estator de la sección Outline 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Method. Se abre un nuevo menú en la sección Details, ver Fig. B.15, en Geometry 
seleccionar la geometría del dominio computacional en la sección gráfica, en 
Method seleccionar Multizone Quad/Tri, en Free Face Mesh Type seleccionar All 
Quad, en Mesh Based Defeaturing seleccionar Off. 
 

 
Fig. B.15. Details del submenú Insert → Method→ MultiZone. 
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En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.16, en Geometry 
usando el filtro de selección Face (ubicado en la parte superior de la sección gráfica) 
y presionando la tecla Ctrl se selecciona en la sección gráfica las cuatro caras 
colindantes con la circunferencia, ver Fig. B.17, en Type seleccionar Element Size, 
en Element Size especificar el valor según corresponda en la  
Tabla B.3. Renombrar Face Sizing de la sección Outline, del apartado Mesh, con el 
nombre de Face Sizing Cuadrado, ver Fig. B.22. 
 

 
Fig. B.16. Details del submenú Insert → Sizing, para Face Sizing Cuadrado. 

 

 
Fig. B.17. Caras seleccionadas para la aplicación de la herramienta Face Sizing. 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.18, en Geometry 
usando el filtro de selección Edge (ubicado en la parte superior de la sección gráfica) 
y presionando la tecla Ctrl se selecciona en la sección gráfica las diez líneas que 



130 
 

aparecen remarcadas en la Fig. B.19, en Type seleccionar Number of Divisions, en 
Number of Divisions especificar el valor según corresponda en la  
Tabla B.3, en Behavior seleccionar Hard, en Bias Type seleccionar “____ ___ _ _”, 
en Bias Option seleccionar Bias Factor, en Bias Factor especificar el valor de 3 y en 
Reverse Bias seleccionar las líneas a las que se les deba cambiar la orientación 
para que queden como en la Fig. B.19. Se recomienda usar un valor de 10 en 
Number of Divisions para visualizar las líneas a seleccionar al cambiar la 
orientación, posteriormente regresar al valor correcto. Renombrar Edge Sizing de la 
sección Outline, del apartado Mesh, con el nombre de Edge Sizing 8.5D, ver Fig. 
B.22. 
 

 
Fig. B.18. Details del submenú Insert → Sizing, para Edge Sizing 8.5D. 

 

 
Fig. B.19. Líneas seleccionadas para Edge Sizing 8.5D. 
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En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Sizing. Se abre un nuevo menú en la sección Details, ver Fig. B.18 como referencia, 
en Geometry usando el filtro de selección Edge (ubicado en la parte superior de la 
sección gráfica) y presionando la tecla Ctrl se selecciona en la sección gráfica las 
dos líneas que aparecen remarcadas en la Fig. B.20, en Type seleccionar Number 
of Divisions, en Number of Divisions especificar el valor según corresponda en la  
Tabla B.3, en Behavior seleccionar Hard, en Bias Type seleccionar “____ ___ _ _”, 
en Bias Option seleccionar Bias Factor, en Bias Factor especificar el valor de 3 y en 
Reverse Bias seleccionar las líneas a las que se les deba cambiar la orientación 
para que queden como en la Fig. B.20. Se recomienda usar un valor de 10 en 
Number of Divisions para visualizar las líneas a seleccionar al cambiar la 
orientación, posteriormente regresar al valor correcto. Renombrar Edge Sizing de la 
sección Outline, del apartado Mesh, con el nombre de Edge Sizing 18.5D, ver Fig. 
B.22. 
 

 
Fig. B.20. Líneas seleccionadas para Edge Sizing 18.5D 

 
En la sección Outline se selecciona Mesh, clic derecho del mouse, se muestra un 
nuevo menú, ver Fig. B.3, se selecciona Insert, se abre un submenú y se selecciona 
Face Meshing. Se abre un nuevo menú en la sección Details, ver Fig. B.21, en 
Geometry usando el filtro de selección Face (ubicado en la parte superior de la 
sección gráfica) y presionando la tecla Ctrl se selecciona en la sección gráfica las 
cuatro caras colindantes con la circunferencia, ver Fig. B.17. 
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Fig. B.21. Details del submenú Insert → Face Meshing. 

 
Finalmente, para generar la malla en el menú superior en la pestaña Home, se da 
clic en Generate. La malla obtenida se muestra en la Fig. B.23. Se guarda el proceso 
del proyecto en el menú superior en la pestaña File y Save Project. 
 

 
Fig. B.22. Nomenclatura empleada para las distintas herramientas de mallado aplicadas al estator. 

 
Tabla B.3. Relación de las mallas del estator y sus valores para las técnicas de mallado 

Malla E1 E2 E3 

Face Sizing Cuadrado 
Element Size (m) 

 
0.03 

 
0.06 

 
0.1 

Edge Sizing 8.5D 
Number of Divisions 

 
136 

 
102 

 
68 

Edge Sizing 18.5D 
Number of Divisions 

 
296 

 
222 

 
148 
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Fig. B.23. Malla del estator, malla E2. 
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Anexo C. Configuración CFD en ANSYS Fluent 
 
En el programa de ANSYS Workbench, en la sección de Toolbox (sección izquierda, 
en el panel de trabajo que se muestra por defecto), en el submenú Component 
Systems, se selecciona y se arrastra el módulo de Fluent a la sección de Project 
Schematic colocándolo enfrente de cualquiera de los dos módulos de Mesh, ver Fig. 
C.1. Se renombra el módulo como “Inicialización Frame Motion”.  
 
Seleccionar y mantener presionado con clic izquierdo del mouse la tercera fila Mesh 
del módulo de Mesh, de cualquiera de los dos módulos MallaR o MallaE, arrastrarlo 
hasta la segunda fila Setup del módulo Fluent y dejar de presionar el clic izquierdo 
del mouse, ver Fig. C.1. En el módulo Mesh arrastrado en la tercera fila cambiara el 
icono de una palomita verde a un rayo amarillo. Seleccionar la fila con el rayo 
amarillo y dar clic derecho, se abrirá un nuevo menú contextual, ver Fig. C.2, 
seleccionar Update. Esperar hasta que vuelva a cambiar del rayo amarillo por la 
palomita verde. Repetir las acciones anteriores para el módulo Mesh faltante, 
MallaR o MallaE. 
 

 
Fig. C.1. Vista del proceso para compartir información entre módulo de Mesh y Fluent. 

 
Para iniciar Fluent dar doble clic sobre Setup, ubicado en la segunda fila del módulo 
Fluent. En la ventana emergente en la sección Options habilitar la opción Double 
Precision y Display Mesh After Reading, en la sección Parallel (Local Machine) en 
Solver Processes especificar el valor de 7, que es el número de procesadores que 
usara el programa. Este valor dependerá del número de núcleos reales con las que 
cuente el equipo de cómputo en donde se realizarán las simulaciones. Para el 
presente trabajo se cuenta con una computadora con un procesador Intel i7-9700 
con 8 núcleos.  
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Fig. C.2. Menú contextual para trasferir la información del módulo de Mesh a Fluent.  

 
En ANSYS Fluent en la sección Outline View en el apartado Setup se selecciona 
General, en la sección Task Page, ver Fig. C.3, en la sección Solver en Type se 
seleccionar Pressure-Based, en Velocity Formulation seleccionar Absolute, en Time 
seleccionar Steady y en 2D Space seleccionar Planar. 
 

 
Fig. C.3. Task Page de Outline View → Setup → General. 

 
Se crea la interfaz entre la malla del rotor y la malla del estator. En la sección Outline 
View en el apartado Setup se selecciona Mesh Interfaces, se abre una nueva 
ventana, ver Fig. C.4, en la sección Boundary Zones seleccionar Interfaceestator e 
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Interfacerotor, en Interface Name Prefix nombrar como interface_estator_rotor, clic 
en Create y clic en Close. 
 

 
Fig. C.4. Mesh Interfaces de Outline View → Setup → Mesh Interfaces. 

 
Se realiza la configuración del modelo de turbulencia para la simulación. En la 
sección Outline View en el apartado Setup se despliega el menú de Models, se 
selecciona Viscous, se abre una nueva ventana, ver Fig. C.5. En la nueva ventana 
en la sección Model seleccionar k-omega (2 eqn), en k-omega Model seleccionar 
SST, habilitar Low-Re Corrections, clic en Ok. Se comprime el menú de Models del 
apartado de Setup de la sección de Outline View. 
 

 
Fig. C.5. Viscous Model de Outline View → Setup → Models → Viscous. 
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Se realiza la configuración de las propiedades físicas del fluido de trabajo para la 
simulación. En la sección Outline View en el apartado Setup desplegar el menú de 
Materials, desplegar apartado Fluid, selecciona air, se abre una nueva ventana, ver 
Fig. C.6. En la nueva ventana en Name renombrar como air-gdl, en la sección 
Properties, en Density especificar el valor de densidad, en Viscosity especificar el 
valor de viscosidad. Para la simulación se usan los valores calculados en el Capítulo 
III. Se da clic en Change/Create, surgirá una nueva ventana emergente dar clic en 
Yes. Finalmente se da clic en Close. Se comprime el menú de Materials del apartado 
de Setup de la sección de Outline View. 
 

 
Fig. C.6. Create/Edit Materials de Outline View → Setup → Materials → Fluid. 

 
Se realiza la configuración del movimiento de la malla, en el caso del estator es una 
malla estática y para la malla del rotor también es estática; sin embargo, las 
ecuaciones gobernantes se modifican para simular el efecto del movimiento a una 
velocidad angular constante. En la sección Outline View en el apartado Setup se 
despliega el menú de Cell Zone Conditions, desplegar apartado Fluid, seleccionar 
insideestator, y presionar la tecla enter, se abre una nueva ventana, ver Fig. C.7. 
En la nueva ventana verificar que en Material Name este seleccionado air-gdl, en 
caso contrario seleccionar air-gdl, clic en Apply y posteriormente clic en Close. 
Seleccionar insiderotor, y presionar la tecla enter, se abre una nueva ventana, ver 
Fig. C.8. En la nueva ventana verificar que en Material Name este seleccionado air-
gdl, en caso contrario seleccionar air-gdl, habilitar la opción Frame Motion, en 
Relative To Cell Zone seleccionar absolute, en la sección Rotation-Axis Origen 
ingresar las coordenadas del eje de rotación, en nuestro caso el eje de rotación 
coincide con el origen de coordenadas, por lo cual indicar 0 en X y 0 en Y, en Speed 
especificar la velocidad de rotación en las unidades marcadas según el valor de la 
Tabla 4.5, clic en Apply y posteriormente clic en Close. 
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Fig. C.7. Outline View → Setup → Cell Zone Conditions → Fluid → insideestator. 

 

 
Fig. C.8. Outline View → Setup → Cell Zone Conditions → Fluid → insiderotor. 

 
Se realiza la configuración de las condiciones de frontera. En la sección Outline 
View en el apartado Setup se selecciona Boundary Conditions, en la sección Task 
Page, dar doble clic en inlet, se abre una nueva ventana, ver Fig. C.9. En Velocity 
Magnitude especificar la velocidad de entrada del viento en las unidades marcadas 
según el valor de la Tabla 4.5, en la sección Turbulence en Specification Method 
seleccionar Intensity and Length Scale, clic en Apply y posteriormente clic en Close. 
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Fig. C.9. Outline View → Setup → Boundary Conditions → inlet. 

 
En la sección Outline View en el apartado Setup se selecciona Boundary Conditions, 
en la sección Task Page, dar doble clic en outlet, se abre una nueva ventana, ver 
Fig. C.10. En Gauge Pressure especificar 0, en la sección Turbulence en 
Specification Method seleccionar Intensity and Length Scale, clic en Apply y 
posteriormente clic en Close. 
 

 
Fig. C.10. Outline View → Setup → Boundary Conditions → outlet. 

 
En la sección Outline View en el apartado Setup se selecciona Boundary Conditions, 
en la sección Task Page, seleccionar Outline, en la misma sección de Task Page 
en Type seleccionar symmetry, ver Fig. C.11. 
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Fig. C.11. Task Page de Outline View → Setup → Boundary Conditions, selección de symmetry para 

outline. 

 
En la sección Outline View en el apartado Setup se selecciona Boundary Conditions, 
en la sección Task Page, dar doble clic en alabesh, se abre una nueva ventana, ver 
Fig. C.12. En la sección Wall Motion seleccionar Moving Wall, en la sección Motion 
seleccionar Relative to Adjacent Cell Zone y Rotational, clic en Apply y 
posteriormente clic en Close. Repetir la configuración anterior para rotors_exterior 
y rotors_interior. 
 

 
Fig. C.12. Outline View → Setup → Boundary Conditions → rotorh 
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Se realiza la configuración de valores de referencia para las simulaciones 2D. En la 
sección Outline View en el apartado Setup se selecciona Reference Values, en la 
sección Task Page, ver Fig. C.13, en Area especificar 2.4, en Density especificar el 
valor de la densidad, en Depth especificar 1, en Length especificar 1.2 y en Velocity 
especificar la velocidad de entrada del viento según el valor de la Tabla 4.5. 
 

 
Fig. C.13. Outline View → Setup → Reference Values. 

 
Se realiza la configuración del solucionador. En la sección Outline View en el 
apartado Solution se selecciona Methods, en la sección Task Page, verificar que los 
valores coincidan con los que se muestra en la ver Fig. C.14. 
 

 
Fig. C.14. Task Page de Outline View → Solution → Methods. 
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En la sección Outline View en el apartado Solution se selecciona Report Definitions, 
clic derecho, se abre un menú contextual y se sigue la siguiente ruta New → Force 
Report →Moment, ver Fig. C.15. Se abre una nueva ventana, ver Fig. C.16, en 
Name nombrar según corresponda en la Tabla C.1, en Report Output Type 
seleccionar Moment, en la sección Create desmarcar Report File y Report Plot, en 
la sección Zones seleccionar según corresponda en la Tabla C.1, clic en Ok. Repetir 
el procedimiento anterior para crear los cinco reportes que aparecen en la Tabla 
C.1. 
 

 
Fig. C.15. Menú contextual de Outline View → Solution → Report Definitions, con detalle en New → 

Force Report →Moment 

 

 
Fig. C.16. Ventana para la configuración de reportes. 
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Tabla C.1. Nombre de los reportes y zonas seleccionadas. 

Name Zone 

Momento_rotor_hys 
rotorh 
rotors_exterior 
rotors_interior 

Momento_rotor_s 
rotors_exterior 
rotors_interior 

Momento_rotor_s_interior rotors_interior 

Momento_rotor_s_exterior rotors_exterior 

Momento_rotor_h Rotorh 

 
Se realiza la configuración del valor de los residuales para considerar la 
convergencia de la solución. En la sección Outline View en el apartado Solution se 
despliega el menú de Monitors, seleccionar Residual, y presionar la tecla enter, se 
abre una nueva ventana, ver Fig. C.17. En la nueva ventana en la columna Absolute 
Criteria rellenar todas las filas con el valor de 0.00001 o con 1e-05, clic en OK. 
 

 
Fig. C.17. Outline View → Solution → Monitors → Residual. 

 
En la sección Outline View en el apartado Solution se despliega el menú de 
Monitors, seleccionar Report Files, clic derecho y se selecciona New. Se abre una 
nueva ventana, ver Fig. C.18, en Name y en File Name nombrar como report-
momentos, en Available Report Definitions seleccionar todo y clic en Add, finalmente 
clic en OK.  
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Fig. C.18. Ventana para la configuración de los archivos de reportes. 

 
En la sección Outline View en el apartado Solution se despliega el menú de 
Monitors, seleccionar Report Plot, clic derecho y seleccionar New. Se abre una 
nueva ventana, ver Fig. C.19, en Name y en File Name nombrar como grafica-rotor-
híbrido, en Available Report Definitions seleccionar moment_rotor_h, 
moment_rotor_hys y moment_rotor_s, clic en Add y clic en Ok.  
 
En la sección Outline View en el apartado Solution se despliega el menú de 
Monitors, seleccionar Report Plot, clic derecho y seleccionar New. Se abre una 
nueva ventana, ver Fig. C.19 de referencia, en Name y en File Name nombrar como 
grafica-rotor-savonius, en Available Report Definitions seleccionar 
moment_rotor_s_interior, moment_rotor_s_exterior y moment_rotor_s, clic en Add 
y clic en Ok.  
 

 
Fig. C.19. Ventana para la configuración de los archivos de gráficas. 
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En la sección Outline View en el apartado Solution se selecciona Initialization, en la 
sección Task Page, ver Fig. C.20, seleccionar Standard Initialization, en Compute 
From seleccionar inlet, en Reference Frame seleccionar Absolute y clic en Initialize. 
 

 
Fig. C.20. Task Page de Outline View → Solution → Initialization. 

 
En la sección Outline View en el apartado Solution seleccionar Run Calculation, en 
la sección Task Page, ver Fig. C.21, especificar el valor de 20000 en Number of 
Iterations. Guardar la configuración y el progreso del proyecto, en el menú superior 
seleccionar la pestaña File seleccionar Save Project. Cerrar el programa Fluent.  
 
En ANSYS Workbench en el módulo de Fluent nombrado “Inicialización Frame 
Motion”, en la segunda fila Setup tendrá el icono de una palomita verde y la tercera 
fila Solution tendrá un rayo amarillo como se muestra en la Fig. C.22. Dar doble clic 
sobre Solution, ubicado en la tercera fila del módulo Fluent.  
 
En el programa Fluent en la sección Outline View en el apartado Solution 
seleccionar Run Calculation, en la sección Task Page, ver Fig. C.21, dar clic en 
Calculate.  
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Fig. C.21. Task Page de Outline View → Solution → Run Calculation. Simulación no transitoria. 

 

 
Fig. C.22. Vista de ANSYS Workbench al terminar el Setup del módulo Fluent “Inicialización Frame 

Motion” 

 
Con lo anterior se iniciará el cálculo de la solución CFD mediante la técnica de 
Frame Motion, esperar a que los cálculos terminen y converja la solución mientras 
se monitorea la convergencia mediante las gráficas de residuales y las gráficas de 
momento configuradas en pasos anteriores. Al finalizar el cálculo, se abrirá una 
nueva ventana emergente avisando que los cálculos han concluido, dar clic en OK. 
Guardar el progreso del proyecto, en el menú superior seleccionar la pestaña File 
seleccionar Save Project. Cerrar el programa Fluent. 
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En ANSYS Workbench en el módulo de Fluent nombrado “Inicialización Frame 
Motion”, seleccionar la esquina superior izquierda con el icono de un triángulo, en 
la primera columna encima de los números, ver la Fig. C.22. Se mostrará un nuevo 
menú, seleccionar Duplicate, se abrirá una nueva ventana emergente, seleccionar 
No. Renombrar el módulo duplicado de Fluent como “Sliding Mesh”.  
 
Seleccionar y mantener presionado con clic izquierdo del mouse la tercera fila 
Solution del módulo de Fluent nombrado “Inicialización Frame Motion”, arrastrarlo 
hasta la tercera fila Solution del módulo Fluent nombrado “Sliding Mesh” y dejar de 
presionar el clic izquierdo del mouse, ver Fig. C.23.  
 

 
Fig. C.23. Proceso de transferencia de datos de solución como datos de inicialización en Fluent. 

 
En el módulo de Fluent llamado Sliding Mesh, dar doble clic sobre Solution, ubicado 
en la tercera fila, ver Fig. C.24.  
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Fig. C.24. Vista de las relaciones entre los diferentes módulos para realizar la simulación de Sliding 

Mesh. 

 
En ANSYS Fluent en la sección Outline View en el apartado Setup se selecciona 
General, en la sección Task Page, ver Fig. C.3 como referencia, en Time seleccionar 
Transient. 
 
En la sección Outline View en el apartado Setup se despliega el menú de Models, 
se selecciona Viscous, se abre una nueva ventana, ver Fig. C.25. En la nueva 
ventana se realiza la configuración del modelo de turbulencia para la simulación con 
la técnica de Sliding Mesh, en la sección Model seleccionar Transition SST, clic en 
Ok. Se comprime el menú de Models del apartado de Setup de la sección de Outline 
View. 
 

 
Fig. C.25. Viscous Model de Outline View → Setup → Models → Viscous → Transition SST. 
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Se realiza la configuración del movimiento de la malla, en el caso del estator es una 
malla estática y para la malla del rotor es una malla deslizante a una velocidad 
angular constante. En la sección Outline View en el apartado Setup se despliega el 
menú de Cell Zone Conditions, desplegar apartado Fluid seleccionar insiderotor, y 
presionar la tecla enter, se abre una nueva ventana. En la nueva ventana clic en 
Copy To Mesh Motion, ver Fig. C.8 como referencia. Verificar que se deseleccione 
la opción Frame Motion, se habilite la opción Mesh Motion y se traslade a Mesh 
Motion los valores ingresados anteriormente en Frame Motion. Clic en Apply y 
posteriormente clic en Close. 
 
En la sección Outline View en el apartado Solution se selecciona Methods, en la 
sección Task Page, en la sección Spatial Discretization y en Transient Formulation 
verificar y elegir todas las opciones Second Order, ver Fig. C.26. 
 

  
Fig. C.26. Task Page de Outline View → Solution → Methods, para Sliding Mesh. 

 
En la sección Outline View en el apartado Solution se despliega el menú de 
Monitors, seleccionar Residual, y presionar la tecla enter, se abre una nueva 
ventana, ver Fig. C.17 como referencia. En la nueva ventana en la columna Absolute 
Criteria rellenar todas las filas con el valor de 0.00001 o con 1e-05, clic en OK. 
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En la sección Outline View en el apartado Solution se despliega el menú de 
Monitors, se despliega la opción Report Files, se selecciona report-momentos y se 
presiona la tecla enter. Se abre una nueva ventana, ver Fig. C.18 como referencia. 
En Available Report Definitions seleccionar delta-time, clic en Add y finalmente clic 
en OK.  
 
Se configura el autoguardado. En la sección Outline View en el apartado Solution 
se despliega el menú de Calculation Activities, se selecciona Autosave (Every Time 
Steps). Se abre una nueva ventana, ver Fig. C.27. En Save Data File Every 
especificar 360, para hacer un autoguardado cada media revolución de la turbina, 
seleccionar Each Time, habilitar Retain Only the Most Recent Files, especificar 5 en 
Maximum Number of Data Files y finalmente clic en OK.  
 

 
Fig. C.27. Outline View → Solution → Calculation Activities → Autosave (Every Time Steps). 

 
En la sección Outline View en el apartado Solution seleccionar Run Calculation, en 
la sección Task Page, ver Fig. C.28, en Number of Time Steps especificar el valor 
según la Tabla 4.4 y Tabla 4.5, en Time Step Size especificar el valor 
correspondiente con base en la Tabla 4.5, en Max Iterations/Time Step especificar 
40. Guardar la configuración y el progreso del proyecto, en el menú superior 
seleccionar la pestaña File seleccionar Save Project, esperar a que se guarde y dar 
clic en Calculate.  
 
Con lo anterior se iniciará el cálculo de la solución CFD con la técnica de Sliding 
Mesh, esperar a que los cálculos terminen y converja la solución mientras se 
monitorea la convergencia mediante las gráficas de residuales y las gráficas de 
momento configuradas en pasos anteriores. Al finalizar el cálculo, se abrirá una 
nueva ventana emergente avisando que los cálculos han concluido, dar clic en OK. 
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Guardar el progreso del proyecto, en el menú superior seleccionar la pestaña File 
seleccionar Save Project.  
 

 
Fig. C.28. Task Page de Outline View → Solution → Run Calculation. Simulación transitoria. 

 
 
 


